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อุตสาหกรรมในประเทศไทยจะเห็นได้ว่ามีการน าเทคโนโลยีระบบอัตโนมัติ (Automation 
Technology) เข้ามาใช้งานเพ่ือให้สินค้าสามารถแข่งขันในตลาดโลกได้ ทั้งในเรื่องราคา และคุณภาพ 
โดยเฉพาะในเรื่องคุณภาพ อาจเนื่องจากมีการเปลี่ยนรุ่นผลิตภัณฑ์อยู่บ่อยๆ ต้องใช้เวลาในการ Set Up 
ปัจจุบันจึงมีการน าเทคโนโลยีต่างๆ เข้ามาใช้ หนึ่งในเทคโนโลยีที่มีความยืดหยุ่นสูง ได้แก่ หุ่นยนต์
อุตสาหกรรม เนื่องจากการเปลี่ยนการท างานสามารถท าได้โดยการเปลี่ยนโปรแกรม นอกจากนี้คุณภาพของ
ผลิตภัณฑ์ที่ได้มีความสม่ าเสมอเป็นมาตรฐานเดียวกัน 

การท างานของหุ่นยนต์อุตสาหกรรมจะเลียนแบบร่างกายของมนุษย์ โดยจะเลียนแบบเฉพาะส่วน
ของร่างกายที่จะน าไปใช้ประโยชน์ในอุตสาหกรรมเท่านั้น นั่นคือช่วงแขนของมนุษย์ ดังนั้น บางคนอาจจะได้
ยินค าว่า “แขนกล” ซึ่งก็หมายถึงหุ่นยนต์อุตสาหกรรม การท างานของหุ่นยนต์อุตสาหกรรมเปรียบเทียบกับ
แขนมนุษย์ แสดงดังรูป 

 

ปัจจุบันและในอนาคตหุ่นยนต์อุตสาหกรรมจะเข้ามามีบทบาทในอุตสาหกรรมมากขึ้น โดยจะ
ท างานแทนมนุษย์ในงานต่างๆ เหล่านี้งานที่อันตราย เช่น งานยกเหล็กเข้าเตาหลอม งานที่เกี่ยวข้องกับ
สารเคมี งานซ้ าซากน่าเบื่อ เช่น งานยกสินค้าจากสายงานการผลิต งานประกอบ งานบรรจุผลิตภัณฑ์งานที่
ต้องการคุณภาพมาตรฐานเดียวกัน เช่น งานเชื่อม งานตัด งานที่ต้องใช้ทักษะความช านาญสูง เช่น งานเชื่อม
แนว เชื่อมเลเซอร์ งานที่ต้องใช้ความละเอียดประณีต เช่น งานประกอบชิ้นส่วนอิเล็กทรอนิกส์ งานตรวจสอบ 
(Inspection) ฯลฯ 
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1.1 หุ่นยนต์คืออะไร 

หุ่นยนต์ คือ เครื่องจักรที่ถูกควบคุมอัตโนมัติ สามารถเขียนโปรแกรมใหม่ได้ ใช้งานเอนกประสงค์ 
โปรแกรมการเคลื่อนที่จะต้องสามารถโปรแกรมให้เคลื่อนที่ได้อย่างน้อย 3 แกนหรือมากกว่า หุ่นยนต์อาจจะ
ยึดอยู่กับที่หรือย้ายต าแหน่ง (Mobile) เพ่ือใช้ในงานอุตสาหกรรม 

1.2 การแบ่งชนิดของหุ่นยนต์ 

โดยทั่วไปการแบ่งชนิดของหุ่นยนต์จะแบ่งตามลักษณะรูปทรงของพ้ืนที่ท างาน (Envelope 
Geometric) แต่ก่อนจะอธิบายชนิดของหุ่นยนต์ขออธิบายการท างานของจุดต่อ (Joint) ของหุ่นยนต์ 
อุตสาหกรรมซึ่งในขั้นพ้ืนฐานมี 2 ชนิดด้วยกัน ดังนี้จุดต่อ (Joint) ทั้งสองแบบเมื่อน ามาต่อเข้าด้วยกันอย่าง
น้อย 3 แกนหลักจะได้พ้ืนที่ท างาน (Work envelope) ที่มีลักษณะแตกต่างกันไป ซึ่งสามารถน ามาแบ่งชนิด
ของหุ่นยนต์ได้ดังต่อไปนี้ 

1. Cartesian (Gantry) Robot 
แกนทั้ง 3 ของหุ่นยนต์จะเคลื่อนที่เป็นแบบเชิงเส้น (Prismatic) ถ้าโครงสร้างมีลักษณะคล้าย Overhead 
Crane จะเรียกว่าเป็นหุ่นยนต์ชนิด Gantry แต่ถ้าหุ่นยนต์ไม่มีขาตั้งหรือขาเป็นแบบอ่ืน เรียกว่า ชนิด 
Cartesian 

 
Cartesian Robot Work Envelop Of Cartesian Robot 

ข้อดี  
1. เคลื่อนที่เป็นแนวเส้นตรงทั้ง 3 มิติ 
2. การเคลื่อนที่สามารถท าความเข้าใจง่าย 
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3. มีส่วนประกอบง่ายๆ 
4. โครงสร้างแข็งแรงตลอดการเคลื่อนที่ 

ข้อเสีย 
1. ต้องการพ้ืนที่ติดตั้งมาก 
2. บริเวณท่ีหุ่นยนต์เข้าไปท างานได้ จะเล็กกว่าขนาดของตัวหุ่นยนต์ 
3. ไม่สามารถเข้าถึงวัตถุจากทิศทางข้างใต้ได้ 
4. แกนแบบเชิงเส้นจะ Seal เพ่ือป้องกันฝุ่นและของเหลวได้ยาก 

การประยุกต์ใช้งาน 

เนื่องจากโครงสร้างมีความแข็งแรงตลอดแนวการเคลื่อนที่ ดังนั้นจึงเหมาะกับงานเคลื่อนย้ายของหนักๆ หรือ
เรียกว่างาน Pick-and-Place เช่น ใช้โหลดชิ้นงานเข้าเครื่องจักร (Machine loading) ใช้จัดเก็บชิ้นงาน 
(Stacking) นอกจากนี้ยังสามารถใช้ในงานประกอบ (Assembly) ที่ไม่ต้องการเข้าถึงในลักษณะที่มีมุมหมุน 
เช่น ประกอบอุปกรณ์อิเล็กทรอนิกส์ และงาน Test ต่างๆ 

2. Cylindrical Robot 

หุ่นยนต์ประเภทนี้จะมีแกนที่ 2 (ไหล่) และแกนที่ 3 (ข้อศอก) เป็นแบบ Prismatic ส่วนแกนที่ 1 (เอว) จะ
เป็นแบบหมุน (Revolute) ท าให้การเคลื่อนที่ได้พ้ืนที่การท างานเป็นรูปทรงกระบอก ดังรูป 

 

Cylindrical Robot Work Envelop Of Cylindrical Robot 
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ข้อดี 
1. มีส่วนประกอบไม่ซับซ้อน 
2. การเคลื่อนที่สามารถเข้าใจได้ง่าย 
3. สามารถเข้าถึงเครื่องจักรที่มีการเปิด – ปิด หรือเข้าไปในบริเวณท่ีเป็นช่องหรือโพรงได้ง่าย (Loading) เช่น 
การโหลดชิ้นงานเข้าเครื่อง CNC 

ข้อเสีย 
1. มีพื้นท่ีท างานจ ากัด 
2. แกนที่เป็นเชิงเส้นมีความยุ่งยากในการ Seal เพ่ือป้องกันฝุ่นและของเหลว 

การประยุกต์ใช้งาน 

โดยทั่วไปจะใช้ในการหยิบยกชิ้นงาน (Pick-and-Place) หรือป้อนชิ้นงานเข้าเครื่องจักร เพราะสามารถ
เคลื่อนที่เข้าออกบริเวณที่เป็นช่องโพรงเล็กๆ ได้สะดวก 

3. Spherical Robot (Polar) 

มีสองแกนที่เคลื่อนในลักษณะการหมุน (Revolute Joint) คือแกนที่ 1 (เอว) และแกนที่ 2 (ไหล่) ส่วนแกนที่ 
3 (ข้อศอก) จะเป็นลักษณะของการเคลื่อนที่แนวเส้นตรง ดังรูป 

 

Spherical Robot Work Envelop Of Spherical Robot 

ข้อดี 
1. มีปริมาตรการท างานมากข้ึนเนื่องจากการหมุนของแกนที่ 2 (ไหล่) 
2. สามารถท่ีจะก้มลงมาจับชิ้นงานบนพื้นได้สะดวก 
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ข้อเสีย 
1. มีระบบพิกัด (Coordinate) และส่วนประกอบ ที่ซับซ้อน 
2. การเคลื่อนที่และระบบควบคุมมีความซับซ้อนขึ้น 
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การประยุกต์ใช้งาน 

ใช้ในงานที่มีการเคลื่อนที่ในแนวตั้ง (Vertical) เพียงเล็กน้อย เช่น การโหลดชิ้นงานเข้าออกจากเครื่องปั้ม 
(Press) หรืออาจจะใช้งานเชื่อมจุด (Spot Welding) 

4. SCARA Robot 

หุ่นยนต์ SCARA (Selective Compliance Assembly Robot Arm) จะมีลักษณะแกนที่ 1 (เอว) และแกน
ที่ 3 (ข้อศอก) หมุนรอบแกนแนวตั้ง และแกนที่ 2 จะเป็นลักษณะการเคลื่อนที่ขึ้นลง (Prismatic) ดังรูป 
หุ่นยนต์ SCARA จะเคลื่อนที่ได้รวดเร็วในแนวระนาบ และมีความแม่นย าสูง 

 

SCARA Robot Work Envelop Of SCARA Robot 

ข้อดี 
1. สามารถเคลื่อนที่ในแนวระนาบ และข้ึนลงได้รวดเร็ว 
2. มีความแม่นย าสูง 

ข้อเสีย 
1. มีพื้นท่ีท างานจ ากัด 
2. ไม่สามารถหมุน (rotation)ในลักษณะมุมต่างๆได้ 
3. สามารถยกน้ าหนัก (Payload) ได้ไม่มากนัก 
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การประยุกต์ใช้งาน 

เนื่องจากการเคลื่อนที่ในแนวระนาบและขึ้นลงได้รวดเร็วจึงเหมาะกับงานประกอบชิ้นส่วนทางอิเล็กทรอนิกส์ 
ซึ่งต้องการความรวดเร็วและการเคลื่อนที่ก็ไม่ต้องการการหมุนมากนัก แต่จะไม่เหมาะกับงานประกอบ
ชิ้นส่วนทางกล (Mechanical Part) ซึ่งส่วนใหญ่การประกอบจะอาศัยการหมุน (Rotation)ในลักษณะมุม
ต่างๆ นอกจากนี้ SCARA Robot ยังเหมาะกับงานตรวจสอบ (Inspection) งานบรรจุภัณฑ์ (Packaging) 

5. Articulated Arm (Revolute) 

ทุกแกนการเคลื่อนที่จะเป็นแบบหมุน (Revolute) รูปแบบการเคลื่อนที่จะคล้ายกับแขนคน ซึ่ งจะ
ประกอบด้วยช่วงเอว ท่อนแขนบน ท่อนแขนล่าง ข้อมือ การเคลื่อนที่ท าให้ได้พ้ืนที่การท างาน ดังรูป 

 

Articulated Arm Robot Work Envelop Of Articulated Robot 

ข้อดี 
1. เนื่องจากทุกแกนจะเคลื่อนที่ในลักษณะ ของการหมุนท าให้มีความยืดหยุ่นสูงในการเข้าไปยังจุดต่างๆ 
2. บริเวณข้อต่อ (Joint) สามารถ Seal เพ่ือป้องกันฝุ่น ความชื้น หรือน้ า ได้ง่าย 
3. มีพื้นท่ีการท างานมาก 
4. สามารถเข้าถึงชิ้นงานทั้งจากด้านบน ด้านล่าง 
5. เหมาะกับการใช้มอเตอร์ไฟฟ้า เป็นชุดขับเคลื่อน 
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ข้อเสีย 
1. มีระบบพิกัด (Coordinate) ที่ซับซ้อน 
2. การเคลื่อนที่และระบบควบคุมท าความ เข้าใจได้ยากข้ึน 
3. ควบคุมให้เคลื่อนที่ในแนวเส้นตรง (Linear) ได้ยาก 
4.โครงสร้างไม่มั่นคงตลอดช่วงการเคลื่อนที่ เพราะบริเวณขอบ Work Envelope ปลายแขนจะ 
5. มีการสั่น ท าให้ความแม่ย าลดลง 

การประยุกต์ใช้งาน 

หุ่นยนต์ชนิดนี้สามารถใช้งานได้กว้างขวางเพราะสามารถเข้าถึงต าแหน่งต่างๆ ได้ดี เช่น งานเชื่อม Spot 
Welding, Path Welding, งานยกของ, งานตัด, งานทากาว, งานที่มีการเคลื่อนที่ยากๆ เช่น งานพ่นสี งาน 
Sealing ฯลฯ 

การเลือกหุ่นยนต์ชนิดต่างๆ มาใช้งาน ควรพิจารณาให้เหมาะสมกับงานที่ต้องการให้หุ่นยนต์ท าดังที่อธิบายไว้
ตอนต้น 
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2.0 บทน ำ 
ซอฟตแ์วร ์COSIMIR เป็นซอฟตแ์วรจ์ ำลองกำรท ำงำนของระบบแบบสำมมิติท่ีท ำงำนบนพีซี ส ำหรบัวินโดว ์95, 
98, NT หรือ 2000 ใชส้ ำหรบัออกแบบ workcell เขียนโปรแกรมควบคมุหุ่นยนต ์และจ  ำลองกำรท ำงำนของ 

workcell  
กำรเคล่ือนไหวและหยบิจบัชิ้ นงำนทุกขัน้ตอนจะสำมำรถถูกจ ำลองเพื่อตรวจสอบและหลีกเล่ียงกำรชนของ

หุ่นยนตก์บัวตัถุรอบขำ้งและเพื่อลดเวลำในแต่ละรอบกำรท ำงำนใหน้้อยท่ีสุด  ซอฟตแ์วร ์COSIMIR รองรบักำร
ออกแบบ workcell ดว้ยไลบรำร่ีท่ีมีเคร่ืองจกัร หุ่นยนต ์ เคร่ืองมือ สำยพำนล ำเลียง อุปกรณป้์อนช้ินงำนและ
อื่นๆ นอกจำกน้ีผูใ้ชย้งัสำมำรถออกแบบช้ินงำนหรืออปุกรณอ์ืน่ๆ ในระบบ CAD แลว้น ำเขำ้ไปในซอฟตแ์วร ์
COSIMIR ได ้

2.1 COSIMIR family 
• COSIMIR Industrial 

         ควำมสำมำรถ: 
1. สำมำรถออกแบบ หุน่ยนตใ์น workcell เขียนโปรแกรมควบคมุและจ  ำลองกำรท ำงำนของ

หุ่นยนต ์
2. สำมำรถส่ือสำรกบั คอนโทรลเลอรข์องหุน่ยนต ์Mitsubishi ได ้ 
ขอ้จ  ำกดั: 
1. จ ำลองกำรท ำงำนของหุ่นยนตข์อง MITSUBISHI เท่ำน้ัน 
2. จ ำลองกำรท ำงำนของหุ่นยนตไ์ดเ้พียงหน่ึงตวัเท่ำน้ัน 

• COSIMIR Professional 
ควำมสำมำรถ: 
1. สำมำรถออกแบบ workcell ทัง้หมด เขียนโปรแกรมควบคมุและจ  ำลองกำรท ำงำน ของ 

workcell 
2. จ ำลองกำรท ำงำนของหุ่นยนตม์ำกกว่ำหน่ึงตวัใน  workcell เดียวกนั 
3. สำมำรถส่ือสำรกบั คอนโทรลเลอรข์องหุ่นยนต ์Mitsubishi Kuka และ ABB ได ้ 

• COSIMIR Educational 
เน่ืองจำกควำมซบัซอ้นของระบบอตัโนมติัมำกขึ้ น ท ำให ้COSIMIR Educational เขำ้มำมบีทบำทท ำให้
ผูเ้รียนเขยีนโปรแกรมเพื่อจ ำลองกำรเคล่ือนท่ีของหุ่นยนตก์่อนท่ีจะไปใชก้บัของจริง 
ควำมสำมำรถ: 
1. สำมำรถออกแบบ หุน่ยนตใ์น workcell แต่ไม่สำมำรถบนัทึกได ้  เขียนโปรแกรมควบคมุและ

จ  ำลองกำรท ำงำนได ้ 
2. สำมำรถดำวน์โหลดมำใชไ้ดโ้ดยไม่มีค่ำใชจ้ำ่ยท่ี www.festo.com/didactic  

แลว้เลือกท่ี Service > Software > Software Demos > COSIMIR Demo 
ขอ้จ  ำกดั: 
1. ไม่สำมำรถส่ือสำรกบัคอนโทรลเลอรข์องหุ่นยนตไ์ด ้
2. จ ำลองกำรท ำงำนของหุ่นยนตไ์ดเ้พียงหน่ึงตวั 

http://www.festo.com/didactic
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ในกำรติดตั้งซอฟตแ์วร ์COSIMIR ซอฟตแ์วรต์อ้งกำรคอมพิวเตอรท่ี์มีสเปกอยำ่งต ำ่ดงัตอ่ไปน้ี 
หน่วยประมวลผล (Processor)           : Pentium II 300 MHz Processor หรือสงูกว่ำ 
หน่วยควำมจ ำ (Memory)                   : 128 MB RAM 
พื้ นท่ีว่ำงในฮำรด์ดิสก ์                   : มำกกวำ่ 200 MB  
หน่วยปฏบิติักำร (Operating system): Window 95TM/98TM/NTTM/2000TM 

Graphic Adapter                              : Adapter with 3D acceleration and OpenGL support 
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2.2 ระบบพิกดัจุด (Coordinate System) 
2.2.1 ระบบพิกดัจุด  

• Cartesian coordinate system  
 คือ ระบบพิกดัจุดประกอบดว้ยแกนท่ีตั้งฉำกกนัและมีจุดตัดกนัท่ีเรียกว่ำ จุดก ำเนิด (origin) แกน
สำมแกนในระบบพิกดัจุดน้ี คอืแกน X, Y และ Z  ดงัน้ันจุดใดๆ จะถูกระบุดว้ยต ำแหน่ง (X, Y, Z) 
คือ ระยะทำงระหวำ่งจุดใดๆ กบัจุดอำ้งอิงของแกน X, Y และ Z 

 
 
 
 
 
 
 
 
 
 
 
 

ในวชิำ robotics ระบบพิกดัจุดในระบบน้ีถูกใชด้งัต่อไปน้ี (ดรูปู 2.2.1 ประกอบ) 
•  World coordinate system ซ่ึงโดยทัว่ไปแลว้จะอยูท่ี่มุมล่ำงสุดของพื้ นท่ีท่ีพิจำรณำ 
•  Base coordinate system ตั้งอยูท่ี่ฐำนของหุ่นยนต ์
•  Effector or tool coordinate systems ตั้งอยูท่ี่จุดศนูยก์ลำงของกริปเปอร ์ (Tool center 

point)  
•  Object coordinate systems ตั้งอยูท่ี่ช้ินงำนแต่ละช้ิน 
•  User coordinate system ส่วนใหญ่ตั้งอยูท่ี่วตัถุท่ีไม่เคล่ือนไหวใน workcell 

 
• Joint coordinate system (หรือ Robot coordinate system)  

ถูกน ำมำใชน้อกเหนือจำกระบบพิกดัฉำก Cartesian เป็นระบบพิกดัจุด (องศำ) ท่ีเกิดจำกต ำแหน่ง
ของขอ้ต่อทุกขอ้ต่อ จะระบุต ำแหน่งของจุดโดยใชค้่ำมุมในกำรหมุนของขอ้ต่อทั้งหกขอ้ต่อ ซ่ึงเป็น

ค่ำท่ีหุ่นยนตต์อ้งรกัษำไวเ้พื่อใหไ้ปถึงต ำแหน่งท่ีก ำหนดดว้ยกริปเปอร ์
• Tool coordinate system 

เป็นระบบพิกดัฉำกท่ีอำ้งอิงกบัแกนท่ีหน้ำแปลน (flange) ของหุ่นยนตโ์ดยในระบบพิกดัน้ี ผูเ้รียน
สำมำรถควบคุมทิศทำงของกริปเปอรไ์ดต้ำมทิศทำงของแกน ZE (ดรูปู 2.2.1) ท ำใหส้ะดวกในกำร
ก ำหนดทำงเดินของงำน เช่นในงำน pick and place เป็นตน้ 

 

รปู 2.2.1: ระบบพิกดัจุด 
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2.3 สว่นประกอบของซอฟตแ์วรแ์ละค ำสัง่ตำ่งๆ  
2.3.1 User Interface 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2.3.2 หนำ้ตำ่งยอ่ย 
Workcell window (หนา้ต่างแสดง workcell) 
Workcell จะถูกแสดงในรปูกรำฟฟิกในหน้ำต่ำงน้ี  ผูใ้ชส้ำมำรถเปิดหนำ้ต่ำง 
workcell เพิ่มเติมไดอ้ีกโดยกำรเลือกท่ีค ำสัง่ View > New 
 
 
 
Joint Coordinates 
หน้ำต่ำง Joint Coordinates แสดงต ำแหน่งของขอ้ต่อหุ่นยนตแ์ต่ละขอ้ต่อ 

หน่วยเป็นองศำส ำหรบัขอ้ต่อท่ีหมุนได ้ และเป็นมิลลิเมตรส ำหรบัขอ้ต่อท่ี

เคล่ือนท่ีเป็นเสน้ตรง   
สำมำรถเปิดหน้ำต่ำงน้ีโดยเลือกค ำสัง่ Extras > Robot Position > Show Joint 
Coordinates หรือ กด F7 
 

 

 

 

รปู 2.3.1: User interface 



Introduction to COSIMIR  

บทที่ 2: ท ำควำมรูจ้กักบัซอฟตแ์วรแ์ละ
ภำษำที่เขียน 

2-5 

 
เมื่อ ดบัเบิลคล๊ิก ลงบนหนำ้ต่ำงน้ีจะปรำกฏ dialog box “Set Joint 
Coordinates”  ผูใ้ชส้ำมำรถระบุองศำในกำรหมุนของขอ้ต่อแลว้ดผูลท่ีเกิด

ขึ้ นกบัหุ่นยนตไ์ด ้
 
 
 
World Coordinates 
หน้ำต่ำงน้ีแสดงต ำแหน่งและทิศทำงของ จุดศนูยก์ลำงของกริปเปอร ์ (Tool 
Center Points) ใน world coordinates นอกจำกน้ี ยงัมกีำรระบุต ำแหน่ง 
ทิศทำง และ configuration ของหุ่นยนตใ์นบรรทดัล่ำงสุดของหน้ำต่ำง 
 
สำมำรถเปิดหน้ำต่ำงน้ีโดยเลือกค ำสัง่ Extras > Robot Position > Show World 
Coordinates หรือ กด Shift+F7 
เมื่อ ดบัเบิลคล๊ิก ลงบนหน้ำต่ำงน้ีจะปรำกฏ dialog box “Set World 
Coordinates”  ผูใ้ชส้ำมำรถระบุต ำแหน่งในแกน X, Y และ Z และทิศทำงของขอ้
ต่อแลว้ดผูลท่ีเกิดขึ้ นกบัหุ่นยนตไ์ด ้

 
 
    Teach-In 

หน้ำต่ำง Teach-In ในโหมด Joint coordinates จะแสดงแถบเล่ือนของขอ้ต่อ
และมีปุ่มสองปุ่มในแต่ละขอ้ต่อเพื่อเคล่ือนท่ีขอ้ต่อแต่ละขอ้ซ่ึงเมื่อกดปุ่มเหล่ำน้ี

หุ่นยนตจ์ะเคล่ือนท่ีตำมท่ีเรำก ำหนด ถำ้ปุ่มถูกกดคำ้งเอำไว ้ หุ่นยนตจ์ะเร่ง

ควำมเร็วจนถึงระดบัควำมเร็วท่ีปรบัเอำไว ้ (override) แลว้รกัษำควำมเร็วท่ี

ระดบัน้ันและหลงัจำกน้ันค่อยๆ ลดควำมเร็วลงจนเหลือศนูยห์ลงัจำกท่ีปล่อย

ปุ่ม 
ผูใ้ชส้ำมำรถเปล่ียนโหมดจำก Joint coordinate เป็น World coordinate หรือ 
Tool coordinates 
สำมำรถเปิดหน้ำต่ำงน้ีโดยเลือกค ำสัง่ Extras > Teach-In หรือกด F8 
 
 
Inputs/Outputs 
หน้ำต่ำงน้ีแสดงสถำนะของกำรอินพุท/เอำทพ์ุทของคอนโทรลเลอร ์
สถำนะปัจจบุนัของอินพุท/เอำทพ์ุทถูกแสดงถดัจำกช่ือ สญัญำณ 0 ถูกแสดงดว้ย
สีแดง สญัญำณ 1 ถูกแสดงดว้ยสีเขยีว ค่ำของอินพุทถูกแสดงในวงเล็บ [ ] เช่น 
[1] หมำยถึงอินพุทถูกต่อกบัเอำทพ์ุท ถำ้สญัญำณอินพุทถูกเปล่ียนสถำนะ ค่ำ
ของอินพุทจะถูกแสดงในวงเล็บ <> 
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สำมำรถเปิดหน้ำต่ำงน้ีโดยเลือกค ำสัง่ Extras > Inputs/Outputs > Show 
Inputs/Show Outputs หรือ กด F9 เพื่อเรียกหน้ำต่ำงอินพุท กด shift+F9 เพื่อ
เรียกหน้ำต่ำงเอำทพ์ุท 
 
 
Controller Selection 
แสดงสถำนะของคอนโทรลเลอรทุ์กตวัใน workcell ผูใ้ชส้ำมำรถเลือก

คอนโทรลเลอรห์ลกัและสงัเกตกำรท ำงำนของคอนโทรลเลอรอ์ื่น  ต ำแหน่งของ

หุ่นยนต ์อินพุท เอำทพ์ุท และ Teach-In ท่ีปรำกฏส ำหรบัคอนโทรลเลอรห์ลกั 
สำมำรถเปิดหน้ำต่ำงน้ีโดยเลือกค ำสัง่ Execute > Controller Selection 
 
Robot Program 
หน้ำต่ำงน้ีจะแสดงโปรแกรมส ำหรบัหุ่นยนตซ่ึ์งจะปรำกฏช่ือหุ่นยนตบ์นหน้ำต่ำง 
สำมำรถเปิดหน้ำต่ำงน้ีโดยเลือกค ำสัง่ Menu > Open 
 
 
Position List 
หน้ำต่ำงน้ีจะแสดงรำยกำรต ำแหน่งต่ำงๆ ของหุ่นยนต ์ หวัขอ้บนหน้ำต่ำงแสดง

ช่ือหุ่นยนตเ์จำ้ของต ำแหน่งต่ำงๆ  ในท่ีน้ี คือ RV-E2 
สำมำรถเปิดหน้ำต่ำงน้ีโดยเลือกค ำสัง่ Menu > Open 
 
 
User Input/Output 
หน้ำต่ำงน้ีจะปรำกฏขึ้ นโดยอตัโนมติัถำ้ในโปรแกรมมีค ำสัง่อ่ำนหรือส่งขอ้มลู

ผ่ำน Serial interface เน่ืองจำกเป็นกำรจ ำลอง ขอ้มลูจะไม่ถูกส่งผ่ำนไปยงั

อุปกรณจ์ริงผ่ำน serial interface แต่จะถูกส่งไปยงัหน้ำต่ำงน้ีเมื่อขอ้มลูถูกแสดง 
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2.3.3 ค ำสัง่บน tool bar ที่จ  ำเป็น 
• Move 

 
ค ำสัง่น้ีใชใ้นกำรเคลื่ อนท่ี มุมมองของวตัถุ (View and reference point) จะใชไ้ดก้บัหน้ำต่ำงท่ี
ก ำลงัท ำงำนอยู ่ (active) ซ่ึงมีมุมมองของวตัถุอยู ่ เคร่ืองหมำยจะแสดงแกนท่ีมุมมองสำมำรถ
เคล่ือนท่ีตำมแกนน้ันได ้ลกูศรท่ีเป็นเสน้ประหมำยถึง ไม่สำมำรถเคล่ือนท่ีตำมแกนน้ันได ้
วิธีกำรเรียกค ำสัง่ Move และวิธีใชง้ำน 
1. เรียกค ำสัง่ Move ดว้ยกำรเลือกท่ีไอคอนบน tool bar หรือ View > Move หรือ คล๊ิกขวำท่ี

วินโดวสข์องworkcellแลว้เลือกค ำสัง่ Move 
2. เมื่อเลือกค ำสัง่ Move แลว้ เล่ือนเมำสม์ำท่ีวินโดวสw์orkcellจะปรำกฏสญัลกัษณ ์             

หมำยควำมว่ำ ค ำสัง่ Move พรอ้มใชง้ำน  
3. คล๊ิกซำ้ยเพื่อเคล่ือนท่ีแนวแกน X และ Z หรือคล๊ิกขวำเพื่อเคล่ือนท่ีแนวแกน X และ Y 
 

• Rotate 
 

ค ำสัง่น้ีใชใ้นกำรหมนุ มุมมองของวตัถุ จะใชไ้ดก้บัหน้ำต่ำงท่ีก ำลงัท ำงำนอยู ่ ซ่ึงมีมุมมองของ

วตัถุอยู ่ เคร่ืองหมำยจะแสดงแกนท่ีมุมมองสำมำรถหมุนตำมแกนน้ันได ้ ลกูศรท่ีเป็นเสน้ประ

หมำยถึง ไม่สำมำรถหมุนตำมแกนน้ันได ้
วิธีกำรเรียกค ำสัง่ Rotate และวิธีใชง้ำน 
1. เรียกค ำสัง่ Rotate ดว้ยกำรเลือกท่ีไอคอนบน tool bar หรือ View > Rotate หรือ คล๊ิก

ขวำท่ีวินโดวสข์องworkcellแลว้เลือกค ำสัง่ Rotate 
2. เมื่อเลือกค ำสัง่ Rotate แลว้ เล่ือนเมำสม์ำท่ีวินโดวส ์ workcell จะปรำกฏสญัลกัษณ ์        

หมำยควำมว่ำ ค ำสัง่ Rotate พรอ้มใชง้ำน  
3. คล๊ิกซำ้ยเพื่อเคล่ือนท่ีแนวแกน X และ Z หรือคล๊ิกขวำเพื่อเคล่ือนท่ีแนวแกน X และ Y 

 
• Zoom 

 
ค ำสัง่น้ีใชใ้นกำรขยายหรอืลด มุมมองของวตัถุ จะใชไ้ดก้บัหน้ำต่ำงท่ีก ำลงัท ำงำนอยู ่ ซ่ึงมี

มุมมองของวตัถุอยู ่  
วิธีกำรเรียกค ำสัง่ Zoom และวิธีใชง้ำน 
1. เรียกค ำสัง่ Zoom ดว้ยกำรเลือกท่ีไอคอนบน tool bar หรือ View > Zoom หรือ คล๊ิกขวำ

ท่ีวินโดวสข์อง workcell แลว้เลือกค ำสัง่ Zoom 
2. เมื่อเลือกค ำสัง่ Zoom แลว้ เล่ือนเมำสม์ำท่ีวินโดวส ์ workcell จะปรำกฏสญัลกัษณ ์                                                  

หมำยควำมว่ำ ค ำสัง่ Zoom พรอ้มใชง้ำน  
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3. คล๊ิกซำ้ยแลว้เล่ือนเมำสต์ำมลกูศรในสญัลกัษณ ์เพื่อขยำยมุมมองหรือคล๊ิกซำ้ยแลว้เล่ือน

เมำสใ์นทิศทำงตรงกนัขำ้มกบัลกูศรในสญัลกัษณเ์พื่อลดมุมมอง หรือถำ้ตอ้งกำรขยำย

เฉพำะส่วน ใหน้ ำเมำสค์ล๊ิกในบริเวณท่ีตอ้งกำร หลงัจำกน้ันกด CTRL+Shift พรอ้มกนั
แลว้คล๊ิกขวำพรอ้มกบัลำกเมำสจ์ะปรำกฏกรอบสีด ำเพื่อเลือกบริเวณท่ีตอ้งกำรขยำย  

หลงัจำกน้ันปล่อยเมำส ์ บริเวณท่ีเลือกไวจ้ะถูกขยำยขึ้ น 
นอกจำกน้ีสำมำรถคล๊ิกขวำท่ีรปูแลว้เลือกมุมมองเป็น Front view, Rear view, Top view, 
Left side view, และ Right side view ดงัรปู 2.3.3a 

 
 
 
 
 
 
 
 
 

 
หมำยเหต:ุ  
Full format: ใชค้ ำสัง่ full format เพื่อด ู workcell แบบเต็มหนำ้ตำ่งจำกมุมมอง
ปัจจบุนั 
Rendering: ค ำสัง่ rendering เปลีย่นลกัษณะภำยนอกของวตัถทุกุชิน้ในหน้ำตำ่งworkcell 
โดยลกัษณะภำยนอกมี 3 แบบ คือ 

a) Wireframe: 
  b)   Filled: 

c) Flat-shaded: 
 
 
 
 
 
 
 
 
 
 

 

รปู 2.3.3a 

   

รปู 2.3.3b: Wireframe รปู 2.3.3c: Filled รปู 2.3.3d: Flat-shaded 
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Floor: ค ำสัง่ floor ท ำหน้ำท่ีเปล่ียนลกัษณะภำยนอกของพื้ นท่ีหุ่นยนตต์ั้งอยู ่ โดยสำมำรถ
เปล่ียนลกัษณะ ขนำด และต ำแหน่งของพื้ นได ้ส ำหรบัลกัษณะของพื้ นมี 3 ประเภท คือ 

  a)  No Floor 
  b)  Grid only 

c) Filled Grid 
 
 
 
 
 
 
 
 
 

 
 
 
• Compile  

ใชค้ ำสัง่ compile เพื่อให ้ compiler แปลงโปรแกรมจำกภำษำระดบัสงู (High-level 
language) เช่น MRL และ Melfa Basic IV เป็นภำษำท่ีระดบักลำง (Intermediate-level 
language) 
ผู้ใช้สำมำรถเรียกค ำสัง่ Compile ได้ที่บน Tool bar และ Execute > Compile 

 
• Compile + Link 

ใชค้ ำสัง่น้ีเพื่อให ้ compiler แปลงโปรแกรมจำกภำษำระดบัสงูเป็นภำษำระดบักลำง และ 

linker จะแปลงโปรแกรมจำกภำษำระดบักลำงเป็น IRDATA code 
ผู้ใช้สำมำรถเรียกค ำสัง่ Compile + Link ได้ที่บน Tool bar และ Execute > Compile + Link 

 
• Start 

ใชค้ ำสัง่ Start เพื่อเร่ิมกำรอ่ำนโปรแกรมโดยหุ่นยนตจ์ะเคล่ือนท่ีตำมค ำสัง่ในโปรแกรม โดย
จะอำ่นโปรแกรม 1 รอบ 
ผูใ้ชส้ำมำรถเรียกค ำสัง่ Start ไดท่ี้บน Tool bar และ Execute > Start 

• Start Cycle 

 

 

 

   

รปู 2.3.3e: No floor รปู 2.3.3f: Grid only รปู 2.3.3g: Filled Grid 
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ใชค้ ำสัง่ Start cycle เพื่อเร่ิมอ่ำนโปรแกรมโดยหุ่นยนตจ์ะเคล่ือนท่ีตำมค ำสัง่ในโปรแกรม 

โดยจะท ำงำนตำมโปรแกรม เมื่อจบกำรอำ่นโปรแกรม 1 รอบจะเร่ิมเร่ิมรอบใหม่โดยอตัโนมติั 
จนกว่ำผูใ้ชจ้ะหยุดค ำสัง่ Stop 
ผูใ้ชส้ำมำรถเรียกค ำสัง่ Start ไดท่ี้ Execute > Start Cycle 
 

• Stop 
ใชค้ ำสัง่ Stop เพื่อหยุดกำรอำ่นโปรแกรม ค ำสัง่น้ีจะใชไ้ดก็้ต่อเมื่อมีกำรอำ่นโปรแกรมอยู ่ผูใ้ช้
สำมำรถเรียกค ำสัง่ Stop ไดท่ี้บน Tool bar 
 

• Next Step 
ใชค้ ำสัง่ Next Step เพื่ออำ่นค ำสัง่ถดัไปในโปรแกรม โดยยกเวน้ค ำสัง่ต่อไปน้ี: Path 
smoothing, ตั้งค่ำสญัญำณเอำทพ์ุท, อ่ำนค่ำสญัญำณอินพุท, กำรเรียกโปรแกรมยอ่ย  
 

 
2.3.4 กำรควบคุมหุ่นยนตโ์ดยใช ้Teach-In 

• วิธีกำรเรียกค ำสัง่ teach-in 
ผูใ้ชส้ำมำรถเปิดหน้ำต่ำง Teach-In (ดรูปูในหวัขอ้ 2.3.2 เร่ือง Teach-In ประกอบ) โดยเลือกค ำสัง่ 
Extras > Teach-In หรือกด F8  
 

• โหมดหรือรปูแบบในกำรก ำหนดต ำแหน่งในกำรเคล่ือนท่ีใหหุ้่นยนต ์
รปูแบบในกำรก ำหนดต ำแหน่งในกำรเคล่ือนท่ีมี 3 แบบ คือ แบบ XYZ Jog, แบบ Joint Jog และ 
แบบ Tool Jog   
• XYZ Jog 
รปูแบบกำรก ำหนดต ำแหน่งในกำรเคล่ือนท่ีแบบ XYZ Jog อิงตำมระบบพิกดัจุดแบบ Base 
coordinate system ซ่ึงมีจุดก ำเนิดตั้งอยูท่ี่ฐำนของหุ่นยนต ์(ดรูปู 2.2.1) 
หน้ำต่ำงของรปูแบบกำรก ำหนดต ำแหน่งในกำรเคล่ือนท่ีแบบ XYZ Jog จะปรำกฏดงัรปู 2.3.2a 
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ปุ่มเคล่ือนท่ีตำมแกน X ท ำหนำ้ท่ีใหหุ้่นยนตเ์คล่ือนท่ีในแกน X ทั้งทิศทำงบวกและลบ 
ปุ่มเคล่ือนท่ีตำมแกน Y ท ำหนำ้ท่ีใหหุ้่นยนตเ์คล่ือนท่ีในแกน Y ทั้งทิศทำงบวกและลบ 
ปุ่มเคล่ือนท่ีตำมแกน Z ท ำหนำ้ท่ีใหหุ้่นยนตเ์คล่ือนท่ีในแกน Z ทั้งทิศทำงบวกและลบ 
ปุ่มหมุนรอบแกน X       ท ำหน้ำท่ีใหหุ้่นยนตเ์คล่ือนท่ีหมุนรอบแกน X ทั้งทำงบวกและลบ 
ปุ่มหมุนรอบแกน Y       ท ำหน้ำท่ีใหหุ้่นยนตเ์คล่ือนท่ีหมุนรอบแกน Y ทั้งทำงบวกและลบ 
ปุ่มหมุนรอบแกน Z       ท ำหน้ำท่ีใหหุ้่นยนตเ์คล่ือนท่ีหมุนรอบแกน Z ทั้งทำงบวกและลบ 
เพื่อเคล่ือนท่ีจุดศนูยก์ลำงของกริปเปอร ์(TCP) ไปยงัต ำแหน่งท่ีตอ้งกำร   
หมำยเหต:ุ ในกำรเคล่ือนท่ีตำมแกนหรือหมุนรอบแกนใดๆ น้ัน หุ่นยนตต์อ้งมีองศำอสิระ 

(degree of freedom) ในกำรเคล่ือนท่ีดว้ย ถำ้องศำอิสระไม่เพียงพอ จะปรำกฏค ำเตือนต่ำงๆ ขึ้ น
ในระหว่ำงกำรเคล่ือนท่ี 
ถำ้ผูใ้ชก้ดปุ่มเหล่ำน้ีคำ้งไว ้ หุ่นยนตจ์ะเร่งระดบัควำมเร็วและควำมเร่งไปท่ีระดบัท่ีตั้งไว ้ และรกัษำ

ระดบัควำมเร็วท่ีระดบัน้ันไวแ้ละหลงัจำกน้ันจะลดระดบัควำมเร็วลงจนเหลือศนูยเ์มื่อปล่อยปุ่ม 
ปุ่ม Jog Override ท ำหนำ้ท่ีปรบัควำมเร็วและควำมเร่งในกำรเคล่ือนท่ี   โดยควำมเร็วและ

ควำมเร่งจะแสดงเป็นตวัเลข (หน่วยเป็นเปอรเ์ซนต)์ ท่ีดำ้นล่ำงของปุ่ม   
0% - ควำมเร็วและควำมเร่งต ำ่ 
100% - ควำมเร็วและควำมเร่งสงู 
ปุ่ม Close Hand ท ำหน้ำท่ีปิดกริปเปอร ์เมื่อตอ้งกำรหยบิขิ้ นงำน 
ปุ่ม Current Position -> Pos. List ท ำหน้ำท่ีบนัทึกต ำแหน่งท่ีหุ่นยนตอ์ยู ่ณ ปัจจุบนัลงใน Position 
list 
รปูแบบกำรก ำหนดต ำแหน่งในกำรเคล่ือนท่ีในลกัษณะน้ีเหมำะสมต ำแหน่งท่ีหยบิจบัและเขำ้ใกล้

ช้ินงำน 
• Joint Jog 

 

รปู 2.3.4a: XYZ Jog 
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หน้ำต่ำง Teach-In ในโหมดน้ีไดบ้รรจช่ืุอของขอ้ต่อแต่ละขอ้ต่อและมีปุ่มสองปุ่มในแต่ละขอ้ต่อเพื่อ
เคล่ือนท่ีขอ้ต่อแต่ละขอ้ซ่ึงปุ่มทำงดำ้นซำ้ยส ำหรบัเคล่ือนท่ีในทิศทำงลบ และดำ้นขวำส ำหรบัทิศ

ทำงบวก ส ำหรบัปุ่มอื่นท ำหนำ้ท่ีเหมือนดงัรปู 2.3.4a เมื่อกดปุ่มเหล่ำน้ีหุ่นยนตจ์ะเคล่ือนท่ีตำมท่ี
ก ำหนด ถำ้ปุ่มถูกกดคำ้งเอำไว ้ หุ่นยนตจ์ะเร่งควำมเร็วจนถึงระดบัควำมเร็วท่ีปรบัเอำไวแ้ลว้รกัษำ

ควำมเร็วท่ีระดบัน้ันและหลงัจำกน้ันค่อยๆ ลดควำมเร็วลงจนเหลือศนูยห์ลงัจำกท่ีปล่อยปุ่ม 
 
• Tool Jog 
รปูแบบกำรก ำหนดต ำแหน่งในกำรเคล่ือนท่ีแบบ Tool Jog อิงตำมระบบพิกดัจุดแบบ Tool 
coordinate system ซ่ึงมีจุดก ำเนิดตั้งอยูท่ี่ศนูยก์ลำงของกริปเปอรข์องหุ่นยนต ์ (ดรูปู 2.2.1 
ประกอบ) 

 

2.3.5 กำรแสดงระบบพิกดัจุด 
ท ำหน้ำท่ีแสดงระบบพิกดัจุดต่ำงๆ บน workcell ผูเ้รียนสำมำรถเรียก dialog box ของ ระบบพกิดัจุด 
ใหป้รำกฏโดยไปท่ี Extras > Coordinate systems จะปรำกฏ dialog box ดงัรปู 2.3.5a  ต่อจำกน้ัน
ท ำกำรเลือกระบบพิกดัจุดท่ีตอ้งกำรใหแ้สดง จะปรำกฏระบบพกิดัจุดในworkcell ดงัรปู 2.3.5b   
หมำยเหตุ: เมื่อเลือก Base coordinate system แลว้ไม่เห็นระบบพิกดัจุดปรำกฏ ใหใ้ชค้ ำสัง่ 

rendering เปล่ียน ลกัษณะภำยนอก เป็น wireframe จะปรำกฏ Base coordinate system อยูท่ี่ฐำน
ของหุ่นยนต ์

 
 
 

 

รปู 2.3.4b: Joint Jog 
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2.3.6 Reset workcell 
ค ำสัง่น้ีใชเ้พื่อกลบัสู่สภำวะเร่ิมตน้ของ workcell โดยสภำวะของworkcellจะถูกรีเซ็ทกลบัสู่สภำวะ
เดียวกบัท่ีเพิ่งถูกโหลดจำกไฟล ์   สญัญำณเอำทพ์ุทจะถูกรีเซ็ทดว้ยเช่นกนั  โปรแกรมจะกลบัสู่

บรรทดัแรกและเวลำท่ีใชใ้นกำรรนัโปรแกรมกลบัเป็นศนูย ์  ในกรณีท่ีผูเ้รียนท ำกำรเปล่ียนแปลงเลย์

เอำทข์อง workcell เช่น เคล่ือนยำ้ยหรือหมุนวตัถุหรือเปล่ียนสีของวตัถุ  จะปรำกฏ dialog box ถำม
ว่ำตอ้งกำรวตัถุอยูใ่นสภำวะเดิม 
เรียกค ำสัง่ Reset workcell ท่ี Edit > Reset workcell 

 

 
 
 
 
 
 
 
 
 

  

รปู 2.3.6b: 
ก่อนใชค้ ำสัง่ Reset workcell 

รปู 2.3.6c: 
หลงัใชค้ ำสัง่ Reset workcell 

รปู 2.3.6a: สภำวะเร่ิมตน้ 

 

 รปู 2.3.5a: Coordinate system dialog box 

รปู 2.3.5b:  
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2.3.7 TCP tracking 
ใชค้ ำสัง่ TCP tracking เพื่อแสดงเสน้ทำงกำรเคล่ือนท่ีของจุดศนูยก์ลำงของกริปเปอร ์ (TCP) โดย
แสดงเป็นเสน้สีแดง วธีิกำรเรียกค ำสัง่ TCP tracking คือ Extras > TCP tracking 

 

2.3.8 New window 
ใชค้ ำสัง่ View > New เพ่ือเพ่ิมหนำ้ต่ำง workcell กำรใชห้นำ้ต่ำงหลำยๆ หนำ้ต่ำงอยำ่ง
นอ้ย 2 หนำ้ต่ำง คือ Right side view และ Front view โดยใหแ้ต่ละหนำ้ต่ำงมีมุมมองท่ี
ต่ำงกนัไปมีประโยชน์มำกในกรณีท่ีตอ้งกำรควบคุมและก ำหนดต ำแหน่งในกำรเคล่ือนท่ี

ในกำรจบัช้ินงำน   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2.3.9 Help 
นอกเหนือจำกค ำสัง่ขำ้งตน้แลว้ยงัมีค ำสัง่อื่นอีกมำกมำยท่ียงัไม่ไดก้ล่ำวถึงในหนังสือเล่มน้ี  ดงัน้ันถำ้

ผูท่ี้สนใจค ำสัง่อื่นๆ สำมำรถเปิดดไูดจ้ำก Help ซ่ึงจะมีค ำอธิบำย ในหน้ำต่ำง Help (ดงัรปู 2.3.9a) 
จะประกอบไปดว้ยแท็บ 4 แท็บ คือ Contents, Index, Search และ Favorites 
โดยท่ีแท็บ Content บรรจุเน้ือหำโดยเรียงตำมหวัเร่ือง 
แท็บ Index บรรจุเน้ือหำโดยเรียงตำมล ำดบัตวัอกัษร 
แท็บ Search ส ำหรบัคน้หำค ำสัง่ท่ีตอ้งกำร 
แท็บ Favorites ส ำหรบัเก็บเน้ือหำท่ีใชบ่้อยๆ 
หมำยเหตุ: Help จะปรำกฏขึ้ นพรอ้มกบัโปรแกรมส ำหรบักรณีของ Cosimir educational  

 

 

รปู 2.3.8a:  
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ตวัอย่ำงที่ 2.1: สำธิตวิธีกำรก ำหนดต ำแหน่ง 
หลงัจำกท่ีรูจ้กัส่วนประกอบและค ำสัง่ในซอฟตแ์วรพ์อสมควรแลว้  ตวัอยำ่งน้ีมีวตัถุประสงคใ์ห้

ผูอ้่ำนท ำควำมคุน้เคยกบัซอฟตแ์วร ์ดว้ยกำรก ำหนดต ำแหน่งในกำรเคล่ือนท่ีทั้งหมด 3 จุด: จดุท่ี 1 
คือ จุดสภำวะเร่ิมตน้ จุดท่ี 2 คือ จุดท่ีอยูเ่หนือช้ินงำนและจุดท่ี 3 คือ จุดท่ีหยบิชิ้ นงำน โดยใช ้
โมเดล ‘PickAndPlaceKuka’ 

 
ขัน้ตอนท่ี 1: เปิด โมเดล ‘PickAndPlaceKuka’ 
กำรเปิดโมเดลท ำไดโ้ดยดจูำกบทท่ี 3 หวัขอ้ท่ี 3.1 หนำ้ท่ี 3-1 ถึง 3-10  
ขัน้ตอนท่ี 2: เพิ่มหน้ำต่ำงโมเดลโดยใชค้ ำสัง่ View > New 
ขัน้ตอนท่ี 3: เปิดหน้ำต่ำงส ำหรบับนัทึกต ำแหน่ง (Position List) 
กำรเปิดหน้ำต่ำงท ำไดโ้ดยดจูำกบทท่ี 3 หวัขอ้ท่ี 3.2 หน้ำท่ี 3-10 ถึง 3-13 
ขัน้ตอนท่ี 4: กด F8 เพื่อเปิดหนำ้ต่ำง Teach-In 
เมื่อปฏบิติัตำมขัน้ตอนท่ี 1 ถึง 4 จะปรำกฏหน้ำต่ำงดงัรปู 2.4.1a (หมำยเหตุ: อำจมีหน้ำต่ำง
อื่นท่ีไม่เหมือนกบัสี่หน้ำต่ำงน้ี ใหปิ้ดหน้ำต่ำงเหล่ำน้ันไป) 
ขัน้ตอนท่ี 5: ก ำหนดต ำแหน่ง 
ก่อนกำรก ำหนดต ำแหน่งอำจวำงแผนเกี่ยวกบัต ำแหน่งคร่ำวๆ ในกระดำษดงัเช่นรปู 2.4.1b 
และ c 
 

 
 

 

รปู 2.3.9a:  
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รปู 2.4.1a:  

  

รปู 2.4.1b: รปู 2.4.1c: 
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จุดท่ี 1 คือ สภำวะเร่ิมตน้ ดงัน้ันจุดใดๆ สำมำรถเป็นสภำวะเร่ิมตน้ได ้ ต ำแหน่งเร่ิมตน้ท่ี
ไดม้ำจำกกำรโหลดจำกไฟลส์ำมำรถเป็นต ำแหน่งเร่ิมตน้ได ้ และสำมำรถบนัทึกต ำแหน่งลง

ใน Position Lists ไดท้นัที 
 
 
 
 
 
 
 
 
 
 

จุดท่ี 2 คือ จุดท่ีกริปเปอรอ์ยูเ่หนือช้ินงำน จำกจุดท่ี 1 เคล่ือนท่ีไปจุดท่ี 2 ดว้ยกำรควบคุม
ผ่ำนหน้ำต่ำง Teach-In โดยใชร้ปูแบบกำรเคล่ือนท่ีแบบ Joint jog และ XYZ jog จนกระทัง่
อยูใ่นระยะท่ีอยูเ่หนือช้ินงำนและกริปเปอรต์ั้งฉำกกบัช้ินงำนทั้งสองมุมมอง   
หมำยเหตุ: ยงัไม่บนัทึกจุดท่ี 2 เน่ืองจำกเป็นกำรเห็นดว้ยสำยตำวำ่ตั้งฉำกและยงัไม่แน่นอน
ว่ำจำกจุดท่ี 2 ไปจุดท่ี 3 สำมำรถจบัช้ินงำนไดห้รือไม่ 

 
 
 
 
 
 
 
 
 
 

จุดท่ี 3: จุดท่ีหยบิชิ้ นงำน  เคล่ือนท่ีจำกจุดท่ี 2 ไปจุดท่ี 3 โดยใชร้ปูแบบกำรเคล่ือนท่ีแบบ 
XYZ jog   เร่ิมเคล่ือนท่ีในแนวแกน Z เพื่อทดสอบวำ่กริปเปอรส์ำมำรถจบัช้ินงำนไดพ้อดี
หรือไม่ ถำ้ไม่พอดีสำมำรถขยบัในแกน Y และ X ในระหว่ำงน้ีสำมำรถซมูมำท่ีช้ินงำนได ้ 
เมื่อมัน่ใจวำ่สำมำรถจบัช้ินงำนไดใ้หก้ดปุ่ม Close Hand  แลว้เคล่ือนท่ีขึ้ นในแนวแกน Z 

 

 

รปู 2.4.1d: 

รปู 2.4.1e: 
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หลงัจำกน้ันบนัทึกเป็นต ำแหน่งท่ี 2  เคล่ือนท่ีลงน ำช้ินงำนวำงไวท่ี้เดิม บนัทึกเป็นต ำแหน่ง
ท่ี 3 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
ขัน้ตอนท่ี 6: เมื่อไดท้ั้งสำมต ำแหน่งท่ีตอ้งกำรใหบ้นัทึก Position List ใน C:/My Documents 
ช่ือ example 2_1.POS   
หมำยเหตุ: นอกจำกจะบนัทึกต ำแหน่งแลว้ ยงัสำมำรถใส่ค ำอธิบำย (Comment) ลงไปใน
ต ำแหน่งต่ำงโดยเลือกท่ีต ำแหน่งท่ีตอ้งกำรใส่ค ำอธิบำยแลว้คล๊ิกขวำ เลือก Properties ดงัรปู 
2.4.1i หลงัจำกน้ันจะปรำกฏหน้ำต่ำง dialog box ดงัรปู 2.4.1j เพื่อใส่ค ำอธิบำย เมื่อใส่
ค ำอธิบำยเสร็จเรียบรอ้ยแลว้จะหน้ำต่ำง Position Lists จะปรำกฏขอ้ควำมค ำอธิบำยดงัรปู 
2.4.1k 

 
 

  

 

รปู 2.4.1f: รปู 2.4.1g: 

รปู 2.4.1h: 
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รปู 2.4.1i: 

 

รปู 2.4.1j: 
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แบบฝึกหดัที่ 2.1 
จงก ำหนดต ำแหน่งเพิ่มอีก 2 ต ำแหน่ง คือ P4 และ P5 ดงัรปู 2.5.1a และ b แลว้บนัทึกใน C:/My 
Documents ช่ือ exercise 2_1.POS   

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

รปู 2.4.1k: 

  

รปู 2.5.1a: รปู 2.5.1b: 
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2.4 ค ำสัง่ตำ่งๆ ในภำษำ Movemaster Command (MRL) 
ค ำสัง่ถูกแบ่งออกเป็น 7 หมวด โดยผูเ้รียนตอ้งเลือกค ำสัง่ใหถู้กกบังำน 
a) หมวดกำรควบคุมต ำแหน่งและกำรเคล่ือนท่ี (Position and motion control commands) 

ค ำสัง่ในหมวดน้ีเกี่ยวขอ้งกบัต ำแหน่งและรวมไปถึง กำรก ำหนดควำมเร็วในกำรเคล่ือนท่ี กำรหน่วงเวลำ 

รปูแบบในกำรเคล่ือนท่ี, tool, palette, เป็นตน้ 
b) หมวดกำรควบคุมโปรแกรม (Program control commands) 

ค ำสัง่ในหมวดน้ีเกี่ยวขอ้งกบั กำรเลือกท ำแบบมีเง่ือนไข (conditional branching) กำรท ำซ ้ำ (repetitive 
operation) กำรขดัจงัหวะสญัญำณ (interrupting of signals) และ เคำน์เตอร ์(counter) เป็นตน้ 

c) หมวดกำรควบคุมกริปเปอร ์(Hand control commands) 
ค ำสัง่ในหมวดน้ีเกี่ยวขอ้งกบักำรปิด/เปิดของกริปเปอร ์

d) หมวดกำรควบคุมอินพุท/เอำทพ์ทุ (I/O control commands) 
ค ำสัง่ในหมวดน้ีเกี่ยวขอ้งกบักำรควบคุมอินพุท/เอำทพ์ุทจำกสญัญำณภำยนอก 

e) หมวดกำรค ำนวณทำงคณิตศำสตร(์Operation, substitute, exchange command) 
ค ำสัง่ในหมวดน้ีเกี่ยวขอ้งกบักำรค ำนวณทำงคณิตศำสตร ์เช่น บวก ลบ คณู หำร เป็นตน้ 

f) หมวดกำรติดต่อส่ือสำรผ่ำน RS232C (Communication command: using RS232C) 
ค ำสัง่ในหมวดน้ีเกี่ยวขอ้งกบักำรถ่ำยโอนขอ้มลูภำยในหุ่นยนต ์ เช่น เคำน์เตอร ์ ต ำแหน่ง รำยช่ือโปรแกรม 

สถำนะของสญัญำณอินพุท/เอำทพ์ุท และตวัแปรอื่นๆ ไปยงัคอมพิวเตอร ์
g) ค ำสัง่อื่นๆ 

ค ำสัง่ในหมวดน้ีเกี่ยวขอ้งกบักำรตั้งค่ำตวัแปร กำรเลือกโปรแกรม และกำรใส่ค ำอธิบำยในโปรแกรม 
 

หมำยเหตุ:  ตวัแปรใน <> และ [] มีควำมหมำยดงัต่อไปน้ี 
< > หมำยถึง ตวัแปรของค ำสัง่ 
[ ] หมำยถึง ตวัแปรสำมำรถละเวน้ได ้(จะใส่หรือไม่ใส่ก็ได)้ 

 
หมวดกำรควบคมุต ำแหน่งและกำรเคล่ือนท่ี 
ค ำสัง่ท่ีอยูใ่นหมวดน้ีท่ีใชบ่้อยๆ ไดแ้ก่ 
MO  Move 
MS  Move Straight 
OVR  Override 
SP  Speed 
TI  Timer 
หมำยเหตุ: ค ำสัง่ทั้งหมดท่ีอยูใ่นหมวดน้ี อยูใ่น COSIMIR Help  

COSIMIR  Programming  Movemaster Command  Position and control command 
ค าสั่ง:       MO (Move) 
การท างาน: เคล่ือนปลำยสุดของกริปเปอรไ์ปยงัต ำแหน่งท่ีตอ้งกำรโดยเคล่ือนแบบค ำนวณตำมแกน  
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รูปแบบ:     MO<position number>[,[<O/C>]] 
ค าศัพท:์    <position number> 
    ระบุหมำยเลขต ำแหน่งปลำยทำงเป็นจ ำนวนเต็มตั้งแต่ 1 ถึง 999 
     <O/C> 
     ระบุสถำนะปิด/เปิดของกริปเปอร ์ถำ้ไม่ไดร้ะบุ สถำนะของกริปเปอรจ์ะปรำกฏ 
   O: กริปเปอรเ์ปิด 
   C: กริปเปอรปิ์ด 
ค าอธิบาย:  
(1) เคล่ือนท่ีปลำยสุดของกริปเปอรไ์ปยงัต ำแหน่งท่ีระบุไวโ้ดยกำรเคล่ือนท่ีแบบ กำรเคล่ือนท่ีแบบ

ค ำนวณตำมแกน  
(2) ถำ้มีกำรระบุสถำนะของกริปเปอร ์ หุ่นยนตจ์ะเคล่ือนท่ีหลงัจำกท่ีปิด/เปิดกริปเปอรแ์ลว้ 
(3) ถำ้ไม่ไดร้ะบุสถำนะของกริปเปอร ์ หุ่นยนตจ์ะเคล่ือนท่ีทนัที 
(4) จะมีเสียงรอ้งเตือนถำ้ต ำแหน่งท่ีตอ้งกำรใหหุ้่นยนตเ์คล่ือนท่ีไปไม่ไดก้ ำหนดไว ้ หรือ ต ำแหน่งท่ีจะ

ไปเกินขอบเขตกำรท ำงำนของหุ่นยนต ์
ตวัอย่าง: 
10 SP 10  ‘ตั้งค่ำควำมเร็วท่ี 10’ 
20 MO 20,C  ‘เคล่ือนท่ีไปต ำแหน่งท่ี 20 กริปเปอรปิ์ด’ 
30 MO 30, O  ‘เคล่ือนท่ีไปต ำแหน่งท่ี 30 กริปเปอรเ์ปิด’ 

 
 

ค าสั่ง:       MS (Move Straight) 
การท างาน: เคล่ือนปลำยสุดของกริปเปอรไ์ปยงัต ำแหน่งท่ีตอ้งกำรโดยเคล่ือนท่ีแบบเสน้ตรง  
รูปแบบ:     MS <position number>[,[<O/C>]] 
ค าศัพท:์    <position number> 
    ระบุหมำยเลขต ำแหน่งปลำยทำงเป็นจ ำนวนเต็มตั้งแต่ 1 ถึง 999 
     <O/C> 
     ระบุสถำนะปิด/เปิดของกริปเปอร ์ถำ้ไม่ไดร้ะบุ สถำนะของกริปเปอรจ์ะปรำกฏ 
          O: กริปเปอรเ์ปิด 
     C: กริปเปอรปิ์ด 
ค าอธิบาย:  
(1) เคล่ือนท่ีปลำยสุดของกริปเปอรไ์ปยงัต ำแหน่งท่ีระบุไวโ้ดยกำรเคล่ือนท่ีแบบ กำรเคล่ือนท่ีแบบ

เสน้ตรง    
(2) จะมีเสียงรอ้งเตือนถำ้ต ำแหน่งท่ีตอ้งกำรใหหุ้่นยนตเ์คล่ือนท่ีไปไม่ไดก้ ำหนดไว ้ หรือ ต ำแหน่งท่ีจะ

ไปเกินขอบเขตกำรท ำงำนของหุ่นยนต ์
(3) ถำ้มีกำรระบุสถำนะของกริปเปอร ์ หุ่นยนตจ์ะเคล่ือนท่ีหลงัจำกท่ีปิด/เปิดกริปเปอรแ์ลว้ 
(4) ควำมเร็วในกำรเคล่ือนท่ีถูกก ำหนดโดยค ำสัง่ SP หรือ SD 
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ตวัอย่าง 1: แสดงตวัอย่างการใชค้ าสั่ง 
10 SP 15 ‘ตั้งค่ำควำมเร็วท่ี 15’ 
20 MO 1  ‘เคล่ือนท่ีไปต ำแหน่งท่ี 1 แบบ กำรเคล่ือนท่ีแบบค ำนวณตำมแกน’ 
30 MS 5  ‘เคล่ือนท่ีไปต ำแหน่งท่ี 5 แบบ กำรเคล่ือนท่ีแบบเสน้ตรง’ 
40 MS 6  ‘เคล่ือนท่ีไปต ำแหน่งท่ี 6 แบบ กำรเคล่ือนท่ีแบบเสน้ตรง’ 

 
 ตวัอย่าง 2: แสดงความแตกตา่งของค าสั่ง MO และ MS 
10 SP 8  ‘ตั้งค่ำควำมเร็วท่ี 8’ 
20 MO 1  ‘เคล่ือนท่ีไปต ำแหน่งท่ี 1 โดยกำรเคล่ือนท่ีแบบค ำนวณตำมแกน’ 
30 MR 10,20,30 ‘เคล่ือนท่ีไปต ำแหน่งท่ี 1 โดยกำรเคล่ือนท่ีแบบเสน้ตรง หลงัจำกน้ัน เคล่ือนท่ีไปต ำแหน่ง

ท่ี 30 โดยกำรเคล่ือนท่ีแบบวงกลมโดยค ำนวณเสน้ทำงกำรเคล่ือนท่ีจำกต ำแหน่งท่ี 10 20 
และ 30’ 

40 MS 3 ‘เคล่ือนท่ีไปต ำแหน่งท่ี 1 โดยกำรเคล่ือนท่ีแบบเสน้ตรง’ 
 

 
 

 
ค าสั่ง:       OVR (Override) 
การท างาน: ก ำหนดค่ำอตัรำส่วนของควำมเร็วในกำรเคล่ือนท่ีของหุ่นยนตเ์ป็นเปอรเ์ซนตซ่ึ์งควำมเร็วน้ีจะ

ครอบคลุมกำรเคล่ือนท่ีของหุ่นยนตท์ัง้โปรแกรม 
รูปแบบ:     OVR <specified override> 
ค าศัพท:์    <specified override> 
   ค่ำอตัรำส่วนควำมเร็วเป็นเปอรเ์ซ็นต ์   มีช่วงตั้งแต่ 1 ถึง 200 
ค าอธิบาย:  
(1) ก ำหนดอตัรำส่วนของควำมเร็วในกำรท ำงำนของหุ่นยนต ์ 
(2) ค ำสัง่น้ีมีผลกบักำรเคล่ือนท่ีทุกประเภท เช่น กำรเคล่ือนท่ีแบบค ำนวณตำมแกน, กำรเคล่ือนท่ีแบบ

เสน้ตรง  และ กำรเคล่ือนท่ีแบบวงกลม 
(3) ควำมเร็วท่ีแทจ้ริง ในกรณีต่ำงๆ  

 



Introduction to COSIMIR  

บทที่ 2: ท ำควำมรูจ้กักบัซอฟตแ์วรแ์ละ
ภำษำที่เขียน 

2-24 

 
- กำรเคล่ือนท่ีแบบค ำนวณตำมแกน = playback override * ค่ำอตัรำส่วนควำมเร็วใน

ค ำสัง่ OVR * SP command setting value 
- กำรเคล่ือนท่ีแบบเสน้ตรง = playback override * ค่ำอตัรำส่วนควำมเร็วในค ำสัง่ OVR * 

SP or SD command setting value 
หมำยเหตุ: Playback override คือค่ำควำมเร็วท่ีถูกก ำหนดท่ีคอนโทรลเลอร ์หรือท่ี teaching box 
              Program override คืออตัรำควำมเร็วท่ีถูกระบุอยูใ่นค ำสัง่ OVR ในโปรแกรม 

(4) ค่ำเร่ิมตน้ของ program override เท่ำกบั 100% 
(5) ค่ำอตัรำส่วนควำมเร็วท่ีถูกก ำหนดอยูใ่นโปรแกรมจะมีผลอยูจ่นกระทัง่เจอค ำสัง่ OVR ใหม่หรือจบ

โปรแกรม 
(6) จะมีเสียงเตือนดงัขึ้ นถำ้ระบุคำ่อตัรำส่วนควำมเร็วเท่ำกบัศนูย ์

 
ตวัอย่าง: 
10 SP 30 ‘ก ำหนดระดบัควำมเร็วท่ี 30 ซ่ึงเทียบเท่ำกบัอตัรำส่วนควำมเร็ว 100% ในค ำสัง่ 

OVR โดยดจูำกตำรำงท่ี 2.1’ 
20 OVR 80  ‘ตั้งค่ำอตัรำส่วนควำมเร็วเท่ำกบั 80%’ 
30 MO 2   ‘เคล่ือนท่ีไปต ำแหน่งท่ี 2 โดยเคล่ือนท่ีแบบค ำนวณตำมแกน ’ 
40 ED   ‘จบโปรแกรม’ 
 
ถำ้ playback override ในตวัอยำ่งดำ้นบนถูกก ำหนดใหเ้ท่ำกบั 50%  
ดงัน้ัน อตัรำส่วนของควำมเร็วท่ีแทจ้ริงในกำรเคล่ือนท่ีแบบค ำนวณตำมแกน = 50*80*100(%) = 40% 
หุ่นยนตจ์ะเคล่ือนท่ีไปต ำแหน่งท่ี 2 ดว้ยควำมเร็ว 40% ของค่ำท่ีสงูท่ีสุด 

 
 

ค าสั่ง:       SP (Speed) 
การท างาน: ก ำหนดระดบัควำมเร็ว (Operation speed), ควำมเร่ง/ ควำมหน่วงและตั้งค่ำกำรเคล่ือนท่ีอยำ่ง
ต่อเน่ือง 
รูปแบบ:     SP <speed level> [,<H/L>[,<CNT setting>]] 
ค าศัพท:์    <speed level> 

    ก ำหนระดบัควำมเร็ว มีตั้งแต่ 0 ถึง 30 
    <H/L> 
    ก ำหนดระดบัควำมเร่ง/ควำมหน่วง 
    H: ควำมเร่ง/ ควำมหน่วง สงู (มำกท่ีสุด คือ 0.2 วนิำที) 
    L: ควำมเร่ง/ ควำมหน่วง ต ำ่ (มำกท่ีสุด คือ 0.4 วนิำที) 
    <CNT setting> 
    ก ำหนดสภำวะกำรท ำงำนของโหมดกำรเคล่ือนท่ีอยำ่งต่อเน่ือง (continuous path mode) 
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    0: โหมดกำรเคล่ือนท่ีอยำ่งต่อเน่ืองหยุดท ำงำน 
    1: โหมดกำรเคล่ือนท่ีอยำ่งต่อเน่ืองท ำงำน 

ค าอธิบาย:  
(1) ก ำหนดระดบัควำมเร็วได ้31 คำ่ คือตั้งแต่ 0 ถึง 30 และก ำหนดค่ำเวลำควำมเร่ง/ ควำมหน่วง ได ้

2 ระดบัคือ สงูและต ำ่  
(2) ระดบัควำมเร็วจะถูกก ำหนดเป็นอตัรำส่วน (%) กบัควำมเร็วรอบท่ีมำกท่ีสุดของแต่ละขอ้ส ำหรบั 

กำรเคล่ือนท่ีแบบค ำนวณตำมแกน และอตัรำส่วนกบัควำมเร็วท่ีมำกท่ีสุดของปลำยสุดของแขน 

(650 มม/ วินำที) ส ำหรบักำรเคล่ือนท่ีแบบเสน้ตรง  
(3) เวลำควำมเร่ง คือ เวลำท่ีมำกท่ีสุดส ำหรบัหุ่นยนตท่ี์จะมีควำมเร็วท่ีมำกท่ีสุด  เพรำะฉะน้ัน ถำ้ 

ควำมเร็วในกำรเคล่ือนท่ี มีคำ่ไม่ถึงควำมเร็วสงูสุด  ค่ำเวลำควำมเร่งจะนอ้ยกว่ำคำ่ท่ีระบุเอำไว ้
(4) ระยะทำงท่ีเคล่ือนท่ีในระหว่ำงท่ีมีควำมเร่ง/ ควำมหน่วง จะถกูก ำหนดโดยควำมเร็วท่ีก ำหนดและ 

ควำมเร็วท่ีก ำหนดเอำไวอ้ำจจะไม่ถึงท่ีก ำหนดเอำไวถ้ำ้ระยะทำงในกำรเคล่ือนท่ีสั้น  
(5) ส ำหรบักำรเคล่ือนท่ีแบบเสน้ตรง ปลำยสุดของแขนจะเคล่ือนท่ีท่ีควำมเร็วคงท่ี  ในบำงกรณี  อำจมี

เสียงเตือนเน่ืองจำกขอ้ต่อใดขอ้ต่อหน่ึงมีค่ำควำมเร็วมำกท่ีสุดแลว้ 
(6) เมื่อก ำหนดค่ำควำมเร็วและเวลำควำมเร่ง/ ควำมหน่วง แลว้  ค่ำน้ันจะยงัคงอยูจ่นกระทัง่มีค ำสัง่ 

SP ท่ีมีระดบัควำมเร็วต่ำงไปจำกค่ำเดิม  ค่ำตั้งตน้ในโปรแกรม (default) คือ SP 12, H  ค่ำเวลำ
ควำมเร่ง/ ควำมหน่วง ของครั้งล่ำสุดยงัคงอยูเ่มื่อไม่ไดก้ ำหนดค่ำควำมเร่งอีกครั้ง 

(7) เมื่อก ำหนดใหโ้หมดกำรเคล่ือนท่ีอยำ่งต่อเน่ืองท ำงำน  หุน่ยนตจ์ะเคล่ือนท่ีอยำ่งต่อเน่ืองโดย

ปรำศจำกควำมเร่งและควำมหน่วง จนกระทัง่เจอค ำสัง่ SD หรือ SP ค ำสัง่ใหม่ซ่ึงจะท ำใหโ้หมดกำร
เคล่ือนท่ีอยำ่งต่อเน่ืองหยุดท ำงำน 

 
ตำรำงที่ 2.1: ควำมสมัพนัธร์ะหว่ำงระดบัควำมเร็วและควำมเร็วในกำรเคล่ือนท่ี 

 

SP 
ควำมเร็วในกำรเคล่ือนท่ีของ   

กำรเคล่ือนท่ีแบบค ำนวณตำม

แกน (%) 

ควำมเร็วในกำรเคล่ือนท่ีของ   

กำรเคล่ือนท่ีแบบเสน้ตรง  

(mm/s) 

0 0.1 0.2 
1 0.4 2.7 
2 0.6 3.8 
3 0.8 5.3 
4 1.1 7.3 
5 1.5 9.8 
6 2.0 13.3 
7 2.7 17.8 
8 3.7 23.8 
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SP 
ควำมเร็วในกำรเคล่ือนท่ีของ   

กำรเคล่ือนท่ีแบบค ำนวณตำม

แกน (%) 

ควำมเร็วในกำรเคล่ือนท่ีของ   

กำรเคล่ือนท่ีแบบเสน้ตรง  

(mm/s) 

9 4.9 31.7 
10 6.5 42.4 
11 8.2 53.1 
12 9.7 63.3 
13 11.6 75.3 
14 13.7 89.2 
15 16.2 105.2 
16 19.0 123.7 
17 22.2 144.5 
18 25.9 168.1 
19 29.8 193.8 
20 34.2 222.0 
21 40.7 264.8 
22 47.3 307.6 
23 53.9 350.4 
24 60.5 393.2 
25 67.1 436.0 
26 73.7 478.8 
27 80.2 521.6 
28 86.8 564.4 
29 93.4 607.2 
30 100.0 650.0 

 
ตวัอย่าง: 
10 SP 8               ‘ก ำหนดระดบัควำมเร็วในกำรเคล่ือนท่ีเท่ำกบั 8 ’ 
20 MO 5    ‘เคล่ือนท่ีไปต ำแหน่งท่ี 5 แบบ กำรเคล่ือนท่ีแบบค ำนวณตำมแกน’ 
30 SP 10   ‘ก ำหนดระดบัควำมเร็วในกำรเคล่ือนท่ีเท่ำกบั 10’ 
40 MS 7    ‘เคล่ือนท่ีไปต ำแหน่งท่ี 5 แบบ กำรเคล่ือนท่ีแบบเสน้ตรง’ 
50 ED                          ‘จบโปรแกรม’ 

 
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ค าสั่ง:       TI (Timer) 
การท างาน: หยุดกำรเคล่ือนท่ีตำมช่วงเวลำท่ีก ำหนด 
รูปแบบ:     TI <timer counter>  
ค าศัพท:์    <Timer counter> 
    ตั้งระยะเวลำในกำรหน่วงซ่ึงมีค่ำตั้งแต่ 0 ถึง 32767 (หน่วยเป็น 0.1 วนิำที) 
ค าอธิบาย:  
(1) หุ่นยนตจ์ะหยุดท ำงำนตำมช่วงระยะเวลำท่ีก ำหนดซ่ึงเท่ำกบั timer counter*0.1 วินำที (ระยะเวลำ

ในกำรหน่วงมำกท่ีสุด เท่ำกบั 3267.7 วินำที) 
(2) ค ำสัง่จะถูกใชก้่อนและหลงัจำกท่ีกริปเปอรเ์ปิดหรือปิดส ำหรบักำรหยบิจบัชิ้ นงำน 
(3) ค่ำตั้งตน้ (default) เท่ำกบัศนูย ์
ตวัอย่าง: 
10 MO 1,0              ‘เคล่ือนท่ีไปต ำแหน่งท่ี 1’ 
20 TI 5       ‘หน่วงเวลำ 0.5 วินำที’ 
30 GC      ‘กริปเปอรปิ์ด’ 
40 TI 10   ‘หน่วงเวลำ 1 วนิำที’ 
50 MO 2                        ‘เคล่ือนท่ีไปต ำแหน่งท่ี 2’               
60 ED                            ‘จบโปรแกรม’ 

 
 

หมวดกำรควบคมุโปรแกรม 
ค ำสัง่ท่ีอยูใ่นหมวดน้ีท่ีใชบ่้อยๆ ไดแ้ก่ 
ED  End 
GT  Goto 
หมำยเหตุ: ค ำสัง่ทั้งหมดท่ีอยูใ่นหมวดน้ี อยูใ่น COSIMIR Help  

COSIMIR  Programming  Movemaster Command  Program control command 
 
ค าสั่ง:       ED (End) 
การท างาน: จบโปรแกรม 
รูปแบบ:     ED 
ค าอธิบาย:  
(1) ค ำสัง่ ED จะอยูท่ำ้ยสุดของโปรแกรม   
ตวัอย่าง: 
100 SP 3              ‘ก ำหนดค่ำควำมเร็วในกำรเคล่ือนท่ีเท่ำกบั 3’ 
110 MO 3       ‘เคล่ือนท่ีไปต ำแหน่งท่ี 3’ 
120 MO 5     ‘เคล่ือนท่ีไปต ำแหน่งท่ี 5’ 
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130 ED               ‘จบโปรแกรม’ 

 
ค าสั่ง:       GT (Go To) 
การท างาน: ขำ้มไปบรรทดัท่ีก ำหนดโดยไม่มีเง่ือนไข 
รูปแบบ:     GT <Line number> 
ค าศัพท:์    <Line number> 
    ก ำหนดบรรทดัท่ีจะขำ้มไป สำมำรถใส่จ ำนวนบรรทดัท่ีจะไปไดต้ั้งแต่ 1 ถึง 9999       
ค าอธิบาย:  
(1) ค ำสัง่ GT ท ำใหโ้ปรแกรมขำ้มไปยงับรรทดัท่ีก ำหนด 
(2) จะมีเสียงเตือนดงัขึ้ นในขณะท่ีคอนโทรลเลอรอ์ำ่นค ำสัง่ GT ในกรณีท่ีไม่มีบรรทดัท่ีก ำหนดใหข้ำ้ม

ไป   
ตวัอย่าง: 
10 MO 1       ‘เคล่ือนท่ีไปต ำแหน่งท่ี 1’ 
20 GT 100     ‘กระโดดไปบรรทดัท่ี 100 โดยไม่มีเง่ือนไข’ 
. 
. 
100 MO 12              ‘เคล่ือนท่ีไปต ำแหน่งท่ี 12’ 
110 MO 15                    ‘เคล่ือนท่ีไปต ำแหน่งท่ี 15’               
. 
. 

 
 
หมวดกำรควบคมุกรปิเปอร ์
ค ำสัง่ท่ีอยูใ่นหมวดน้ีท่ีใชบ่้อยๆ ไดแ้ก่ 
GC  Grip Close 
GO  Grip Open 
หมำยเหตุ: ค ำสัง่ทั้งหมดท่ีอยูใ่นหมวดน้ี อยูใ่น COSIMIR Help  

COSIMIR  Programming  Movemaster Command  Hand control command 
 
ค าสั่ง:       GC (Grip Close) 
การท างาน: ปิดกริปเปอร ์
รูปแบบ:     GC [<hand number>] 
ค าศัพท:์    <Hand number> 
    ก ำหนดหมำยเลขกริปเปอร ์ 
    หมำยเลขกริปเปอร ์คือ 1, 2, 3 และ 4    
    ค่ำ default คือ หมำยเลข1     
ค าอธิบาย:  
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(1) กริปเปอรท์ ำงำนดว้ยมอเตอร ์(Motor-operated hand) คือ กริปเปอรห์มำยเลข 1เท่ำน้ัน   
(2) กริปเปอรท์ ำงำนดว้ยลม (Pneumatic hand) ใชโ้ซลินอยดว์ำลว์เพื่อปิด/เปิดกริปเปอร ์  
(3)  หุ่นยนตต์อ้งกำรช่วงระยะเวลำหน่ึงในกำรจดัต ำแหน่งและหยบิชิ้ นงำน เพรำะฉะน้ัน จ ำเป็นท่ีตอ้งมี

กำรหน่วงเวลำก่อนและหลงัค ำสัง่ GC   
ตวัอย่าง: 
10 MO 10,O       ‘เคล่ือนท่ีไปต ำแหน่งท่ี 10 และกริปเปอรเ์ปิด’ 
20 TI 5      ‘หน่วงเวลำ 0.5 วินำที’ 
30 GC               ‘กริปเปอรปิ์ดเพื่อจบัช้ินงำน’ 
40 TI 5      ‘หน่วงเวลำ 0.5 วินำที’ 
50 MO 15,C  ‘เคล่ือนท่ีไปต ำแหน่งท่ี 15 และกริปเปอรปิ์ด’ 

 
 

ค าสั่ง:       GO (Grip Open) 
การท างาน: เปิดกริปเปอร ์
รูปแบบ:     GO [<hand number>] 
ค าศัพท:์    <Hand number> 
    ก ำหนดหมำยเลขกริปเปอร ์ 

               หมำยเลขกริปเปอร ์คือ 1, 2, 3 และ 4    
   ค่ำ default คือ หมำยเลข1     
ค าอธิบาย:  
(1) กริปเปอรท์ ำงำนดว้ยมอเตอร ์(Motor-operated hand) คือ กริปเปอรห์มำยเลข 1เท่ำน้ัน   
(2) กริปเปอรท์ ำงำนดว้ยลม (Pneumatic hand) ใชโ้ซลินอยดว์ำลว์เพื่อปิด/เปิดกริปเปอร ์  
(3)  หุ่นยนตต์อ้งกำรช่วงระยะเวลำหน่ึงในกำรจดัต ำแหน่งและหยบิชิ้ นงำน เพรำะฉะน้ัน จ ำเป็นท่ีตอ้งมี

กำรหน่วงเวลำก่อนและหลงัค ำสัง่ GO   
ตวัอย่าง: 
10 MO 10,C       ‘เคล่ือนท่ีไปต ำแหน่งท่ี 10 และกริปเปอรปิ์ด’ 
20 TI 5      ‘หน่วงเวลำ 0.5 วินำที’ 
30 GO               ‘กริปเปอรเ์ปิดเพื่อปล่อยช้ินงำน’ 
40 TI 5      ‘หน่วงเวลำ 0.5 วินำที’ 
50 MO 15,O  ‘เคล่ือนท่ีไปต ำแหน่งท่ี 15 และกริปเปอรเ์ปิด’ 

 
หมวดกำรควบคมุอินพทุ/เอำทพ์ทุ 
ค ำสัง่ท่ีอยูใ่นหมวดน้ีท่ีใชบ่้อยๆ ไดแ้ก่ 
OB  Output Bit 
TBD  Test Bit Direct 
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หมำยเหตุ: ค ำสัง่ทั้งหมดท่ีอยูใ่นหมวดน้ี อยูใ่น COSIMIR Help  

COSIMIR  Programming  Movemaster Command  I/O control command 
 
ค าสั่ง:       OB (Output Bit) 
การท างาน: ก ำหนดสถำนะเอำทพ์ุทของบิท (Bit) ท่ีก ำหนดผ่ำนทำงพอรท์สญัญำณเอำทพ์ุทภำยนอก 

(external output port) 
รูปแบบ:     OB [<+/->] <output bit number> 
ค าศัพท:์     
<+/-> 
    ก ำหนดสภำวะ ON หรือ OFF ของบิทท่ีก ำหนด 
               +: ON 
               -: OFF 
<Bit number> 
   ก ำหนดหมำยเลขบิทของเอำทพ์ุท ซ่ึงมีค่ำตั้งแต่ 0 ถึง 32767                
ค าอธิบาย:  
(1) + หมำยถึงใหบิ้ทน้ันท ำงำน (ON)  - หมำยถึงใหบิ้ทน้ันหยุดท ำงำน (OFF) 
(2)  บิทอื่นนอกเหนือจำกท่ีก ำหนดไวไ้ม่ไดร้บัผลกระทบใดจำกค ำสัง่น้ี  สถำนะของเอำทพ์ุทท่ีก ำหนด

จะยงัคงอยูใ่นสภำวะเดิมจนกระทัง่มีกำรก ำหนดค่ำใหม่ในบิทน้ันในค ำสัง่ OB 
(3) ส ำหรบักริปเปอรท์ ำงำนดว้ยลม  เรำสำมำรถก ำหนดสัง่ใหก้ริปเปอรปิ์ด/เปิดดว้ยค ำสัง่ OB แต่ไม่

สำมำรถใชก้บักริปเปอรท์ ำงำนดว้ยมอเตอร ์
ตวัอย่าง: 
10 OB -10       ‘สัง่ใหส้ถำนะของบิดท่ี 10 ปิด’ 
20 ED      ‘จบโปรแกรม’ 

 
 

ค าสั่ง:       TBD (Test Bit Direct) 
การท างาน: กระโดดขำ้มไปยงับรรทดัท่ีก ำหนดไว ้ถำ้คำ่ของอินพุทบิทจำกภำยนอกตรงกบัเง่ือนไข 
รูปแบบ:     TBD [<+/->] <input bit number>, <branching line> 
ค าศัพท:์     
<+/-> 
    ก ำหนดสภำวะบิทท่ีจะเป็นเง่ือนไข 
               +: ON 
               -: OFF 
<Input bit number> 
   ก ำหนดหมำยเลขบิทของอินพทุ ซ่ึงมีค่ำตั้งแต่ 0 ถึง 32767         
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<Branching line number>      
   ก ำหนดหมำยเลขบรรทดัท่ีจะกระโดดขำ้มไป ซึ่งมีค่ำตั้งแต่ 1 ถึง 9999   
ค าอธิบาย:  
(1) กระโดดขำ้มไปยงับรรทดัท่ีก ำหนดไว ้ถำ้สถำนะอินพุทจำกภำยนอกตรงกบัเง่ือนไขท่ีก ำหนดไว ้
(2)  โปรแกรมจะกระโดดขำ้มไปยงับรรทดัท่ีก ำหนดไว ้ ถำ้สถำนะของอินพุทตรงกบัเง่ือนไข  ถำ้ไมต่รง

กบัเง่ือนไข โปรแกรมจะอ่ำนค ำสัง่ในบรรทดัถดัไป 
(3) จะมีเสียงเตือนดงัขึ้ น ถำ้ไม่มีบรรทดัท่ีระบุใหก้ระโดดไป 
ตวัอย่าง: 
10 TBD +19,100  ‘ถำ้สญัญำณอนิพุทบิทท่ี 19 ON ใหก้ระโดดไปยงับรรทดัท่ี 100’ 
20 MS 1   ‘เคล่ือนท่ีไปต ำแหน่งท่ี 1 โดย กำรเคล่ือนท่ีแบบเสน้ตรง’ 
30 ED      ‘จบโปรแกรม’ 
. 
. 
100 MO 10  เคล่ือนท่ีไปต ำแหน่งท่ี 10’ 

 
 

ส ำหรับหมวดกำรค ำนวณทำงคณิตศำสตร์  หมวดกำรติดต่อส่ือสำรผ่ำน RS232C และหมวดอื่นๆ ไม่มีกำร
อำ้งถึงในคู่มือกำรใชง้ำนเล่มน้ีแต่ผูเ้รียนสำมำรถคน้ควำ้ค ำสัง่ของทั้งสำมหมวดน้ีใน COSIMIR Help  

COSIMIR  Programming  Movemaster Command  Operation, substitute and exchange 
command/Communication command (Using RS323C)/other command 
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2.5 ค ำสัง่ตำ่งๆ ในภำษำ MELFA BASIC IV 
เนื่องจำก Melfa Basic IV มีฟังก์ชัน่ตำ่งๆ มำกกวำ่ ท ำให้สำมำรถสร้ำงโปรแกรมที่มคีวำมซบัซ้อนได้มำกกวำ่ภำษำ 
Movemaster command   
ค ำสัง่ถูกแบ่งออกเป็น 7 หมวด โดยผูเ้รียนตอ้งเลือกค ำสัง่ใหถู้กกบังำน 
a) หมวดกำรควบคุมต ำแหน่งและกำรเคล่ือนท่ี (Position and motion control commands) 

ค ำสัง่ในหมวดน้ีเกี่ยวขอ้งกบัต ำแหน่งและรวมไปถึง กำรก ำหนดควำมเร็วในกำรเคล่ือนท่ี กำรหน่วงเวลำ 

รปูแบบในกำรเคล่ือนท่ี, tool, palette, เป็นตน้ 
b) หมวดกำรควบคุมโปรแกรม (Program control commands) 

ค ำสัง่ในหมวดน้ีเกี่ยวขอ้งกบั กำรเลือกท ำแบบมีเง่ือนไข (conditional branching) กำรท ำซ ้ำ (repetitive 
operation) กำรขดัจงัหวะสญัญำณ (interrupting of signals) และ  เคำน์เตอร ์ เป็นตน้ 

c) หมวดกำรควบคุมกริปเปอร ์(Hand control commands) 
ค ำสัง่ในหมวดน้ีเกี่ยวขอ้งกบักำรปิด/เปิดของกริปเปอร ์

d) หมวดกำรควบคุมอินพุท/เอำทพ์ทุ (I/O control commands) 
ค ำสัง่ในหมวดน้ีเกี่ยวขอ้งกบักำรควบคุมอินพุท/เอำทพ์ุทจำกสญัญำณภำยนอก 

e) ค ำสัง่อื่นๆ 
ค ำสัง่ในหมวดน้ีเกี่ยวขอ้งกบักำรตั้งค่ำตวัแปร กำรเลือกโปรแกรม และกำรใส่ค ำอธิบำยในโปรแกรม 

 
หมวดกำรควบคมุต ำแหน่งและกำรเคล่ือนท่ี 
ค ำสัง่ท่ีอยูใ่นหมวดน้ีท่ีใชบ่้อยๆ ไดแ้ก่ 
DLY  Delay 
MOV  Move 
MVS  Move Straight 
OVRD  Override 
SPD  Speed 
หมำยเหตุ: ค ำสัง่ทั้งหมดท่ีอยูใ่นหมวดน้ี อยูใ่น COSIMIR Help  

COSIMIR  Programming  Melfa-Basic IV Command  Melfa-Basic IV position and motion 
control command 
 
ค าสั่ง:       DLY (Delay) 
การท างาน: หน่วงเวลำตำมระยะเวลำท่ีก ำหนด 
รูปแบบ:     DLY <time>       
ค าศัพท:์    <time> 
    ระยะเวลำท่ีหน่วง หน่วยเป็นวินำที  ช่วงระยะเวลำท่ีน้อยท่ีสุดท่ีระบุได ้คือ 0.05 วินำที 
ค าอธิบาย:  
(1) ค ำสัง่ DLY ถูกใชเ้พื่อหน่วงเวลำในโปรแกรม   
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(2) ถำ้คอนโทรลเลอรอ์ำ่นค ำสัง่ END หรือค ำสัง่ในบรรทดัสุดทำ้ยของโปรแกรมหรือ ถำ้มีกำรกดปุ่ม

ฉุกเฉิน (Emergency stop) เพื่อหยุดกำรอำ่นโปรแกรมในระหว่ำงท่ีหน่วงเวลำไว ้   สถำนะของ
สญัญำณเอำทพ์ุทจะยงัคงอยูใ่นค่ำเดิม 

ตวัอย่าง: 
10 DLY 30  ‘หน่วงเวลำ 30 วินำที’ 

 
 

ค าสั่ง:       MOV (Move) 
การท างาน: เคล่ือนท่ีจำกต ำแหน่งปัจจุบนัไปยงัต ำแหน่งปลำยทำงโดยเคล่ือนท่ีแบบ กำรเคล่ือนท่ีแบบ

ค ำนวณตำมแกน  
รูปแบบ:     MOV <Target Position> [,[,<Close Distance>] [<Interpolation Type>]] [Appended 
conditions]      
ค าศัพท:์     
<Target Position> คือ ต ำแหน่งปลำยทำง 
<Close Distance> 
ถำ้มีกำรก ำหนดค่ำ close distance   ต ำแหน่งปลำยทำงจริงจะเป็นต ำแหน่งท่ีห่ำงจำกต ำแหน่งท่ีก ำหนด 
(target position) ในแนวแกน Z (+/-) เป็นระยะทำงเท่ำกบั close distance 
+ หมำยถึง ต ำแหน่งปลำยทำงจริงอยูต่ ำ่กวำ่ช้ินงำน 
- หมำยถึง ต ำแหน่งปลำยทำงจริงอยูส่งูกวำ่ช้ินงำน 
<Interpolation type> 
ก ำหนดชนิดของ interpolation ซ่ึงสำมำรถระบุดงัรปูแบบในบรรทดัถดัไป 
Type <Numeric constant1>, <Numeric constant2> 
โดย Numeric constant 1… Detour/short cut = 1/0 
      Numeric constant 2… Invalid 
ค่ำ default คือ 1,0 (detour) 
ค าอธิบาย:  
(1) Detour หมำยถึง ลกัษณะกำรเคล่ือนท่ีท่ีตรงตำมกบัท่ีก ำหนดต ำแหน่งในกำรเคล่ือนท่ี (teach) ให้

หุ่นยนตทุ์กประกำร 
(2) Short cut หมำยถึง ลกัษณะกำรเคล่ือนท่ีในระหว่ำงเดินทำงจำกจุดเร่ิมตน้ไปจุดสุดทำ้ยโดยใชก้ำร

เคล่ือนท่ีท่ีน้อยกว่ำแบบ detour 
(3) กำรก ำหนดลกัษณะกำรเคล่ือนท่ีแบบ detour และ short cut จะมีควำมแตกต่ำงกนัมำกในกรณีท่ี

ตอ้งมีกำรเคล่ือนท่ีในแกนใดแกนหน่ึงมำกกว่ำ 180 องศำ 
(4) Numeric constant2 ไม่มีผลใดๆ กบักำรเคล่ือนท่ีแบบ กำรเคล่ือนท่ีแบบค ำนวณตำมแกน  
ตวัอย่าง: 
10 MOV P1 TYPE 1,0  ‘เคล่ือนท่ีไปต ำแหน่งท่ี 1 โดยมีลกัษณะกำรเคล่ือนท่ีแบบ detour’ 
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 
 

ค าสั่ง:       MVS (Move Straight) 
การท างาน: เคล่ือนท่ีจำกต ำแหน่งปัจจุบนัไปยงัต ำแหน่งปลำยทำงโดยเคล่ือนท่ีแบบ กำรเคล่ือนท่ีแบบ

เสน้ตรง 
รูปแบบท่ี 1:     MVS <Target Position> [,[,<Close Distance>] [<Interpolation Type>]] [Appended 
conditions]      
รูปแบบท่ี 2:     MVS <Separation Distance> [<Interpolation Type>] 
ค าศัพท:์     
<Target Position> คือ ต ำแหน่งปลำยทำง 
<Close Distance> 
ถำ้มีกำรก ำหนดค่ำ close distance  ต ำแหน่งปลำยทำงจริงจะเป็นต ำแหน่งท่ีห่ำงจำกต ำแหน่งท่ีก ำหนด 
(target position) ในแนวแกน Z (+/-) เป็นระยะทำงเท่ำกบั close distance 
+ หมำยถึง ต ำแหน่งปลำยทำงจริงอยูต่ ำ่กวำ่ช้ินงำน 
- หมำยถึง ต ำแหน่งปลำยทำงจริงอยูส่งูกวำ่ช้ินงำน 
<Interpolation type> 
ก ำหนดชนิดของ interpolation ซ่ึงสำมำรถระบุดงัรปูแบบในบรรทดัถดัไป 
Type <Numeric constant1>, <Numeric constant2> 
โดย Numeric constant 1… Detour/short cut = 1/0 
      Numeric constant 2… 3-axis orthogonal/equivalent rotation = 1/0 
ค่ำ default คือ 1,0 (detour, equivalent rotation) 
<Separation Distance> 
ถำ้มีกำรก ำหนดค่ำ separation distance  ต ำแหน่งปลำยทำงจริงจะเป็นต ำแหน่งท่ีห่ำงจำกต ำแหน่งท่ี

ก ำหนด (target position) ในแนวแกน Z (+/-) เป็นระยะทำงเท่ำกบั close distance 
+ หมำยถึง ต ำแหน่งปลำยทำงจริงอยูต่ ำ่กวำ่ช้ินงำน 
- หมำยถึง ต ำแหน่งปลำยทำงจริงอยูสู่งกวำ่ช้ินงำน 
ค าอธิบาย:  
(1) กำรเคล่ือนท่ีแบบเสน้ตรง  คอื ชนิดของกำรเคล่ือนท่ีท่ีหุ่นยนตเ์คล่ือนท่ีจำกต ำแหน่งปัจจุบนัไป

ต ำแหน่งปลำยทำงโดยกริปเปอรเ์คล่ือนท่ีผ่ำนจุดต่ำงๆ ในระหวำ่งจุดเร่ิมตน้ถึงจุดปลำยทำงเป็น

เสน้ตรง 
ตวัอย่าง: 
10 MVS P1   ‘เคล่ือนท่ีไปต ำแหน่งท่ี 1 โดยเคล่ือนท่ีแบบ กำรเคล่ือนท่ีแบบเสน้ตรง’ 

 
 

ค าสั่ง:       OVRD (Override) 



Introduction to COSIMIR  

บทที่ 2: ท ำควำมรูจ้กักบัซอฟตแ์วรแ์ละ
ภำษำที่เขียน 

2-35 

 
การท างาน: ก ำหนดอตัรำส่วนควำมเร็วในกำรเคล่ือนท่ีของหุ่นยนตซ่ึ์งครอบคลมุทัง้โปรแกรม 

รูปแบบ:     OVRD <Designated override>       
ค าศัพท:์     
<Designated override> คือ อตัรำส่วนควำมเร็วเป็นจ ำนวนจริง หน่วยเป็นเปอรเ์ซ็นต ์ (ช่วงตวัเลขท่ีใส่ได้
คือ 1 ถึง 100 ตวัเลข ตวัเลขนอกเหนือจำกช่วงน้ีจะท ำใหเ้กดิ error) นอกจำกจะใส่เป็นตวัเลขแลว้ ยงั
สำมำรถใส่ค่ำแบบท่ีมีกำรกระท ำทำงคณิตศำสตร ์เช่น บวก ลบ คณู หำร เป็นตน้ 
ค าอธิบาย:  
(1) ค ำสัง่ OVRD สำมำรถใชไ้ดก้บัทุกชนิดของกำรเคล่ือนท่ีไม่วำ่จะเป็นกำรเคล่ือนท่ีแบบค ำนวณตำม

แกนหรือแบบเสน้ตรง 
(2) อตัรำส่วนของควำมเร็วท่ีแทจ้ริง ในกรณีต่ำงๆ  

- กำรเคล่ือนท่ีแบบค ำนวณตำมแกน = playback override * อตัรำส่วนควำมเร็วในค ำสัง่ 
OVRD * อตัรำส่วนควำมเร็วในค ำสัง่ JOVRD  

- กำรเคล่ือนท่ีแบบเสน้ตรง = playback override * อตัรำส่วนควำมเร็วในค ำสัง่ OVRD * 
ควำมเร็วในค ำสัง่ SPD  

หมำยเหตุ: Playback override คือค่ำควำมเร็วท่ีถูกก ำหนดท่ีคอนโทรลเลอรห์รือ teaching box  
              Program override จะถูกระบุอยูใ่นค ำสัง่ OVRD ในโปรแกรม 

JOVRD เป็นค ำสัง่ก ำหนดคำ่ควำมเร็วในกำรเคล่ือนท่ีของหุ่นยนตแ์บบตำมแกนเป็น

หน่วยเปอรเ์ซนตเ์ทียบกบัควำมเร็วสงูสุด ซ่ึงครอบคลมุเฉพาะการเคลื่ อนท่ีแบบจากจดุ

ไปจดุเท่าน้ัน 

                        คำ่ default ของ JOVRD command อยูท่ี่ 100% 
ตวัอย่าง: 
10 OVRD 50  ‘ก ำหนดอตัรำส่วนควำมเร็วเท่ำกบั 50%’ 

 
 

ค าสั่ง:       SPD (Speed) 
การท างาน: ก ำหนดควำมเร็วซ่ึงครอบคลมุการเคลื่ อนท่ีแบบเสน้ตรงหรอืวงกลมเท่าน้ัน 

รูปแบบ:     SPD <Designated speed>       
ค าศัพท:์     
<Designated speed> คอื ค่ำควำมเร็วเป็นจ ำนวนจริง หน่วยเป็นมิลลิเมตร/วินำที 
ค าอธิบาย:  
(1) ค ำสัง่ SPD จะท ำหนำ้ท่ีเปล่ียนเฉพำะคำ่ควำมเร็วในกำรเคล่ือนท่ีแบบเสน้ตรงและวงกลมเท่ำน้ัน 
(2) เมื่อก ำหนดค่ำควำมเร็วเป็น M_NSPD หุ่นยนตจ์ะเคล่ือนท่ีท่ีควำมเร็วสงูสุด  
(3) ค่ำควำมเร็วในค ำสัง่ SPD จะยงัคงอยูจ่นกระทัง่คอนโทรลเลอรอ์ำ่นค ำสัง่ SPD ท่ีอยูถ่ดัไป 
(4) ค่ำควำมเร็วในค ำสัง่ SPD จะกลบัสู่ค่ำ default เมื่อจบโปรแกรม 
ตวัอย่าง: 
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10 SPD 100 ‘ก ำหนดค่ำควำมเร็วในกำรเคล่ือนท่ีเป็นเสน้ตรงหรือวงกลมเท่ำกบั 100 มลิลิเมตร/

วินำที’ 
 
ตำรำงที่ 2.2: ตำรำงสรุปค ำสัง่เก่ียวกบักำรก ำหนดควำมเร็ว 
 

ค ำสัง่เก่ียวกบักำรก ำหนดควำมเร็ว ค ำอธิบำย 

ACCEL ก ำหนดควำมเร่งและควำมหน่วงระหวำ่งกำรเคล่ือนท่ี มีหน่วยเป็นเปอรเ์ซนต์

เมื่อเทียบกบัควำมเร่งหรือควำมหน่วงสงูสุด 

OVRD ก ำหนดอตัรำส่วนควำมเร็วในกำรเคล่ือนท่ีของหุ่นยนตซ่ึ์งครอบคลมุทัง้

โปรแกรม หน่วยเป็นเปอรเ์ซนตเ์มื่อเทียบกบัควำมเร็วสงูสุด 

JOVRD ก ำหนดอตัรำส่วนควำมเร็วในกำรเคล่ือนท่ีของหุ่นยนตแ์บบค านวณตามแกน

หน่วยเป็นเปอรเ์ซนตเ์มื่อเทียบกบัควำมเร็วสงูสุด 

SPD ก ำหนดควำมเร็วในกำรเคล่ือนท่ีของหุ่นยนตท่ี์เป็นเสน้ตรงและวงกลม หน่วย

เป็นมิลลิเมตรต่อวินำที 
 

 
 

หมวดกำรควบคมุโปรแกรม 
ค ำสัง่ท่ีอยูใ่นหมวดน้ีท่ีใชบ่้อยๆ ไดแ้ก่ 
END                 End 
GOTO               Go to  
IF THEN ELSE     If Then Else 
หมำยเหตุ: ค ำสัง่ทั้งหมดท่ีอยูใ่นหมวดน้ี อยูใ่น COSIMIR Help  

COSIMIR  Programming  Melfa-Basic IV Command  Melfa-Basic IV program control 
command 
 
ค าสั่ง:       END (End) 
การท างาน: จบโปรแกรม 
รูปแบบ:     END        
ค าอธิบาย:  
(1) ในหน่ึงโปรแกรมสำมำรถมีค ำสัง่ END ไดห้ลำยครั้ง 
(2) ค ำสัง่ END ไม่จ ำเป็นตอ้งอยูต่ ำแหน่งสุดทำ้ยของโปรแกรมเสมอไป 
(3) เมื่อคอนโทรลเลอรอ์ำ่นค ำสัง่ END ค่ำตวัแปรในค ำสัง่ SPD, ACCEL, OADL, JOVRD, OVRD, 

FINE, and CNT จะถูกรีเซ็ท 
ตวัอย่าง: 
100 END ‘ตั้งค่ำควำมเร็วในกำรเคล่ือนท่ีเป็นเสน้ตรงหรือวงกลมเท่ำกบั 100 มิลลิเมตร/วินำที’ 
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 
 

ค าสั่ง:       GOTO (Go to) 
การท างาน: ขำ้มไปยงับรรทดัท่ีก ำหนดไวโ้ดยไม่มีเง่ือนไข 
รูปแบบ:     GOTO <Branch Destination>        
ค าศัพท:์      
<Branch Destination> หมำยถึง บรรทดัท่ีจะกระโดดขำ้มไป’ 

 
 

ค าสั่ง:       IF THEN ELSE (If Then Else) 
การท างาน: กำรเปรียบเทียบเง่ือนไขและจะมีกำรท ำงำนขัน้ตอนต่ำงๆ เม่ือเง่ือนไขเป็นจริงหรือเท็จ  
รูปแบบ:     IF<Expression> THEN<Process> [ELSE<Process>] 
ค าศัพท:์       
<Expression> 
เง่ือนไขทำงคณิตศำสตรห์รือทำงตรรกศำสตรเ์พื่อเปรียบเทียบตวัแปรกบัเป้ำหมำย 
ตวัอยำ่งตวัแปร Robot status variable เช่น 
M_OUT  ตวัแปรเกี่ยวกบัเอำทพ์ุทบิท (General purpose output bit device) 
M_IN  ตวัแปรเกี่ยวกบัอนิพุทบิท (General purpose input bit device) 
หมำยเหตุ: ตวัแปรทั้งหมดท่ีอยูใ่นหมวดน้ี อยูใ่น COSIMIR Help  

COSIMIR  Programming  Melfa-Basic IV Command  Alphabetical overview of Melfa Basic 
IV Robot status variable 

ตวัแปร:      M_OUT  
การท างาน: สำมำรถอำ่นคำ่สญัญำณเอำทพ์ุทและเปล่ียนแปลงค่ำสญัญำณเอำทพ์ุท (Both    

reading and writing) 
รูปแบบ:     M_OUT (Bit Number) = bit signal output  

                            หมำยเหตุ: bit signal output 0=off, 1=on 
ตวัอย่าง:     M_OUT(1) = 0 ‘เปล่ียนค่ำสญัญำณเอำทพ์ุทบิทท่ี 1 ใหม้ีค่ำเป็นศนูยห์รือปิด’ 

 
ตวัแปร:       M_IN  
การท างาน: สำมำรถอำ่นค่ำสญัญำณอินพุทเท่ำน้ัน  
รูปแบบ:     M_IN (Bit Number) = bit signal input 

                        หมำยเหตุ: bit signal input 0=off, 1=on 
ตวัอย่าง:     IF M_IN(1) = 0 THEN 100 ‘ถำ้คำ่สญัญำณอินพุทบิทท่ี 1 มคี่ำเป็นศนูย ์ใหข้ำ้ม

ไป  บรรทดัท่ี 100’ 
<Process> 
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ขัน้ตอนกำรท ำงำนต่อจำกค ำสัง่ THEN เมื่อเง่ือนไขเป็นจริง 
ขัน้ตอนกำรท ำงำนต่อจำกค ำสัง่ ELSE เมื่อเง่ือนไขเป็นเท็จ 

ตวัอย่าง: 
100 IF M1>10 THEN 1000 ‘ถำ้เง่ือนไขตวัแปร M1 มีค่ำมำกกว่ำ 10 เป็นจริงใหข้ำ้มไป

ท ำขัน้ตอนใน   บรรทดัท่ี 1000’ 
110 IF M1>10 THEN GOTO 1000 ELSE GOTO 2000 

‘ถำ้เง่ือนไขตวัแปร M1 มีค่ำมำกกว่ำ 10 เป็นจริงใหข้ำ้มไป
ท ำขัน้ตอนในบรรทดัท่ี 1000 
 ถำ้เง่ือนไขตวัแปร M1 มีค่ำมำกกว่ำ 10 เป็นเท็จใหข้ำ้มไป
ท ำขัน้ตอนใน บรรทดัท่ี 2000’ 

 
 

หมวดกำรควบคมุกรปิเปอร ์
ค ำสัง่ท่ีอยูใ่นหมวดน้ีท่ีใชบ่้อยๆ ไดแ้ก่ 
HCLOSE         Hand Close 
HOPEN                        Hand Open  
หมำยเหตุ: ค ำสัง่ทั้งหมดท่ีอยูใ่นหมวดน้ี อยูใ่น COSIMIR Help  

COSIMIR  Programming  Melfa-Basic IV Command  Melfa-Basic IV hand control 
commands 
 
ค าสั่ง:       HOPEN /HCLOSE (Hand Open/Close) 
การท างาน: สัง่กริปเปอรใ์หเ้ปิดหรือปิด 
รูปแบบ:     HOPEN<Hand No.> [, <Starting grasp force>, <Holding grasp force>, <Starting grasp 

force holding time>] 
           HCLOSE<Hand No.> 

ค าศัพท:์    <Hand No.> 
    ก ำหนดหมำยเลขกริปเปอร ์ซ่ึงมีใหเ้ลือกตั้งแต่ 1 ถึง 8    
    <Starting grasp force> 

ค่ำตวัแปรน้ีใชไ้ดก้บักริปเปอรม์อเตอรเ์ท่ำน้ัน  ก ำหนดค่ำของแรงในกำรจบัขิ้ นงำน (grasping force) 
เมื่อเร่ิมตน้ปิด/เปิดกริปเปอร ์คำ่ของแรงสำมำรถก ำหนดไดต้ั้งแต่ 0 ถึง 63 (63 = 3.5 kgf)  ค่ำ default 
เท่ำกบั 63 

   <Holding grasp force> 
ค่ำตวัแปรน้ีใชไ้ดก้บักริปเปอรม์อเตอรเ์ท่ำน้ัน  ก ำหนดค่ำของแรงในกำรจบัขิ้ นงำนในกำรคงสภำพปิด /
เปิดของกริปเปอร ์คำ่ของแรงสำมำรถก ำหนดไดต้ั้งแต่ 0 ถึง 63 (63 = 3.5 kgf) ค่ำ default เท่ำกบั 63 

  <Starting grasp force holding timer> 
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 ค่ำตวัแปรน้ีใชไ้ดก้บักริปเปอรม์อเตอรเ์ท่ำน้ัน  ก ำหนดช่วงเวลำท่ีใหก้ริปเปอรค์งค่ำของแรงในกำรเร่ิมตน้

ปิด/เปิดกริปเปอร ์ซ่ึงสำมำรถก ำหนดช่วงเวลำไดต้ั้งแต่ 0 วินำที ค่ำ default เท่ำกบั 0.3 วินำที   
ตวัอย่าง: 
10 HOPEN 1  ‘เปิดกริปเปอรห์มำยเลข1’ 
20 HCLOSE 2  ‘ปิดกริปเปอรห์มำยเลข2’ 

 
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ในบทท่ี 3 จะเกี่ยวกบัขัน้ตอนการสรา้งโมเดล ขัน้ตอนการก าหนดต าแหน่งในการเคล่ือนท่ีและขัน้ตอนการเขยีนโปรแกรม 

3.0 สว่นประกอบที่จ  ำเป็นต่อกำรรนัโปรแกรม 
      ส่วนประกอบท่ีจ าเป็นต่อการรนัโปรแกรมมีดงัต่อไปน้ี 

1) โมเดล (model) 
2) ต ำแหน่ง (Position Lists) 
3) โปรแกรม  

 

3.1  ขั้นตอนกำรสรำ้งโมเดล  
ขัน้ตอนการสรา้งโมเดลมีสองวธีิ คือ การเรียกจากไฟลต์วัอยา่ง หรือการสรา้งโมเดลเอง 

3.1.1 ขั้นตอนกำรเรียกโมเดลจำกไฟลต์วัอยำ่ง 
การเรียกไฟลต์วัอยา่งมีอยู ่2 วิธี คือ  
1) เปิดจากไดเร็กทอร่ีท่ีลงซอฟตแ์วร ์COSIMIR Educational ไว ้หรือ 
2)    เปิดจาก COSIMIR Help 
วิธีกำรที่ 1: เปิดจำกไดเร็กทอรี่ที่มีซอฟตแ์วร ์COSIMIR Educational อยู ่

1. หลงัจากเขา้โปรแกรม COSIMIR Education ใหไ้ปท่ี File>Open  เลือกไดเร็กทอร่ีท่ีซอฟตแ์วร ์COSIMIR 
Educational อยูแ่ลว้จะปรากฏหน้าต่าง (Window) ดงัรปู 3.1.1a    

 หมำยเหต:ุ โดย default จะอยูใ่น C:/Program files/COSIMIR Educational   

 
 
 
 
 
 
 
 
 

 2.   เลือกเขา้ไปในโฟลเดอรโ์มเดล จะปรากฏหน้าต่างซ่ึงมี โมเดลใหเ้ลือกมากมาย ดงัรปู 3.1.1b 
 
 
 
 
 
 

 

รปู 3.1.1a 

 

รปู 3.1.1b 
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3.  เลือกโมเดลท่ีตอ้งการ ตวัอยา่งเช่น PickAndPlaceABB ดงัรปู 3.1.1c 

 
 
 
 
 
 
 
 
 

4.  เลือกเขา้ไปท่ี โฟลเดอรโ์มเดล ปรากฏไฟลช่ื์อ PickAndPlaceABB ซ่ึงมีนามสกุล .MOD ดงัรปู 3.1.1d 
 
 
 
 
 
 
 
 

5. เมื่อดบัเบ้ิลคล๊ิกท่ีไฟล ์PickAndPlaceABB จะปรากฏหน้าต่างดงัรปู 3.1.1e 
หมายเหตุ: หน้าต่างท่ีปรากฏอาจมีความแตกต่างจากหนา้ต่างท่ีปรากฏในรปู 3.1.1e คือ อาจมี

หน้าต่างอื่นท่ีนอกเหนือจากหนา้ต่างท่ีเป็น workcell  
 
 
 
 
 
 
 
 
 
 
 

 

รปู 3.1.1c 

 

รปู : 3.1.1d 

 

รปู: 3.1.1e  
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วิธีกำรที่ 2: เปิดจำก COSIMIR Help 

1.  หลงัจากเปิดโปรแกรม COSIMIR Educational แลว้ โปรแกรมจะปรากฏขึ้ นพรอ้มกบั COSIMIR Help 
ใหม้าท่ีหน้าต่างของ COSIMIR Help แลว้คล๊ิกท่ีเคร่ืองหมายบวกดา้นหน้าของ COSIMIR>COSIMIR 
Assistant> COSIMIR Educational> Model  ดงัรปู 3.1.1f ซ่ึงมีโมเดลหุ่นยนตต่์างๆ ใหเ้ลือก 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2.  เลือกท่ีโมเดลท่ีตอ้งการ ตวัอยา่งเช่น PickAndPlaceABB   จะปรากฏหนา้ต่างดงัรปู 3.1.1g หลงัจาก
น้ันกดปุ่ม 

 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

รปู: 3.1.1f 

รปู: 3.1.1g 
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3.  หลงัจากน้ันจะปรากฏหน้าต่างดงัรปู 3.1.1h ใหเ้ลือก ‘Open this file from its current location’  จาก
น้ันคล๊ืก OK    เมื่อคล๊ิก OK แลว้จะปรากฏหน้าต่างเช่นเดียวกบัรปู 3.1.1e   
หมายเหตุ: สาเหตุท่ีไม่สามารถเลือก ‘Save this file to disk’ ไดเ้น่ืองจากขอ้จ ากดัของซอฟตแ์วร ์
Cosimir Educational ท่ีไมส่ามารถบนัทึกโมเดลได ้ 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.1.2 ขั้นตอนกำรสรำ้งโมเดลเอง  
1. หลงัจากเปิดโปรแกรม COSIMIR Educational แลว้ ใชค้ าสัง่ File> Project Wizard จะปรากฏ
หน้าต่างดงัรปู 3.1.2a  

 
 
 
 
 
 
 
 
 
 
 

 

รปู: 3.1.1h 

 

รปู: 3.1.2a 
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2. ใส่ช่ือ Project Name ซ่ึงช่ือของ Project Name จะเป็นช่ือของโมเดล Position Lists และ
โปรแกรมโดยอตัโนมติั ทั้งสามไฟลจ์ะมช่ืีอไฟลเ์หมือนกนัแต่คนละนามสกุล 

3. หลงัจากน้ันกดปุ่ม Next แลว้จะปรากฏหน้าต่างดงัรปู 3.1.2b 
4. เลือกรุ่นของหุ่นยนต,์ จ านวนการด์อินพุทเอาทพ์ุท (I/O interface card), จ านวนกริปเปอร ์
และ ภาษาท่ีจะใชใ้นการเขยีนโปรแกรม 
5. หลงัจากน้ันกดปุ่ม Finish แลว้จะปรากฏหนา้ต่างดงัรปู 3.1.2c ซ่ึงมีทั้งหน้าต่างโมเดล 

Position Lists และโปรแกรม โดยในท่ีน้ีเลือกหุ่นยนต ์RV-2AJ 
 
 
 
 
 
 
 
 
  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

รปู: 3.1.2b 

 

รปู: 3.1.2c 
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3.1.3 ขั้นตอนกำรเพ่ิมวตัถุอื่นๆ ในโมเดล 
ขัน้ตอนน้ีเป็นขัน้ตอนของการเลือกวตัถุอื่นๆ มาประกอบกบัโมเดลเดิมท่ีมีอยูซ่ึ่งมีวิธีการอยู ่2 วธีิ 
คือ การเรียกวตัถุอื่นจาก Model explorer และโดยการใชค้ าสัง่ File > Import  
วิธีที่ 1 คือ กำรเรียกวตัถอ่ืุนๆ จำก Model explorer 
1. ตอ้งมีโมเดลพรอ้มอยูแ่ลว้ 

  2. กดปุ่ ม           บนเมนบูาร์หรือใช้ค าสัง่ Execute> Model Explorer จะปรากฏหน้าตา่งดงัรูป 
3.1.3a 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

รปู 3.1.3a แสดงใหร้ายละเอียดภายใน workcell เช่น ขณะน้ีใน workcell ประกอบไปดว้ยวตัถุ 
(object) 5 อยา่ง คือ หุ่นยนต ์ ABB, กร๊ิปเปอร ์ (Gripper) PGH40, ช้ินงาน 

(PickAndPlaceCrankshaft), PickAndPlaceStorage และ PickAndPlaceStacking ผูเ้รียน

สามารถตรวจสอบไดว้า่ วตัถุช่ือน้ีมรีปูร่างหนา้ตาอยา่งไรโดยการคล๊ิกท่ีช่ือวตัถุน้ัน เช่น 

ABB2400_16 จะปรากฏกรอบลอ้มรอบวตัถุน้ันๆ ไว ้
3. ท าการเพิ่มวตัถุใน workcell โดยคล๊ิกขวาท่ี Object >New> From model library เพื่อเลือก
วตัถุจาก model library ดงัรปู 3.1.3b 

 
 
 
 
 

 

 

รปู: 3.1.3a 
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4. หลงัจากน้ันจะปรากฏหน้าต่างดงัรปู 3.1.3c ซ่ึงมีวตัถุแยกตามประเภทต่างๆ ใหเ้พิ่มไปใน
workcell 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

รปู 3.1.3b 

รปู 3.1.3c 
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5. เลือกวตัถุท่ีตอ้งการเพิ่มลงไป ตวัอยา่ง เช่น ตอ้งการเพิ่มกระบอกสบู ใหค้ล๊ิกท่ีเคร่ืองหมาย

บวกหน้า Miscellaneous Mechanisms หลงัจากน้ันเลือกท่ี Push Cylinder  กดปุ่ม Add ดงั
รปู 3.1.3d 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. หลงัจากกดปุ่ม Add แลว้ Push Cylinder จะกลายเป็นหน่ึงในวตัถุของ workcell แต่เมื่อสงัเกต
จากรปู 3.1.3e จะเห็นว่า Push Cylinder ยงัไม่ปรากฏใน workcell เน่ืองจากอยูภ่ายในฐานของ
หุ่นยนต ์

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

รปู: 3.1.3d 

รปู: 3.1.3e 
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7. ดงัน้ันจึงตอ้งเปล่ียนต าแหน่งของ Push cylinder โดยคล๊ิกขวาท่ี Push cylinder เลือก 

Properties ดงัรปู 3.1.3f 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
8. หลงัจากน้ันจะปรากฏหน้าต่าง “Properties for Object” ซ่ึงมีทั้งหมด 4 แท็บ  ใหเ้ลือกแท็บ 
‘Position’ เพื่อก าหนดต าแหน่งวตัถุ ดงัรปู 3.1.3g 

 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

รปู: 3.1.3f 

รปู: 3.1.3g 
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9. ก าหนดต าแหน่งในแกน x, y และ z เท่ากบั 500 mm, 500 mm และ 70 mm ตามล าดบั จะได ้
โมเดลดงัรปู 3.1.3h    

    
 
 
 
 
 
 
 
 
 
 
 

วิธีที่ 2 คือ กำรเรียกวตัถอ่ืุนโดยใชค้ ำสัง่ File > Import 
1. ตอ้งมีโมเดลพรอ้มอยูแ่ลว้ 
2. ใชค้ าสัง่  File > Import  
3. หลงัจากน้ันเลือกไดเร็กทอร่ีท่ีซอฟตแ์วร ์Cosimir ติดตั้งอยู ่ในท่ีน้ีคือ C:\Program Files\ Cosimir 

Education\ Models\ MiscLibs 
4. เลือกวตัถุท่ีจะน ามาเพิ่มในโมเดล  หลงัจากท่ีเลือกวตัถุแลว้จะปรากฏช่ือวตัถุใน Model explorer 
5. ปรบัต าแหน่งของวตัถุเช่นเดียวกนักบัในแบบท่ี 1 ขอ้ 8 
หมายเหตุ: วิธีแต่ละวธีิมีวตัถุใหเ้ลือกต่างกนั 

 
3.2 ขั้นตอนกำรก ำหนดต ำแหน่งในกำรเคลื่อนท่ี 

เมื่อไดโ้มเดลเรียบรอ้ยแลว้ ขัน้ตอนต่อไปคือการก าหนดต าแหน่งต่างๆ ใหก้บัหุ่นยนตซ่ึ์งมีขัน้ตอนดงัต่อไปน้ี คือ 
1. เปิดหน้าต่างส าหรบับนัทึกต าแหน่งโดยใชค้ าสัง่ File> New จะปรากฎหนา้ต่าง “New”  ใหเ้ลือก MRL 

Position List หรือ Position Lists (COSIMIR position lists) ดงัรปู  3.2.1a ถา้ผูเ้รียนสรา้งโมเดลเองใหข้า้ม
ขัน้ตอนท่ี 1 และ 2 ไดเ้ลย  
หมายเหตุ: MRL Position Lists มีนามสกุลเป็น .POS และ Position Lists มีนามสกุลเป็น .PSL ซ่ึงทั้งสอง
ไฟลส์ามารถบนัทึกต าแหน่งไดแ้ต่ในกรณีท่ีผูเ้รียนเลือกใช ้ Position Lists ก่อนท าการคอมไพลก์บั

โปรแกรมตอ้งเปล่ียนเป็น MRL Position lists เพื่อใหเ้ขา้กบัภาษา MRL และ Melfa Basic IV  
MRL Position Lists และ Position Lists มีคุณสมบติัต่างกนัดงัต่อไปน้ี คือ 

 

รปู: 3.1.3h 
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a) ช่ือต าแหน่งใน Position Lists สามารถเป็นตวัหนังสือหรือตวัเลขก็ได ้ เช่น P901 หรือ 901  

ในขณะท่ีช่ือต าแหน่งใน MRL Position Lists ตอ้งเป็นตวัเลขเท่าน้ัน เช่น 901 เป็นตน้ 
b)  Position Lists สามารถระบตุ าแหนง่โดยใช้ world coordinate joint coordinate หรือ MRL-5 joint 

coordinate  นอกจากนีย้งัสามารถอ้างถงึต าแหนง่โดยการองิจากวตัถ ุ (Relative to object หรือ 
object coordinate) ซึง่คณุสมบตัินีท้ าให้เราสามารถปรับต าแหนง่ใน Position Lists โดยอิงจากการ
เปลีย่นแปลงของวตัถนุัน้ๆ ใน workcell แตใ่นสว่นของ MRL Position Lists ระบตุ าแหนง่โดย world 
coordinate เทา่นัน้  โดยรวมแล้ว Position Lists เป็นเคร่ืองมือส าหรับการก าหนดต าแหนง่ตา่งๆ ซึง่
ท าได้ง่ายกวา่ MRL Position Lists  เพราะมีคณุสมบตัิอื่นๆ เพิ่มมากขึน้ อยา่งไรก็ตาม เมื่อทดสอบ
ต าแหนง่ตา่งๆ เรียบร้อยใน Position Lists เรียบร้อยแล้วให้ท าการเปลีย่นเป็น MRL position lists 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
2.  หลงัจากกดปุ่ม OK จะปรากฏหน้าต่างดงัรปู 3.2.1b 

 
 
 
 
 
 
 
 
 
 

 

 

รปู 3.2.1a 

รปู 3.2.1b 
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3. เน่ืองจากการก าหนดต าแหน่งของหุ่นยนตใ์นซอฟตแ์วรม์ีขอ้จ ากดั คือ อาจจะมีมิติความลึกท่ีไม่เหมือนกบัการ
มองหุ่นยนตข์องจริง ดงัน้ันจึงขอแนะน าใหใ้ช ้workcell เพิ่มอีกหน่ึงหน้าต่างโดยใชค้ าสัง่ View > New เพื่อใหเ้ห็น
ต าแหน่งต่างๆ ไดดี้ขึ้ น โดยเฉพาะอยา่งยิง่ในขณะท่ีหยบิชิ้ นงาน ดงัรปู 3.2.1c 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. ปรบัหนา้ต่างแรกใหเ้ป็น Right side view และหน้าต่างท่ีสองใหเ้ป็น Front view ดงัรปู 3.2.1d 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5.  เรียก Teach-In Box ขึ้ นมาเพื่อก าหนดต าแหน่ง (วิธีการก าหนดต าแหน่งใหด้จูากบทท่ี 2) 

 

รปู: 3.2.1c 

 

รปู: 3.2.1d 
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6. หลงัจากท่ีมีการโหลดและสรา้งอุปกรณต่์างๆ ใน workcell และก าหนดต าแหน่งใหก้บัหุ่นยนตแ์ลว้  ดงัน้ัน 

ก่อนท่ีจะท าการจ าลองการท างานควรท่ีจะมีการตรวจสอบว่าต าแหน่งท่ีก าหนดใหก้บัหุ่นยนตน้ั์นอยูใ่น 

workspace ของหุ่นยนตห์รือไม่ เพื่อป้องกนัความผิดพลาดในระหว่างจ าลองการท างาน   การตรวจสอบว่า
ต าแหน่งใดๆ อยูใ่น workspace สามารถท าไดโ้ดยเลือกท่ีต าแหน่งท่ีตอ้งการตรวจสอบ แลว้ใชค้ าสัง่ Extras > 
Position List > Check Reachability  สามารถตรวจสอบไดค้รั้งละหน่ึงต าแหน่ง ดงัรปู 3.2.1e  หลงัจากการ
ตรวจสอบ ต าแหน่งท่ีไม่อยูใ่น workspace จะปรากฏเป็นสีเทา 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.3  ขั้นตอนกำรเขียนโปรแกรม 
1. เปิดหน้าต่างส าหรบัเขยีนโปรแกรมโดยใชค้ าสัง่ File > New จะปรากฏหน้าต่าง dialog box ดงัรปู 3.3.1a เลือก 
ภาษาท่ีจะใชเ้ขยีนคือ Movemaster Command Program หรือ Melfa Basic IV  

 
 
 
 
 
 
 
 
 
 

 

 

รปู: 3.3.1a 

รปู: 3.2.1e 
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2. กดปุ่ม OK จะปรากฏหน้าต่างส าหรบัเขยีนโปรแกรม ดงัรปู 3.3.1b 

 
 
 
 
 
 
 
 
 
 
 

 
 
 
 3. วางแผนในการเขยีนโปรแกรม 

วิธีการเขยีนโปรแกรมอยา่งเป็นระบบเร่ิมจาก 
1) เขา้ใจ (โจทย)์ ปัญหา 
2) วิเคราะหปั์ญหา: ศึกษาปัญหาโดยแบ่งเป็นปัญหายอ่ยๆ  และหาขอ้มลูขาเขา้ (input) และขอ้มลูขาออก 

(output) ของปัญหา 
3) ออกแบบขัน้ตอนการเขยีนโปรแกรม (algorithm)  
4) พฒันาโปรแกรม: แปลงขัน้ตอนการแกปั้ญหาเป็นภาษา MRL หรือ Melfa Basic IV 
5) ทดสอบโปรแกรม: เมื่อท าการตรวจสอบความถูกตอ้งของโปรแกรมแลว้ใหบ้นัทึกโปรแกรม  
ในกรณีท่ีเลือกใชภ้าษา MRL ใชค้ าสัง่ compile+Link บน tool bar เพือ่แปลงโปรแกรมเป็น IRDATA Code 
หลงัจากน้ันใชค้ าสัง่ Start บน tool bar เพื่อรนัโปรแกรม 
ส าหรบักรณีของภาษา Melfa Basic IV จะมีขัน้ตอนของ Project Management ท่ีเพิ่มเติมขึ้ นมา  Project 
management ช่วยในเร่ืองการจดัการไฟลโ์ปรแกรมซ่ึงใชภ้าษาในการเขยีนท่ีต่างกนักล่าวคือ ในหน่ึงโปรเจกท์
ผูเ้รียนสามารถเลือก Melfa Basic IV ในการรนัโปรแกรมในครั้งแรก และในครั้งถดัไปสามารถเลือกภาษาท่ี
ต่างไปจาก Melfa Basic IV ได ้Project Management สามารถรองรบัภาษา V+, RAPID, KRL และ Melfa 
Basic IV แต่ไม่รองรบัภาษา MRL 
ขัน้ตอนของ Project Management มีดงัต่อไปน้ี    

a) ใชค้ าสัง่ Execute > Project Management จะปรากฏหน้าจอดงัตวัอยา่งในรปู 3.3.1c   
b) กดปุ่ม ‘Add New Project’ แลว้เลือกไดเร็กทอร่ีท่ีจะบนัทึกโปรเจกทด์งัตวัอยา่งในรปู 3.3.1d 

 

รปู: 3.3.1b 
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c) เลือกแท็บ ‘Files’ แลว้ใส่ ‘Source Files’ คือ โปรแกรมและ Position Lists ใหก้บัโปรเจกท ์โดยใช้

ปุ่ม ‘Add Files’ เพื่อเลือกไฟลโ์ปรแกรมและ Position Lists ท่ีไดบ้นัทึกไว ้ เสร็จแลว้จะไดด้งั
ตวัอยา่งในรปู 3.3.1e  และเลือกโปรแกรมจาก compile mode เป็น main program  

d) ท าการคอมไพลโ์ปรเจกทโ์ดยใชค้ าสัง่ Compile Project 
e) รนัโปรแกรมโดยใชค้ าสัง่ Start บน tool bar 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

    

รปู 3.3.1c:  
Project Management 
Dialog Box 

รปู: 3.3.1d 
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ตวัอย่ำงที่ 3.1: สำธิตวิธีกำรเขียนโปรแกรม 

จงเขยีนโปรแกรมควบคุมหุ่นยนตโ์ดยใช ้Movemaster Command Program ใหหุ้่นยนตเ์คล่ือนท่ีไปหยบิชิ้ นงาน
ขึ้ นมาจาก Storage  หมายเหตุ: ใชโ้มเดล PickAndPlaceKuka และใชต้ าแหน่งท่ีก าหนดในตวัอยา่งท่ี 2.1 (ช่ือ
ไฟล:์ exercise 2_1.POS) 

ขัน้ตอนท่ี 1: เขา้ใจปัญหา 
ขัน้ตอนท่ี 2: วเิคราะหปั์ญหา 
เน่ืองจากปัญหาน้ียงัไม่มีความซบัซอ้นเท่าใดนัก คือ หุ่นยนตท์ างานตามล าดบัขัน้ตอน ดงัน้ันจึงสามารถ

ใชเ้ทคนิค sequential programming คือการท างานแบบเป็นล าดบัขัน้ตอน (step-by-step execution) 
ซ่ึงเป็นเทคนิคเบ้ืองตน้ส าหรบัผูเ้ร่ิมตน้ 

ขัน้ตอนท่ี 3: ออกแบบ 
ออกแบบขัน้ตอน เสน้ทางการเคล่ือนท่ีและการท า 
งานท่ีต าแหน่งต่างๆ ซึ่งมีล าดบัขัน้ตอนหลกัดงัน้ี 

1) เคล่ือนท่ีไปต าแหน่งท่ี 1  
2) เคล่ือนท่ีไปต าแหน่งท่ี 2 (ตามแนวแกน) 
3) เคล่ือนท่ีไปต าแหน่งท่ี 3 (แบบเสน้ตรง) 
4) หยบิชิ้ นงาน 
5) เคล่ือนท่ีไปต าแหน่งท่ี 2 (แบบเสน้ตรง) 

 
 

รปู: 3.3.1e 

รปู 3.3.2a: ตวัอยา่งการออกแบบล าดบัขัน้ตอนการท างานและ
เสน้ทางการเคล่ือนท่ี 
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หลงัจากเรียงล าดบัขัน้ตอนหลกัแลว้ก็พิจารณาวา่สมควรมีขัน้ตอนยอ่ยหรือไม่  ในกรณีท่ีขัน้ตอนหลกั

อธิบายขัน้ตอนการท างานไวค้รบถว้นก็ไม่จ าเป็นตอ้งมีขัน้ตอนยอ่ย  ขัน้ตอนท่ี 1 และ 2 มีความชดัเจน
อยูแ่ลว้ ขัน้ตอนท่ีตอ้งเพิ่มรายละเอียดมีดงัต่อไปน้ี 

ล าดบัท่ี 3 เคล่ือนท่ีไปต าแหน่งท่ี 3 
3.1 หน่วงเวลา 1 วนิาที  

ล าดบัท่ี 4 หยบิชิ้ นงาน 
4.1 หน่วงเวลา 1 วินาที 

ดงัน้ัน ล าดบัขัน้ตอนทั้งหมด คือ 
1. เคล่ือนท่ีไปต าแหน่งท่ี 1 
2. เคล่ือนท่ีไปต าแหน่งท่ี 2 (ตามแนวแกน) 
3. เคล่ือนท่ีไปต าแหน่งท่ี 3 (แบบเสน้ตรง) 

3.1 หน่วงเวลา 1 วินาที 
4. หยบิชิ้ นงาน 

4.1 หน่วงเวลา 1 วนิาที 
5. เคล่ือนท่ีไปต าแหน่งท่ี 2 (แบบเสน้ตรง) 

ขัน้ตอนท่ี 4: พฒันาโปรแกรม 
ในขัน้ตอนการพฒันาโปรแกรม ใหน้ าขัน้ตอนทั้งหมดมาเขยีนเป็นภาษา Movemaster command 
program ดงัรปู 3.3.2b 

 
 
 
 
 
 
 
 

ขัน้ตอนท่ี 5: ทดสอบโปรแกรม 
ตรวจสอบผลการท างานของโปรแกรมโดยจ าลองการท างาน  ถา้ผลการท างานไม่ตรงตามตอ้งการให้

ทบทวนแกไ้ขโปรแกรมและตรวจสอบจนแน่ใจว่าการท างานเป็นไปตามท่ีปัญหาก าหนดไว ้
เมื่อจบตวัอยา่งท่ี 3.1 ผูเ้รียนสามารถท าแบบฝึกหดัขอ้ 3.1 ถึง 3.3 ในหน้าท่ี 30 ได ้
 
 
 
 
 

 

รปู: 3.3.2b 
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ตวัอย่ำงที่ 3.2: I/O connection และ structured programming 
       
   

ต ำแหน่ง ค ำอธิบำย 
901 ต าแหน่งเร่ิมตน้ (Home) 
902 ต าแหน่งท่ีหยบิชิ้ นงานในถาด (Tray) 
903 ต าแหน่งท่ีวางช้ินงานในหลุม (socket) 
904 ต าแหน่งท่ีหยบิลกูสบูสีเทา (ขนาดเล็ก) 
905 ต าแหน่งท่ีห่างจากลกูสบูสีเทามาทางซา้ยมือ 

906 ต าแหน่งท่ีวางลกูสบูสีเทาลงในช้ินงาน 

907 ต าแหน่งท่ีหยบิลกูสบูสีด า (ขนาดใหญ่) 
908 ต าแหน่งท่ีห่างจากลกูสบูสีด ามาทางซา้ยมือ 

909 ต าแหน่งท่ีวางลกูสบูสีด าลงในช้ินงาน 

910 ต าแหน่งท่ีหยบิสปริง 

911 ต าแหน่งท่ีวางสปริงลงในช้ินงาน 

912 ต าแหน่งท่ีหยบิฝา 

913 ต าแหน่งท่ีวางฝาลงบนช้ินงาน 

914 ต าแหน่งท่ีประกอบฝากบัช้ินงาน 

915 ต าแหน่งเหนือสไลด ์(slide) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

จงเขยีนโปรแกรมควบคุมหุ่นยนตโ์ดยใชภ้าษา 

Melfa Basic IV ใหหุ้่นยนตป์ระกอบช้ินงาน 
(Housing) เขา้กบัฝา ใชโ้มเดล MPS 
RobotAssembly ดงัรปู 3.3.3a และใชต้ าแหน่ง 
และอินพุทเอาทพ์ุท จากไฟลต์วัอยา่งดงัตารางท่ี 
3.3.1 และ 3.3.2 ตามล าดบั 

หมายเหตุ: เมื่อเรียกหน้าต่าง workcell ขึ้ นมาแลว้ 
จะพบว่าไม่มีช้ินงาน ดงัน้ันใหเ้รียกช้ินงานในขณะท่ี

หน้าต่าง workcell ท างานอยู ่โดยใชค้ าสัง่ File > 
Import หลงัจากน้ันเลือก Program files > 
COSIMIR Educational > Model > MPS-
RobotAssembly > Import มีช้ินงานใหเ้ลือกสามสี 
คือ HousingBlack, HousingRed และ 
HousingSilver เลือกสีใดสีหน่ึงเท่าน้ัน 

 

รปู 3.3.3a 

ตารางท่ี 3.3.1: ตารางแสดงต าแหน่งต่างๆ พรอ้มค าอธิบาย 
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ขัน้ตอนท่ี 1: เขา้ใจปัญหา    
ขัน้ตอนท่ี 2: วเิคราะหปั์ญหา 

เน่ืองจากปัญหาน้ีค่อนขา้งมีความซบัซอ้น ดงัน้ันเพื่อลดความซบัซอ้นจึงน าเทคนิคการเขยีนโปรแกรม

แบบ Structured programming มาใชเ้พื่อแบ่งเป็นปัญหายอ่ยๆ คือ โปรแกรมหลกั (main program) 1 
โปรแกรมเพื่อควบคุมล าดบัการท างานของโปรแกรมยอ่ย และโปรแกรมยอ่ย (subprogram) 3 
โปรแกรม คอื โปรแกรมรีเซ็ทสู่สภาวะพรอ้มท างาน (initailize) โปรแกรมหยบิช้ินงานจากถาดมาวางไว้
ท่ีหลุม  โปรแกรมประกอบฝาเขา้กบัชิ้ นงาน  

ขัน้ตอนท่ี 3: ออกแบบ 
โปรแกรมรีเซ็ทสูส่ภำวะเริ่มตน้  
ล าดบัขัน้ตอน: 

1. ก าหนดความเร็ว 
2. เคล่ือนท่ีสู่ต าแหน่งเร่ิมตน้ 
3. เปิดกริปเปอร ์
4. กลบัสู่โปรแกรมหลกั 

โปรแกรมหยบิข้ินงำนจำกถำดวำงไวท่ี้หลมุ 
1. ตรวจสอบวา่มีช้ินงานท่ีถาดหรือไม่ 
2. เคล่ือนท่ีมาต าแหน่งเหนือช้ินงาน 
3. เคล่ือนท่ีมาต าแหน่งท่ีหยบิชิ้ นงาน 
4. ปิดกริปเปอร ์
5. เคล่ือนท่ีเหนือต าแหน่งท่ีหยบิชิ้ นงาน 
6. เคล่ือนท่ีเหนือต าแหน่งท่ีวางช้ินงานในหลุม 
7. เคล่ือนท่ีมาต าแหน่งท่ีวางช้ินงาน 
8. เปิดกริปเปอร ์

อินพทุ ค ำอธิบำย เอำทพ์ทุ ค ำอธิบำย 
0 ตรวจสอบวา่กริปเปอรอ์ยูใ่นสภาวะปิด  0 ปิดกริปเปอร ์ 

1 ตรวจสอบวา่มีฝาอยูใ่นแมกกาซีน A  1 ใหฝ้าช้ินถดัไปพรอ้มท่ีจะถูกเล่ือนออก 

2 ตรวจสอบวา่มีลกูสบูขนาดใหญ่ 2 ใหก้ระบอกสบูเล่ือนฝาออกมา 

3 ตรวจสอบวา่มีลกูสบูขนาดเล็ก 3 ใหล้กูสบูขนาดใหญ่ช้ินถดัไปพรอ้มท่ีจะถูกเล่ือนออก 

4 ตรวจสอบวา่มีสปริงอยูใ่นแมกกาซีน B 4 ใหล้กูสบูขนาดเล็กช้ินถดัไปพรอ้มท่ีจะถูกเล่ือนออก 

5 ตรวจสอบวา่มีช้ินงานเป็นสีด า 5 ใหส้ปริงช้ินถดัไปพรอ้มท่ีจะถูกเล่ือนออก 

6 ตรวจสอบวา่มีสปริง 6 ใหก้ระบอกสบูเล่ือนสปริงออกมา 

7 ตรวจสอบวา่ฝาถูกกระบอกสบูเล่ือนออกมาแลว้   
8 ตรวจสอบวา่สปริงถูกกระบอกสบูเล่ือนออกมาแลว้   
9 ตรวจสอบวา่มีช้ินงานอยูใ่นถาด   

ตำรำงที่ 3.3.2: ตำรำงแสดงอินพทุและเอำทพ์ทุของ workcell พรอ้มค ำอธิบำย 
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9. เคล่ือนท่ีเหนือต าแหน่งท่ีวางช้ินงาน 
10. กลบัสู่โปรแกรมหลกั 

โปรแกรมประกอบฝำเขำ้กบัช้ินงำน 
1. เคล่ือนท่ีเหนือต าแหน่งท่ีหยบิฝา 
2. ใหก้ระบอกสบูเล่ือนฝาออกมา 
3. ตรวจสอบวา่ฝาถูกเล่ือนออกแลว้ 
4. ใหก้ระบอกสบูเคล่ือนท่ีเขา้ 
5. ใหฝ้าช้ินถดัไปพรอ้มท่ีจะถูกเล่ือนออก 
6. เคล่ือนท่ีมาต าแหน่งท่ีหยบิฝา 
7. ปิดกริปเปอร ์
8. เคล่ือนท่ีมาต าแหน่งเหนือฝา 
9. เคล่ือนท่ีมาต าแหน่งท่ีเหนือช้ินงาน 
10. เคล่ือนท่ีมาต าแหน่งท่ีวางฝาบนช้ินงาน 
11. เคล่ือนท่ีหมุนฝาเพื่อประกอบเขา้กบัชิ้ นงาน 
12. เปิดกริปเปอร ์
13. เคล่ือนท่ีมาต าแหน่งท่ีเหนือช้ินงาน 
14. กลบัสู่โปรแกรมหลกั 

โปรแกรมหลกั 
1. โปรแกรมยอ่ย ‘รีเซ็ทสู่สภาวะเร่ิมตน้’ 
2. โปรแกรมยอ่ย ‘หยบิขิ้ นงานจากถาดวางไวท่ี้หลุม’ 
3. โปรแกรมยอ่ย ‘ประกอบฝาเขา้กบัชิ้ นงาน’ 
4. เคล่ือนท่ีกลบัสู่ต าแหน่งเร่ิมตน้ 
5. จบโปรแกรม 

ขัน้ตอนท่ี 4: พฒันาโปรแกรม 
ในขัน้ตอนการพฒันาโปรแกรม ใหน้ าขัน้ตอนทั้งหมดมาเขยีนเป็นภาษา Melfa Basic IV ดงัรปู 3.3.3b 

 
10 ‘********************************************************************************************* 
20 ‘***EXAMPLE 3.2: I/O COMMUNICATION AND STRUCTURED PROGRAMMING*** 
30 ‘********************************************************************************************* 
 
40 ‘*MAIN PROGRAM* 
50 GOSUB 110    ‘INITIALIZE 
60 GOSUB 160    ‘ASSEMBLE HOUSING 
70 GOSUB 370    ‘ASSEMBLE CAP 
80 MOV P901    ‘HOME POSITION 
90 END     ‘END PROGRAM 
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100 ‘*INITIALIZE* 
110 OVRD 70    ‘SPEED 
120 MOV P901    ‘HOME POSITION 
130 M_OUT(0)=0    ‘GRIPPER OPEN 
140 RETURN    ‘RETURN TO MAIN PROGRAM 
 
150 ‘*ASSEMBLE HOUSING* 
160 DLY 1 
170 WAIT M_IN(9)=1   ‘WAIT UNTIL HOUSING IN TRAY 
180 SPD 60 
190 MOV P902,-50   ‘OVER TRAY 
200 SPD 30 
210 MVS P902    ‘TO PICK 
220 DLY 1 
230 M_OUT(0)=1    ‘GRIPPER CLOSE 
240 DLY 1 
250 MVS P902,-50   ‘MOVE UP 
260 SPD 60 
270 MOV P903,-250   ‘OVER SOCKET 
280 SPD 45 
290 MVS P903    ‘TO PLACE 
300 DLY 1 
310 M_OUT(0)=0    ‘GRIPPER OPEN 
320 DLY 1 
330 MVS P903,-50   ‘MOVE UP 
340 RETURN    ‘RETURN 
 
350 ’*ASSEMBLE CAP* 
360 SPD 60 
370 MOV P912,-250   ‘OVER PICK 
380 M_OUT(2)=1    ‘PUSHER OUT 
390 WAIT M_IN(7)=1   ‘WAIT UNTIL CAP IS MOVED OUT 
400 M_OUT(2) =0   ‘PUSHER IN 
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410 M_OUT(1)=1    ‘CAP NEXT PART 
420 SPD 45 
430 MVS P912    ‘TO PICK 
440 DLY 1 
450 M_OUT(0)=1    ‘GRIPPER CLOSE 
460 DLY 1 
470 MVS P912,-50   ‘MOVE UP 
480 SPD 60 
490 MOV P913,-250   ‘OVER PLACE 
500 SPD 45 
510 MVS P913    ‘TO PLACE 
520 MVS P914    ‘ASSEMBLE  
530 M_OUT(0)=0    ‘GRIPPER OPEN 
540 MVS P914,-50   ‘MOVE UP 
550 RETURN    ‘RETURN 

 
รปู 3.3.3b: โปรแกรมประกอบชิ้ นงานเขา้กบัฝา 

 
ขัน้ตอนท่ี 5: ทดสอบโปรแกรม 

ตรวจสอบผลการท างานของโปรแกรมโดยจ าลองการท างาน  ถา้ผลการท างานไม่ตรงตามตอ้งการให้

ทบทวนแกไ้ขโปรแกรม 
เมื่อจบตวัอยา่งท่ี 3.2 ผูเ้รียนสามารถท าแบบฝึกหดัขอ้ 3.4 ในหน้าท่ี 30 ได ้
 
จากตวัอยา่งท่ี 3.2 เราใชอ้ินพุทและเอาทพ์ุทท่ีไฟลต์วัอยา่งก าหนดไวใ้ห ้แต่ในตวัอยา่งท่ี 3.3 ผูเ้รียนตอ้งสรา้งอินพุท
และเอาทพ์ุทและตอ้งก าหนดความสมัพนัธร์ะหว่างกนัดว้ยตนเอง 
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ตวัอย่ำงที่ 3.3: กำรสรำ้งโมเดลและ I/O communication 
 
 
 
 
 
 
 
 
 
 
 
 
 
ขัน้ตอนการสรา้งโมเดล: ดหูวัขอ้ 3.1.2 ในหนา้ท่ี 4 
ขัน้ตอนการเพิ่มวตัถุในโมเดล: ดหูวัขอ้ 3.1.3 วิธีท่ี 2 ในหนา้ท่ี 10 
ขัน้ตอนการก าหนดต าแหน่งในการเคล่ือนท่ี: ดหูวัขอ้ 3.2 ในหน้าท่ี 10 

 
 
 
 
 
 
 
 
 

ขั้นตอนกำรเขียนโปรแกรม 
ขัน้ตอนท่ี 1: เขา้ใจปัญหา 
ขัน้ตอนท่ี 2: วเิคราะหปั์ญหา 

เน่ืองจากปัญหาน้ียงัไม่มีความซบัซอ้นเท่าใดนักจึงสามารถใชเ้ทคนิค sequential programming 
ได ้ อยา่งไรก็ตามตวัอยา่งน้ีมีการสรา้งวตัถุเพิ่มในโมเดล และวตัถุเหล่าน้ีมีการติดต่อส่ือสารเพื่อ

แลกเปล่ียนขอ้มลูกบัคอนโทรลเลอรข์องหุ่นยนตผ่์านอินพุทและเอาทพ์ุท 
1. ตรวจสอบวา่วตัถุท่ีเลือกมามีอินพุทและเอาทพ์ุทใดบา้ง 
โมเดลน้ีประกอบไปดว้ย หุ่นยนต ์ Mitsubishi RV-2AJ, Socket และ BoxStackRed ซ่ึง

ประกอบดว้ย Push Cylinder   จาก Model Explorer สามารถตรวจสอบอินพุท เอาทพ์ุทเดิมท่ี
กระบอกสบูมีอยู ่ดงัรปู 3.3.4c 

 

จงเขยีนโปรแกรมควบคุมหุ่นยนตโ์ดยใชภ้าษา Melfa 
Basic IV โดยใช ้ หุ่นยนต ์Mitsubishi RV-2AJ และเพิ่ม
วตัถุสองชนิด คือ BoxStackedRed และ Socket ซ่ึงอยูท่ี่
ต าแหน่ง (350, -150, 0) และหมุนในทิศทาง Roll –90 
องศา และ (125, 290, 35) ตามล าดบั ดงัรปู  3.3.4a 
และมีเง่ือนไขการท างานดงัน้ี: เมื่อกดปุ่มสตารท์หุ่นยนต์
จะเคล่ือนท่ีไปหยบิช้ินงานจาก BoxStackRed โดยท่ี

ช้ินงานจะถูกดนัออกมาโดยกระบอกสบู เมื่อหยบิชิ้ นงาน

ไดแ้ลว้ตอ้งรอจนกวา่กระบอกสบูเคล่ือนท่ีกลบัแลว้จึงน า

ช้ินงานไปวางในหลุม (Socket) โดยก าหนดใหใ้ช้

ต าแหน่งดงัรปู 3.3.4b 
 
 

 

รปู 3.3.4a 

รปู 3.3.4b 
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จากรปู 3.3.4c จะพบวา่ RV-2AJ มีอินพุทท่ียงัไม่ใชง้านตั้งแต่บิต 0 ถึง 255 บิตท่ี 900 ถึง 907 
เกี่ยวกบักริปเปอร ์ เช่นเดียวกนักบัเอาทพ์ุทในรปู 3.3.4d หมายเหตุ: ในท่ีน้ีจะใชอ้ินพุทและ
เอาทพ์ุทบิตท่ี 901 คือ HCLOSED1 และ HCLOSE1 ตามล าดบั 
จากรปู 3.3.4e จะพบว่า PushCylinder มีอินพุทบิด 0 และ 1 คือ MoveOut และ MoveIn 
ตามล าดบั เอาทพ์ุทบิด 0 และ 1 คือ IsMovedOut และ IsMovedIn ตามล าดบั 
BoxStackRed มีอินพุทบิด 0 คือ NextPart และเอาทพ์ุทบิด 0 คือ PartAvail 
Gripper มีอินพุทบิด 0 คือ Close และเอาทพ์ุทบิด 0 คือ Closed 
Socket ไม่มีอินพุทและเอาทพ์ุท 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

รปู 3.3.4c 

รปู 3.3.4d 

รปู 3.3.4e 
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2.  สรา้งตารางแสดงอินพุทและเอาทพ์ุทของวตัถุทุกชนิดในโมเดลรวมถึงหุ่นยนต ์ และเพิ่ม

อินพุทและเอาทพ์ุทใหก้บัหุ่นยนตแ์ละวตัถุอื่นและเช่ือมโยงความสมัพนัธร์ะหวา่งอินพุทและ

เอาทพ์ุท 
จากขอ้ 1 สามารถสรุปเป็นตารางอินพุทและเอาทพ์ุทของวตัถุทุกชนิดในโมเดลดงัรปู 3.3.4f 
พิจารณาจาก PushCylinder ม ี อินพุท MoveOut และ MoveIn ซ่ึงเป็นสญัญาณท่ีไดร้บัจาก
หุ่นยนตใ์หก้ระบอกสบูเคล่ือนท่ีออกและเขา้ตามล าดบั  ดงัน้ัน หุ่นยนตต์อ้งส่งสญัญาณ

เอาทพ์ุทใหอ้ินพุทดงักล่าว ซ่ึงผูเ้รียนตอ้งก าหนดช่ือสญัญาณเอาทพ์ุทลงในตาราง ตวัอยา่งเช่น 

ก าหนดสญัญาณเอาทพ์ุทจากหุ่นยนตช่ื์อ C_Out และ C_In เป็นสญัญาณอินพุทของ 

PushCylinder ช่ือ MoveOut และ MoveIn ตามล าดบั แลว้ลากลกูศรเช่ือมโยงระหวา่งกนั ดงัรปู 
3.3.4g (หมายเหตุ: C_Out และ C_In ยอ่มาจาก CylinderOut และ CylinderIn ตามล าดบั ใน
การก าหนดช่ือน้ัน ก าหนดใหส้ั้นและส่ือความหมายเพื่อใหผู้อ้ื่นสามารถเขา้ใจได)้  ท าจนครบ
ทุกอินพุทและเอาทพ์ุทจะไดต้ารางดงัรปู 3.3.4h 

 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

3. เช่ือมโยงความสมัพนัธอ์ินพุทและเอาทพ์ุทของหุ่นยนตแ์ละวตัถุอืน่ 

   

รปู 3.3.4f รปู 3.3.4g รปู 3.3.4h 
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หลงัจากท่ีไดอ้อกแบบความสมัพนัธร์ะหวา่งอินพุทและเอาทพ์ุทแลว้ เราจะใชข้อ้มลูเหล่าน้ีไว ้

เช่ือมโยงความสมัพนัธร์ะหวา่งกนัในซอฟตแ์วร ์ โดยไปท่ี Model explorer แลว้เปล่ียนช่ืออินพุท
และเอาทพ์ุทของหุ่นยนต ์ 
จากรปู 3.3.4i และ 3.3.4j พบวา่หุ่นยนตม์ีอินพุทและเอาทพ์ุทท่ียงัไม่ไดถู้กใชง้านอยูซ่ึ่งจะ

ปรากฏดว้ยช่ือ ‘inactive’ เช่น inactive 000  ดงัน้ันเราสามารถน ามาใชไ้ดด้ว้ยการเปล่ียนช่ือ
โดยคล๊ิกขวาท่ีอินพุทหรือเอาทพ์ทุท่ีปรากฏช่ือ inactive แลว้ใชค้ าสัง่ Rename ดงัรปู   แลว้
เปล่ียนช่ือตามท่ีไดก้ าหนดไวท้ั้งในส่วนของอินพุทและเอาทพ์ุทดงัตวัอยา่งในรปู 3.3.4i หลงัจาก
น้ันเช่ือมโยงความสมัพนัธต์ามท่ีไดอ้อกแบบไวโ้ดยจดัใหอ้ินพุทของหุ่นยนตท์ั้งหมดอยูท่างขวา

มือ และวตัถุอื่นอยูซ่า้ยมือ ดงัรปู 3.3.4k แลว้เช่ือมโยงความสมัพนัธก์นัโดย drag and drop 
เช่น ลากอินพุทของหุ่นยนตช่ื์อ PushForward มาใส่เอาทพ์ุทของ PushCylinder ช่ือ 

IsMovedOut แลว้ตรวจสอบว่า วตัถุทั้งสองมีการเฃือ่มต่อกนัดงัรปู  อินพุท ‘PushForward’ ต่อ
กบัเอาทพ์ุท ‘IsMovedOut’ จาก PushCylinder  ท าจนครบทุกอินพุท ในส่วนของเอาทพ์ุทก็ท า
เช่นเดียวกบัอินพุทเช่น ลากเอาทพ์ุท ‘C_Out’ มาใส่อินพุท ‘MoveOut’ ของ PushCylinder แลว้
ตรวจสอบวา่ วตัถุทั้งสองมีการเฃือ่มต่อกนัดงัรปู 3.3.4l และ 3.3.4m 

 
 
 
 
   
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

  

รปู 3.3.4i รปู 3.3.4j 
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รปู 3.3.4k 

รปู 3.3.4m 

รปู 3.3.4l 
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ขัน้ตอนท่ี 3: ออกแบบ 
ล าดบัขัน้ตอนหลกั 

1. กดปุ่มสตารท์ 
2. หุ่นยนตเ์คล่ือนท่ีไปต าแหน่งท่ี 1 
3. เปิดกริปเปอร ์
4. เคล่ือนท่ีมาเหนือต าแหน่งท่ี 2 
5. กระบอกสบูเล่ือนช้ินงานออก 
6. กระบอกสบูเคล่ือนท่ีออกสุด 
7. หุ่นยนตเ์คล่ือนท่ีมาต าแหน่งท่ี 3 
8. หยบิชิ้ นงาน (ปิดกริปเปอร)์ 
9. กระบอกสบูเคล่ือนท่ีกลบั 
10. รอจนกระบอกสบูเคล่ือนท่ีเขา้สุด 
11. หุ่นยนตเ์คล่ือนท่ีมาเหนือต าแหน่งท่ี 2 
12. หุ่นยนตเ์คล่ือนท่ีมาเหนือต าแหน่งท่ี 3 
13. หุ่นยนตเ์คล่ือนท่ีมาต าแหน่งท่ี 3 
14. ปล่อยช้ินงาน 
15. หุ่นยนตเ์คล่ือนท่ีมาเหนือต าแหน่งท่ี 3 
16. หุ่นยนตเ์คล่ือนท่ีไปต าแหน่งท่ี 1 

ขัน้ตอนท่ี 4: พฒันาโปรแกรม 
ในขัน้ตอนการพฒันาโปรแกรม ใหน้ าขัน้ตอนทั้งหมดมาเขยีนเป็นภาษา Melfa Basic IV ดงัรปู 3.3.4n 
10 WAIT M_IN(3)=1  ‘WAIT FOR START SIGNAL 
20 MOV P1   ‘HOME POSITION 
30 M_OUT(901)=0  ‘GRIPPER OPEN 
40 MOV P2,-50   ‘OVER PICK 
50 M_OUT(0)=1   ‘CYLINDER OUT 
60 WAIT M_IN(0)=1  ‘WAIT UNTIL HOUSING AVAILABLE 
70 MVS P2   ‘TO PICK 
80 DLY 1 
90 M_OUT(901)=1  ‘GRIPPER CLOSE 
100 DLY 1    
110 M_OUT(0)=0   ‘CANCEL CYLINDER IN 
120 M_OUT(1)=1   ‘CYLINDER IN 
130 WAIT M_IN(1)=1  ‘WAIT UNTIL CYLINDER IN 
140 MVS P2,-50   ‘MOVE UP 
150 MOV P3,-50   ‘OVER PLACE 
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160 MVS P3   ‘TO PLACE 
170 DLY 1 
180 M_OUT(901)=0  ‘GRIPPER OPEN 
190 DLY 1 
200 MVS P3,-50   ‘MOVE UP 
210 MOV P1   ‘HOME POSITION 
220 END    ‘END PROGRAM 

 
รปู 3.3.4n: โปรแกรมแสดงการท างานตวัอยา่งท่ี 3.3 

 
ขัน้ตอนท่ี 5: ทดสอบโปรแกรม 
ตรวจสอบผลการท างานของโปรแกรมโดยจ าลองการท างาน  ถา้ผลการท างานไม่ตรงตามตอ้งการให้

ทบทวนแกไ้ขโปรแกรม 
 
หมายเหตุ: ในกรณีท่ีอินพุทหรือเอาทพ์ุทของวตัถุใดไม่พอใหใ้ชง้านตอ้งท าการเพิ่มอนิพุทหรือเอาทพ์ุท
สามารถท าไดโ้ดยคล๊ิกขวาท่ีวตัถุน้ัน New > Input หรือ output > Digital (System)  ดงัรปู 3.3.4o   
ขอ้แตกต่างระหว่าง Digital I/Os และ Digital (System) I/Os คือ  Digital (System) I/Os จะถูก 
ประมวลผลและจดัการโดยอปุกรณภ์ายในของระบบน้ัน  ซ่ึงผูเ้รียนสามารถดสูถานะของอินพุทและ

เอาทพ์ุทเหล่าน้ีไดแ้ต่ไม่สามารถบงัคบัคา่อินพุทหรือเอาทพ์ุทได ้เช่นในกรณีของ Push cylinder ระบบ
ภายในจะควบคุม Push cylinder เคล่ือนท่ีเขา้ออก 

ส าหรบั Digital I/Os จะถูกควบคุมโดยผูใ้ชห้รือโปรแกรม อินพทุและเอาทพ์ุทประเภทน้ีจะถูกเขยีนและ
อ่านโดยโปรแกรม เช่น ในกรณีของ Push button ผูเ้รียนกดปุ่มโดยเปล่ียนค่าจาก 0 เป็น 1 ซ่ึงผูเ้รียน
ควบคุมค่าอนิพุทเอาทพ์ุทได ้

 
 
 
 
 
 
 
 
 
 
 

 

รปู 3.3.4o 
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แบบฝึกหดัที่ 3.1 
จงเขยีนโปรแกรมควบคุมหุ่นยนตโ์ดยใชภ้าษา Melfa Basic IV ใหหุ้น่ยนตเ์คล่ือนท่ีไปหยบิชิ้ นงานขึ้ นมาจาก Storage   
หมายเหตุ: ใชโ้มเดล PickAndPlaceKuka และใชต้ าแหน่งท่ีก าหนดในตวัอยา่งท่ี 2.1  

แบบฝึกหดัที่ 3.2 
จงเขยีนโปรแกรมควบคุมหุ่นยนตโ์ดยใชภ้าษา Melfa Basic IV ใหหุ้่นยนตเ์คล่ือนท่ีไปหยบิชิ้ นงานขึ้ นมาจาก Storage ไปวางท่ี 
Stacking   
หมายเหตุ: ใชโ้มเดล PickAndPlaceKuka และใชต้ าแหน่งท่ีก าหนดในแบบฝึกหดัท่ี 2.1  

แบบฝึกหดัที่ 3.3: ใชค้  ำสัง่วน loop กำรท ำงำน 
จงเขยีนโปรแกรมควบคุมหุ่นยนตโ์ดยใชภ้าษา Melfa Basic IV ใหหุ้่นยนตเ์คล่ือนท่ีจากต าแหน่งท่ี 1 ถึงต าแหน่งท่ี 5 แลว้วนรอบ
การท างานเคล่ือนท่ีจากต าแหน่งท่ี 1 ถึง 5 ซ ้าไปเร่ือยๆ  
หมายเหตุ: สรา้งโมเดล RV-2AJ และก าหนดต าแหน่งใดๆ 5 ต าแหน่ง 

แบบฝึกหดัที่ 3.4: I/O communication and structured programming 
จงเขยีนโปรแกรมควบคุมหุ่นยนตต่์อจากตวัอยา่งท่ี 3.2 โดยใชภ้าษา Melfa Basic IV ใหหุ้่นยนตป์ระกอบชิ้ นงานเขา้กบัลกูสบู 
สปริงและฝา  
หมายเหตุ: โดยมีเง่ือนไขเพิ่มเติมดงัต่อไปน้ีน้ี: ช้ินงานสีด าจะประกอบเขา้กบัลกูสบูขนาดเล็ก (สีเทา)  ช้ินงานท่ีเหลือ คือ สีเงินและ
สีแดงประกอบเขา้กบัลกูสบูขนาดใหญ่ (สีด า) 
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หลงัจากที่ผู้ เรียนมีความคุ้นเคยกบัซอฟต์แวร์ COSIMIR Educational และสามารถเขียนโปรแกรมได้แล้ว ผู้ เรียนมีความพร้อมทีจ่ะ
ท างานกบัหุน่ยนต์จริงและใช้ซอฟต์แวร์ COSIMIR Industrial ซึง่มีฟังก์ชัน่เพิม่จาก COSIMIR Educational คือสามารถติดตอ่สือ่สาร
กบัคอนโทรลเลอร์ของหุน่ยนต์ได้  

4.0 ระบบโดยรวม: หุ่นยนต์ + คอนโทรลเลอร์ + Teaching Box (TB) + คอมพวิเตอร์  
 ประกอบไปด้วยสว่นประกอบหลกัๆ คือ หุน่ยนต์ คอนโทรลเลอร์ TBและคอมพวิเตอร์ซึง่มีซอฟต์แวร์ COSIMIR Industrial 
ติดตัง้อยู ่  
หุน่ยนต์และคอนโทรลเลอร์เช่ือมตอ่กนัผา่น machine cable โดยที่คอนโทรลเลอร์ซึง่เปรียบเสมอืนตวัสัง่การของหุน่ยนต์เช่ือมตอ่กบั 
TB และ คอมพิวเตอร์ 
 

 
 

 4.0.1 หุ่นยนต์ 
หุน่ยนต์ที่ใช้อ้างอิงในคูม่ือนีเ้ป็นหุน่ยนต์มิตซูบิชิ รุ่น RV-2AJ ซึง่เป็นหุน่ยนต์อตุสาหกรรมถกูออกแบบมาให้ใช้ได้

กบังานทกุประเภท (all-purpose industrial robot) RV-2AJ ถกูพฒันาขึน้มาจากรุ่น RV-M1 มีความรวดเร็วและ
แมน่ย าในการท างานเพิม่มากขึน้ มีแกนทัง้หมด 5 แกน คือ แกนที่ 1, 2, 3, 5 และ 6แตล่ะแกนเคลือ่นท่ีด้วยเซอร์โว
มอเตอร์ (AC servo motor)  
หมายเหต:ุ รายละเอียดของสเปกหรือคณุสมบตัิอื่นๆ ของหุน่ยนต์ขอให้ผู้ เรียนศกึษาเพิ่มเติมจากคูม่ือที่มาพร้อมกบั
หุน่ยนต์ 

หุน่ยนต์รุ่น RV-2AJ ถกูน าไปใช้ในอตุสาหกรรมตอ่ไปนี ้อตุสาหกรรมอิเลก็ทรอนิกส์ท่ีต้องการเคร่ืองจกัรที่มีความ
แมน่ย าสงู อตุสาหกรรมอาหาร เคร่ืองส าอางและยา และการศกึษาและการวจิยั  

รูปท่ี 4.0.0a: รูปแสดง
ระบบการเรียนการสอน
เร่ืองหุน่ยนต์
อตุสาหกรรม 
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ตวัอยา่งการประยกุต์ใช้ในอตุสาหกรรมอิเลก็ทรอนิกส์ เช่น ในงานขนย้ายซดีีรอมดงัรูป 4.0.1a งานประกอบ

ชิน้สว่นอิเลก็ทรอนิกส์ ดงัรูป 4.0.1b งานประกอบชิน้สว่นทัว่ไป ดงัรูป 4.0.1c งานตรวจสอบคณุภาพคีย์บอร์ดและ
ชิน้สว่นอิเลก็ทรอนิกส์ดงัรูป 4.0.1d และ 4.0.1e 

 

 

 
 
 
 

 
 
 

รูปท่ี 4.0.1a: งานขนย้ายซีดีรอม 

รูปท่ี 4.0.1b: งานประกอบชิน้สว่นอิเลก็ทรอนิกส์ 

รูปท่ี 4.0.1c: งานประกอบชิน้สว่นทัว่ไปโดยหุน่ยนต์ท า
หน้าที่หยอดกาว 
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ตวัอยา่งการประยกุต์ใช้ในอตุสาหกรรมอาหาร เคร่ืองส าอางและยา เช่น ในงานตรวจสอบและวิเคราะห์คณุภาพ

ยา ดงัรูป 4.0.1f และงานบรรจอุาหาร ดงัรูป 4.0.1g  
 
 
 
 
 
 
 
 
 
 
 
 

รูปท่ี 4.0.1d: งานตรวจสอบคย์ีบอร์ด 

รูปท่ี 4.0.1e: งานตรวจสอบชิน้สว่นอิเลก็ทรอนิกส ์

 

รูปท่ี 4.0.1f: งานตรวจสอบและวเิคราะห์คณุภาพยา 
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4.0.2 คอนโทรลเลอร์ 
 คอนโทรลเลอร์ของหุน่ยนต์ RV-2AJ เป็นรุ่น CR2-571 ภาษาที่รองรับ คือ MELFA BASIC IV และ MOVEMASTER 
COMMAND สามารถบนัทกึโปรแกรมได้ 88 โปรแกรม และสามารถบนัทกึต าแหนง่ได้ 2, 500 ต าแหนง่ 

 
 
 
 
 
 
 
 
 
 
 
 
 

2) Start button…ท าหน้าที่รันโปรแกรมและสัง่ให้หุน่ยนต์ท างาน โปรแกรมจะรันอยา่งตอ่เนื่องโดยจะมีไฟ LED สเีขียวติดอยู่
ตลอดที่ปุ่ มนีท้ างาน 

3) Stop button…ท าหน้าที่หยดุการท างานของหุน่ยนต์ทนัที แต ่ เซอร์โวมอเตอร์ ยงัท างานอยู ่ไฟ LED สแีดงติดอยูต่ลอดที่
ปุ่ มนีท้ างาน 

4) Reset button…ท าหน้าที่รีเซท็ error และรีเซ็ทสภาวะโปรแกรมที่ถกูขดัจงัหวะและรีเซ็ทโปรแกรมให้เร่ิมที่บรรทดัแรกใหม่
อีกครัง้   ไฟ LED สแีดงจะติดอยูต่ลอดเมื่อมี error เกิดขึน้ 

5) Emergency stop button…ท าหน้าที่หยดุการท างานของหุน่ยนต์โดยที่ เซอร์โวมอเตอร์ หยดุการท างานด้วย 
6) T/B Connection switch…ท าหน้าที่เช่ือมตอ่หรือยกเลกิการเช่ือมตอ่กบั TB โดยไมต้่องท าปิดคอนโทรลเลอร์ 

 

รูปท่ี 4.0.1g: งานบรรจอุาหาร 

 

รูปท่ี 4.0.2a: แผงด้านหน้า 
ของคอนโทรลเลอร์ 



Introduction to COSIMIR  

บทที่ 4: ซอฟตแ์วร ์COSIMIR Industrial 
4-5 

 
7) CHANG DISP… เมื่อกดปุ่ มนี ้ หน้าจอจะเปลีย่นรายละเอียดที่แสดง โดยเรียงตามล าดบัมดีงันี ้ คือ หมายเลขโปรแกรม 

หมายเลขบรรทดัของโปรแกรม ความเร็ว override นอกจากนีย้งัท าหน้าที่แสดง หมายเลข error 
ที่เกิดขึน้ 

8) End button…ท าหน้าทีจ่บการอา่นโปรแกรมที่บรรทดัสดุท้ายหรือเมื่อเจอค าสัง่ END  ไฟ LED สแีดงจะติดตลอดขณะ
ระหวา่งการท างานหนึง่รอบ 

9) SVO.ON switch… เมื่อกดปุ่ มนี ้ เซอร์โวมอเตอร์ จะเร่ิมต้นท างานโดยมีไฟ LED สเีขียวตดิตลอดเวลาที่ เซอร์โวมอเตอร์ 
ท างาน 

10) SVO.OFF switch… เมื่อกดปุ่ มนี ้ เซอร์โวมอเตอร์ จะหยดุท างานโดยมีไฟ LED สแีดงตดิตลอดเวลาที่ เซอร์โวมอเตอร์ 
หยดุการท างาน 

11) STATUS.NUMBER (display panel)…หน้าจอท าหน้าที่แสดงหมายเลข error หมายเลขโปรแกรม หมายเลขบรรทดั คา่
เปอร์เซ็นต์ความเร็ว override  

14) MODE changeover switch…ท าหน้าที่เปลีย่นโหมดการท างานของหุน่ยนต์ โดยมี 3 โหมดดงัตอ่ไปนี ้
  AUTO (Op.)… เป็นโหมดส าหรับการท างานของคอนโทรลเลอร์เทา่นัน้ 
 TEACH…เป็นโหมดที่ใช้ร่วมกบัการท างานของ TB เทา่นัน้ 
 AUTO (Ext.)… เป็นโหมดส าหรับการสัง่งานคอนโทรลเลอร์จากอปุกรณ์ภายนอก (คอมพวิเตอร์) เทา่นัน้ 
15) UP/ DOWN switch… ท าหน้าที่เปลีย่นรายละเอียดที่แสดงบนหน้าจอขึน้ลง 
 

4.0.3 Teaching Box (TB) 
 

 
  

 

 
รูปท่ี 4.0.3a: ภาพด้านหน้าของ TB รูปท่ี 4.0.3b: ภาพด้านข้างและด้านหลงัของ TB 
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1) [EMG. STOP] switch…เมื่อกดปุ่ มนี ้ เซอร์โวมอเตอร์ จะหยดุการท างานและหุน่ยนต์จะหยดุการท างานทนัทีไมว่า่ TB 

จะท างานอยูห่รือไม ่ ถ้าต้องการยกเลกิการท างานของปุ่ มนีใ้ห้หมนุปุ่ มไปในทิศทางตามเขม็นาฬิกา 
2) [ENABLE/ DISABLE] switch…สวิตช์นีท้ าหน้าที่ปิดหรือเปิด TB เมื่อต้องการใช้การ TB ให้หมนุสวิตช์ไปท่ี ‘ENABLE’ 

ซึง่จะหยดุการท างานจากคอนโทรลเลอร์และอปุกรณ์ภายนอกทนัที  เมื่อไมต้่องการใช้ TB แล้วให้หมนุสวติช์ไปท่ี 
‘DISABLE’ 

3) Display LCD…โปรแกรมและสถานะของหุน่ยนต์จะปรากฏบนหน้าจอเมื่อสวิตช์ของ TB อยูท่ี่ ‘ENABLE’ 
4) [TOOL] key…เคลือ่นท่ีแบบ tool jog 
4)    [JOINT] key…เคลือ่นท่ีแบบ joint jog 
4)    [XYZ] key…เคลือ่นท่ีแบบในแนวแกน XYZ  
5) [MENU] key…กดปุ่ ม ‘MENU’ เพื่อต้องการกลบัสูเ่มนหูลกั 
6) [STOP] key…ท าหน้าที่หยดุการอา่นโปรแกรมและคอ่ยๆ ลดความเร็วของหุน่ยนต์จนกระทัง่หยดุ  ซึง่เป็นค าสัง่เดียวกบั 

STOP button หน้าแผงคอนโทรลเลอร์และสามารถใช้ได้ในทกุกรณีแม้วา่ สวิตช์จะอยูท่ีต่ าแหนง่ ‘DISABLE’ 
7) [STEP/MOVE] key…การเคลือ่นท่ีของหุน่ยนต์สามารถกระท าได้ก็ตอ่เมื่อกดปุ่ มนีค้้างไว้พร้อมกบัปุ่ ม [Jog operation] 

key ซึง่การกดปุ่ มนีท้ าให้ เซอร์โวมอเตอร์ ท างาน  นอกจากนี ้step jump ยงัสามารถกระท าได้โดยกดปุ่ มนีค้้างไว้พร้อม
กบัปุ่ ม [INP/EXE] 

8) [+/FORWD] key…step feed สามารถกระท าได้เมื่อกดปุ่ มนีค้้างไว้พร้อมกบัปุ่ ม [INP/EXE]   เมื่อกดปุ่ มนีพ้ร้อมกบั 
[STEP/MOVE] ความเร็ว override จะเพิ่มขึน้ 

9) [-/BACKWD] key…เมื่อกดปุ่ มนีพ้ร้อมกบัปุ่ ม [STEP/MOVE] ความเร็ว override จะลดลง 
10) [COND]…ท าหน้าทีแ่ก้ไขโปรแกรม 
11) [ERROR RESET] key…ท าหน้าที่รีเซ็ท error ที่เกิดขึน้  เมื่อกดปุ่ มนีพ้ร้อมกบั [INP/EXE] โปรแกรมจะถกูรีเซ็ท 
12) [Jog operation] key (ปุ่ มจ านวน 12 ปุ่ มเร่ิมจาก [-X (J1) ถึง +C(J6)]…ปุ่ มจ านวน 12 ปุ่ มเหลา่นีเ้รียกวา่ปุ่ ม ‘jog 

operation’  เมื่อเลอืกการเคลือ่นท่ีแบบ joint jog  แกนแตล่ะแกนจะหมนุ และเมื่อเลอืกการเคลือ่นท่ีในแนวแกน XYZ 
หุน่ยนต์จะเคลือ่นท่ีตามแกนแตล่ะแกน  นอกจากนีปุ้่ มเหลา่นีย้งัถกูใช้ในการใสค่า่ตวัเลขเช่นในการเลอืกเมนหูรือใส่
หมายเลขต าแหนง่ 

13) [ADD ] key…ท าหน้าทีเ่พิ่มต าแหนง่และนอกจากนีย้งัท าหน้าทีเ่คลือ่นท่ีเคอร์เซอร์ขึน้ () 

14) [RPL/ ] key…This corrects the position data.  นอกจากนีย้งัท าหน้าที่เคลือ่นท่ีเคอร์เซอร์ลง () 

15) [DEL/  ] key…ท าหน้าที่ลบต าแหนง่ นอกจากนีย้งัท าหน้าที่เคลือ่นท่ีเคอร์เซอร์ไปทางซ้าย () 

16) [HAND/  ] key… 
เมื่อกดปุ่ มนีพ้ร้อมกบัปุ่ ม [+C (J6)] หรือ [- C (J6)] กริปเปอร์หมายเลข 1 จะปิดหรือเปิด 
เมื่อกดปุ่ มนีพ้ร้อมกบัปุ่ ม [+B (J5)] หรือ [- B (J5)] กริปเปอร์หมายเลข 2 จะปิดหรือเปิด 
เมื่อกดปุ่ มนีพ้ร้อมกบัปุ่ ม [+A (J4)] หรือ [- A (J4)] กริปเปอร์หมายเลข 3 จะปิดหรือเปิด 
เมื่อกดปุ่ มนีพ้ร้อมกบัปุ่ ม [+Z (J3)] หรือ [- Z (J3)] กริปเปอร์หมายเลข 4 จะปิดหรือเปิด 
นอกจากนีปุ้่ มนีย้งัท าหน้าที่เคลือ่นท่ีเคอร์เซอร์ไปทางขวา 
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17) [INP/ EXE] key…ท าหน้าที่ป้อนโปรแกรมและท าหน้าที่บนัทกึต าแหนง่ 
18) [POS CHAR] key…ท าหน้าทีเ่ปลีย่นลกัษณะการป้อนข้อมลูคอื เปลีย่นไปมาระหวา่งตวัเลขและตวัอกัษรในระหวา่ง

การแก้ไขต าแหนง่ เป็นต้น 
19) Deadman switch… เมื่อบิดสวติช์มาที่ต าแหนง่ ‘ENABLE’ และกดปุ่ มนีค้้างไว้ เซอร์โวมอเตอร์ จะท างาน ถ้าปลอ่ยปุ่ ม

นี ้ เซอร์โวมอเตอร์ หยดุท างาน อยา่งไรก็ตาม ในกรณีที่มกีารกดปุ่ ม [EMG. STOP] หรือ SVO.OFF switch บนแผง
คอนโทรลเลอร์ท างาน  เซอร์โวมอเตอร์ จะหยดุการท างาน และจะไมก่ลบัสูส่ภาวะการท างานแม้วา่จะกดปุ่ ม Deadman 
switch ไว้ก็ตาม ในกรณีนีส้ามารถแก้ไขได้โดยกดปุ่ ม SVO.ON switch 

20) Contrast setting switch…ท าหน้าที่ปรับความสวา่งของหน้าจอ กดปุ่ มด้านบนเพื่อปรับหน้าจอให้เข้มขึน้ กดปุ่ ม
ด้านลา่งเพื่อปรับหน้าจอให้สวา่งขึน้ 

 

4.1 วิธีการใช้ Teaching Box (TB) 
 4.1.1 การก าหนดต าแหน่งด้วย TB 

การก าหนดต าแหนง่ท าได้สองวธีิคือ การก าหนดต าแหนง่ด้วย TB ซึง่จะกลา่วในหวัข้อนีแ้ละการก าหนดต าแหนง่
บนซอฟต์แวร์ซึง่จะกลา่วในหวัข้อ 4.3.2 แม้วา่เราสามารถก าหนดต าแหนง่บนซอฟต์แวร์ได้แต่ผู้ เขียนขอแนะน าให้ใช้ TB 
เพราะการใช้ TB ท าให้ผู้ เรียนต้องอยูห่น้างานจริงและก าหนดต าแหนง่ได้ถกูต้องมากกวา่ การก าหนดต าแหนง่บนซอฟต์แวร์
นัน้สิง่แวดล้อมไมเ่หมือนกบัของจริงและผู้ เรียนอาจไมไ่ด้อยูใ่กล้กบัหน้างานจึงมีสว่นให้การก าหนดต าแหนง่ผิดพลาดได้ 
ส าหรับขัน้ตอนในการก าหนดต าแหน่งด้วย TB มีดงัตอ่ไปนี ้

  1) บิดกญุแจที่คอนโทรลเลอร์มาที่ต าแหนง่ ‘TEACH’ ดงัรูปท่ี 4.1.1a 
 
 
 
 
  2) บิดกญุแจที่ TB มาที่ต าแหนง่ ‘ENABLE’ ดงัรูปท่ี 4.1.1b 
 
 
 
 
 

3) กดปุ่ ม [MENU] ที่ TB หน้าจอที่ TB จะปรากฏดงัรูปท่ี 4.1.1c ใช้ปุ่ ม [ADD ],  [RPL/ ], [DEL/  ] และ 

[HAND/  ] เพื่อเลือ่นเคอร์เซอร์ไปยงัฟังก์ชัน่ท่ีต้องการ 
 
 
 

 

 

รูปท่ี 4.1.1a: บิดสวิตช์หน้าแผงคอนโทรลเลอร์มาที่
ต าแหนง่ ‘TEACH’ 

รูปท่ี 4.1.1b: บิดสวิตช์ที่ TB มาที่ต าแหนง่ ‘ENABLE’ 

 

รูปท่ี 4.1.1c: หน้าจอของ TB  
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4) เลอืกหมายเลข 1 ‘TEACH’ แล้วกดปุ่ ม [INP/ EXE] เพื่อตอบตกลง หน้าจอที่ TB จะปรากฏดงัรูปท่ี   4.1.2d 
 
 
 
 

5) ใสห่มายเลขโปรแกรมที่ต้องการ (เลอืกได้ตัง้แต ่ 1 ถึง 999) ดงัตวัอยา่งในรูป 4.1.2eหลงัจากนัน้กดปุ่ ม [INP/ 
EXE] เพื่อตอบตกลง หน้าจอจะเปลีย่นไปดงัรูปท่ี 4.1.2f ซึง่ในขณะนีโ้ปรแกรมที่หนึง่ยงัไมม่ีข้อมลูหรือต าแหนง่
ถกูบนัทกึอยู ่

 
 
 
 
 
    

หมายเหต:ุ ในการใช้งานจริงต้องไมใ่ช้โปรแกรมหมายเลข 1 เป็นอนัขาดเนื่องจากเป็นโปรแกรมที่สมบรูณ์ส าหรับ
การท างานของชดุ MPS การเรียกใช้โปรแกรมหมายเลข 1 หมายถึงการบนัทกึทบัโปรแกรมเดิม 

6) กดปุ่ ม [POS CHAR] ดงัรูป 4.1.2g 

MS.POS (P1             )

   X : ----------------------

   Y : ----------------------

   Z : ----------------------

 
7) เร่ิมต้นการก าหนดต าแหนง่ โดยใช้มือซ้ายกดปุ่ ม Deadman switch พร้อมกบัปุ่ ม [STEP/MOVE] ค้างไว้จนได้
ยินเสยีง เซอร์โวมอเตอร์ ท างานและไฟ LED สเีขียวติดที่ปุ่ ม SVO.ON switch ซึง่หมายความวา่ เซอร์โวมอเตอร์ 
อยูใ่นสภาพพร้อมท างานแล้ว 
และใช้มือขวากดปุ่ ม [TOOL] หรือ [JOINT] หรือ [XYZ] เพื่อเลอืกรูปแบบการเคลือ่นท่ี  

8) โดยที่มือซ้ายยงักด Deadman switch พร้อมกบัปุ่ ม [STEP/MOVE] อยู ่ ใช้มือขวากดปุ่ ม [Jog    operation] 
key จ านวน 12 ปุ่ มเร่ิมจาก [-X (J1) ถึง +C(J6)] 
ในกรณีที่เลอืกใช้การเคลือ่นท่ีแบบ XYZ mode ให้ใช้ปุ่ มตอ่ไปนี…้ 

[-X (J1)] และ [+X (J1)] ท าหน้าที่เคลือ่นท่ีไปในแกน X- และ X+ ตามล าดบั 
[-Y (J2)] และ [+Y (J2)] ท าหน้าที่เคลือ่นท่ีไปในแกน Y- และ Y+ ตามล าดบั 
[-Z (J3)] และ [+Z (J3)] ท าหน้าที่เคลือ่นท่ีไปในแกน Z- และ Z+ ตามล าดบั 

ในกรณีที่เลอืกใช้การเคลือ่นท่ีแบบ Joint mode ให้ใช้ปุ่ มตอ่ไปนี…้ 
[-X (J1)] และ [+X (J1)] ท าหน้าที่เคลือ่นท่ีตามแกนท่ี 1 ไปในทิศทาง – และ+ตามล าดบั 

 

รูปท่ี 4.1.1d: หน้าจอของ TB  

 

รูปท่ี 4.1.1e: ระบหุมายเลขโปรแกรม  

 

รูปท่ี 4.1.1f: ระบหุมายเลขโปรแกรม  

รูปท่ี 4.1.1g: ระบหุมายเลข
โปรแกรม  
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    [-Y (J2)] และ [+Y (J2)] ท าหน้าที่เคลือ่นท่ีไปในแกนที่ 2 ไปในทิศทาง – และ+ตามล าดบั 
    [-Z (J3)] และ [+Z (J3)] ท าหน้าที่เคลือ่นท่ีไปในแกนที่ 3 ไปในทิศทาง – และ+ตามล าดบั 
    [-A (J4)] และ [+A (J4)] ท าหน้าที่เคลือ่นท่ีไปในแกนที่ 4 ไปในทิศทาง – และ+ตามล าดบั 
    [-B (J5)] และ [+B (J5)] ท าหน้าที่เคลือ่นท่ีไปในแกนที่ 5 ไปในทิศทาง – และ+ตามล าดบั 
    [-C (J6)] และ [+C (J6)] ท าหน้าที่เคลือ่นท่ีไปในแกนที่ 6 ไปในทิศทาง – และ+ตามล าดบั 

หมายเหต:ุ ในกรณีที่ยงัไมไ่ด้ยินเสยีง เซอร์โวมอเตอร์ ท างานแล้วกดปุ่ มใดปุ่ มหนึง่ของ [Jog Operation] key 
จะเกิด error ขึน้ 

ในกรณีที่ต้องการเปิดหรือปิดกริปเปอร์ให้กดปุ่ ม [HAND/  ] ค้างไว้แล้วกด [-C (J6)] เพื่อปิดกริปเปอร์ หรือ 
[+C (J6)] เพื่อเปิดกริปเปอร์ โดยไมท่ี่ต้องกดปุ่ ม Deadman switch และ [STEP/MOVE] 

9) เมื่อได้ต าแหนง่ที่ต้องการ ให้บนัทกึต าแหนง่โดยปลอ่ยปุ่ ม Deadman switch และ [STEP/MOVE]  

10) ใสห่มายเลขต าแหนง่ เช่น P1, P2, … โดยใช้ปุ่ ม [POS CHAR] เพื่อป้อนหมายเลขและ ปุ่ ม [ADD ],   [RPL/ 

], [DEL/  ] และ [HAND/  ] เพื่อเลือ่นเคอร์เซอร์ไปยงัต าแหนง่ที่ต้องการ 
11) เมื่อใสห่มายเลขต าแหนง่เรียบร้อยแล้วให้กดปุ่ ม Deadman switch และ [STEP/MOVE] ค้างไว้ แล้วกดปุ่ ม 

[ADD ] 2 ครัง้เพื่อบนัทกึต าแหนง่   
12) ท าซ า้ขัน้ตอนท่ี 7) ถึง 11) ใหมท่กุครัง้ทีต้่องการเพิม่ต าแหนง่ 

4.1.2 วิธีการแสดงต าแหน่ง 
ในกรณีที่ก าหนดต าแหนง่ตา่งๆ ครบเรียบร้อยแล้ว ต้องการตรวจสอบวา่ต าแหนง่ตา่งๆ อยู ่ณ ที่ต าแหนง่ใดบ้าง มี

วิธีการตรวจสอบดงัตอ่ไปนี ้
  1) บิดกญุแจที่คอนโทรลเลอร์มาที่ต าแหนง่ ‘TEACH’ ดงัรูปท่ี 4.1.1a 
  2) บิดกญุแจที่ TB มาที่ต าแหนง่ ‘ENABLE’ ดงัรูปท่ี 4.1.1b 

3) กดปุ่ ม [MENU] ที่ TB หน้าจอที่ TB จะปรากฏดงัรูปท่ี 4.1.1c ใช้ปุ่ ม [ADD ],   [RPL/ ], [DEL/  ] และ 

[HAND/  ] เพื่อเลือ่นเคอร์เซอร์ไปยงัฟังก์ชัน่ท่ีต้องการ 
4) เลอืกหมายเลข 1 ‘TEACH’ แล้วกดปุ่ ม [INP/ EXE] เพื่อตอบตกลง หน้าจอที่ TB จะปรากฏดงัรูปท่ี   4.1.2d 
5) ใสห่มายเลขโปรแกรมที่ต้องการตรวจสอบต าแหนง่  
6) กดปุ่ ม [POS CHAR] จะปรากฏหน้าจอดงัรูป 4.1.2g 
7) ใสห่มายเลขต าแหนง่ที่ต้องการตรวจสอบ เช่น P1, P2, … 
8) ใช้มือซ้ายกดปุ่ ม Deadman switch พร้อมกบัปุ่ ม [STEP/MOVE] ค้างไว้จนได้ยินเสยีง เซอร์โวมอเตอร์ ท างาน
และไฟ LED สเีขียวติดที่ปุ่ ม SVO.ON switch ซึง่หมายความวา่ เซอร์โวมอเตอร์ อยูใ่นสภาพพร้อมท างานแล้ว แล้ว
ใช้มือขวากดปุ่ ม [INP/ EXE] ค้างไว้จนกวา่หุน่ยนต์จะเคลือ่นท่ีกลบัสูต่ าแหนง่ที่ก าหนดไว้ 

   หมายเหต:ุ  
• ในกรณีที่กดปุ่ ม [INP/ EXE] ก่อนได้ยินเสยีง เซอร์โวมอเตอร์ ท างาน จะท าให้เกิด error 
• ในบางกรณี หุน่ยนต์ไมส่ามารถกลบัสูต่ าแหนง่ที่ก าหนดให้ได้เนื่องจากข้อจ ากดัขององศาการ

หมนุของแตล่ะข้อซึง่เป็นผลมาจากการออกแบบโครงสร้างหุน่ยนต์จากบริษัทผู้ผลติ 
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4.1.3 วิธีการลบต าแหน่ง 
1) ให้หน้าจอปรากฏต าแหนง่ที่ต้องการลบ โดยใสต่ าแหนง่ที่ต้องการลบ แล้วกดปุ่ ม [INP/ EXE] เช่น ดงัในรูป 
4.1.3a   

 

MS.POS (P1             )

   X : +232.03

   Y :   +64.24

   Z : +436.24

 
 

2) กดปุ่ ม [STEP/MOVE] ค้างไว้แล้วกดปุ่ ม [DEL/  ] หนึง่ครัง้แล้วปลอ่ย จะได้ยินเสยีงบี๊บ 3 ครัง้ เพื่อเป็นการ
เตือน และจะปรากฏข้อความเตือนดงัรูป 4.1.3b 
 

MS.POS (P1             )

DELETE?
 

 

3) ยงัคงกดปุ่ ม [STEP/MOVE] ค้างไว้แล้วกดปุ่ ม [DEL/  ] หนึง่ครัง้เพื่อยืนยนัการลบ หลงัจากนัน้จะได้ยินเสยีง
บี๊บและที่ด้านลา่งหน้าจอจะปรากฏข้อความ ‘EXECUTING’ เพื่อแจ้งวา่ได้ท าการลบต าแหนง่เรียบร้อยแล้ว   

 4.1.4 วิธีการบันทกึต าแหน่งทับต าแหน่งเดมิ (replace) 
1) ให้หน้าจอปรากฏต าแหนง่ทีต้่องการแทนทีด้่วยต าแหนง่อื่น โดยใสต่ าแหนง่ที่ต้องการแทนที ่ แล้วกดปุ่ ม [INP/ 
EXE] เช่น ดงัในรูป 4.1.3a   

2) กดปุ่ ม [STEP/MOVE] ค้างไว้แล้วกดปุ่ ม [RPL/ ] หนึง่ครัง้แล้วปลอ่ย จะได้ยินเสยีงบี๊บ 3 ครัง้ เพื่อเป็นการ
เตือน และจะปรากฏข้อความเตือนดงัรูป 4.1.4a 

 

MS.POS (P1             )

REPLACE?
 

 

3) ยงัคงกดปุ่ ม [STEP/MOVE] ค้างไว้แล้วกดปุ่ ม [RPL/ ] หนึง่ครัง้เพื่อยืนยนัการแทนท่ี หลงัจากนัน้จะ
ได้ยินเสยีงบี๊บและทีด้่านลา่งหน้าจอจะปรากฏข้อความ ‘EXECUTING’ เพื่อแจ้งวา่ได้ท าการแทนที่
ต าแหนง่เรียบร้อยแล้วโดยได้น าต าแหนง่ที่อยูถ่ดัไปมาเป็นต าแหนง่ที่ถกูแทนท่ี  แล้ว โดยทีต่ าแหนง่ที่อยู่
ถดัไปยงัคงอยู ่

รูปท่ี 4.1.3a: หน้าจอ TB แสดงต าแหนง่ที่
ต้องการลบ  

รูปท่ี 4.1.3b: หน้าจอ TB แสดง
ข้อความเตือนการลบ 

รูปท่ี 4.1.4a: หน้าจอ TB แสดง
ข้อความเตือนการแทนท่ี 
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         4.1.5 การปรับค่าความเร็วด้วย TB 
1) ใช้มือซ้ายยงักด Deadman switch พร้อมกบัปุ่ ม [STEP/MOVE] อยู ่ใช้มือขวากดปุ่ ม [+/FORWD] เพื่อปรับคา่

ความเร็ว override ให้สงูขึน้ หรือ [-/BACKWD] เพื่อปรับคา่ความเร็ว override ให้ลดลง 
 

การก าหนดต าแหนง่โดยใช้ TB นัน้มีแนวทางเช่นเดยีวกบัแนวทางในซอฟต์แวร์ซึง่ต้องมกีารวางแผนดงัตวัอยา่งที่ 2.1 อยา่งไรก็
ตาม ในการก าหนดต าแหนง่ให้กบัหุน่ยนต์จริงๆ นัน้มีข้อควรระวงัเก่ียวกบัความปลอดภยัมากกวา่ในซอฟต์แวร์ ซึง่ต้องท าการ
วางแผนให้รอบคอบก่อนปฏิบตังิานจริงทกุครัง้ รูป 4.1.6a, b และ c แสดงตวัอยา่งให้เห็นความผิดพลาดที่เกิดขึน้ในระหวา่งการ
ก าหนดต าแหนง่ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
   
 
 
 
 
 
 
 
 

 

รูปท่ี 4.1.6a: แสดงการใช้การเคลือ่นท่ีผิดประเภท 
การเคลือ่นท่ีจาก P1 ไป P2 สามารถท าได้ 2 วิธี คือ 
การเคลือ่นท่ีแบบค านวณตามแกน และการเคลือ่นท่ี
แบบเส้นตรง แตก่ารก าหนดต าแหนง่ให้กบัหุน่ยนต์
ต้องค านงึถงึอปุกรณ์ที่อยูใ่นบริเวณรอบๆ หุน่ยนต์ด้วย  
ในท่ีนี ้ถ้าใช้การเคลือ่นท่ีแบบค านวณตามแกน 
หุน่ยนต์จะเคลือ่นท่ีชนอปุกรณ์ 

 

รูปท่ี 4.1.6b: แสดงการใช้เส้นทางที่ไมเ่หมาะสม 
 การเคลือ่นท่ีจาก P1 ไป P4 มี 2 เส้นทาง คือ เคลือ่นท่ี
จาก P1, P2, P3 และ P4 และ เคลือ่นท่ีจาก P1 ถึง P4 
ซึง่ผู้ เรียนต้องเลอืกเส้นทางที่หุน่ยนต์จะไมช่นกบั
อปุกรณ์อื่นในบริเวณรอบๆ หุน่ยนต์ ในที่นีเ้ส้นทางแรก
เป็นเส้นทางทีเ่หมาะสมที่สดุ 

 

รูปท่ี 4.1.6c: แสดงการไมต่รวจสอบสภาวะของกริป
เปอร์ก่อนหยิบชิน้งาน  ในที่นีก้ริปเปอร์ปิดอยู ่แตก่ าลงั
เคลือ่นท่ีเข้าหาชิน้งาน ซึง่จะท าให้มีการชนเกิดขึน้ 
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แบบฝึกหดัที่ 4.1a: จงก าหนดต าแหนง่ใดๆ 5 ต าแหนง่ให้กบัหุน่ยนต์โดยใช้ TB  
แบบฝึกหดัที่ 4.1b: จงก าหนดต าแหนง่ให้กบัหุน่ยนต์โดยใช้ TB และใช้สภาพแวดล้อมที่มีลกัษณะเหมาะส าหรับการหยิบจบั
ชิน้งานจากสถานท่ีหนึง่ไปวางอีกสถานท่ีหนึ่ง (Pick and place) วตัถปุระสงค์ของแบบฝึกหดันีต้้องการให้ผู้ เรียนสามารถก าหนด
ต าแหนง่ให้หุน่ยนต์เพื่อการจบัชิน้งานจากที่หนึง่ไปวางอีกที่หนึง่ได้  
หมายเหต:ุ การจดัสภาพแวดล้อมขึน้อยูก่บัชดุฝึกและอปุกรณ์ทีม่ีอยู ่ ถ้าสภาพแวดล้อมของผู้ เรียนมีสภาพท่ีเอือ้อ านวยตอ่การ
หยิบจบัชิน้งานก็ไมม่ีความจ าเป็นต้องจดัสภาพแวดล้อมใหม ่ อยา่งไรก็ตาม ในกรณีที่สภาพแวดล้อมไมเ่หมาะสม อาจจดั
สภาพแวดล้อมดงัรูปท่ี 4.1.5a 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 

รูปท่ี 4.1.5a: ตวัอยา่ง
สภาพแวดล้อมส าหรับแบบฝึกหดัที่ 
4.1b 
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4.2 การเขียนโปรแกรม 
1. หลงัจากเปิดโปรแกรม COSIMIR Industrial แลว้ ใชค้ าสัง่ File> Project Wizard จะปรากฏหน้าต่างดงัรปูท่ี 

4.2.1a หมายเหตุ: เสยีบ Hardlock ขณะใช้งานโปรแกรม COSIMIR Industrial ตลอดเวลา 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. ใส่ช่ือ Project Name ซ่ึงช่ือของ Project Name จะเป็นช่ือของโมเดล Position Lists และโปรแกรมโดยอตัโนมติั 
ทั้งสามไฟลจ์ะมีช่ือไฟลเ์หมือนกนัแต่คนละนามสกุล ซ่ึงทั้งสามไฟลจ์ะถูกเก็บไวท่ี้ C:\Program Files\COSIMIR 
Industrial\Projects ซ่ึงสามารถเปล่ียนสถานท่ีเก็บไฟลเ์หล่าน้ีได ้  
ใส่ช่ือโปรแกรม ใส่ช่ือผูเ้ขยีนโปรแกรมในช่อง ‘Created by’ และช่ือยอ่ผูเ้ขยีนโปรแกรมในช่อง ‘Initials’ ดงัตวัอยา่ง
ในรปู 4.2.1b 
 
 
 
 
 
 
 
 
 
 
 
 

 

รูปท่ี 4.2.1a: หน้าตา่ง Project Wizard  

 

รูปท่ี 4.2.1b: หน้าตา่ง Project Wizard 
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3. หลงัจากน้ันกดปุ่ม Next แลว้เลือกรุ่นของหุ่นยนต,์ จ านวนการด์อินพุทเอาทพ์ุท (I/O interface card), จ านวน 
กริปเปอร ์และ ภาษาท่ีจะใชใ้นการเขยีนโปรแกรม ซ่ึงขอ้มลูเหล่าน้ีจะตอ้งตรงกบัฮารด์แวรท่ี์มอียู่ดงัตวัอยา่งในรปู 

4.2.1c (หมายเหตุ: ในบทน้ีจะกล่าวถึง Melfa Basic IV เท่าน้ัน) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
4. หลงัจากน้ันกดปุ่ม Finish แลว้จะปรากฏหน้าต่างดงัรปูท่ี 4.2.1d ซ่ึงจะปรากฏหน้าต่างทั้งหมด 4 หน้าต่างคือ 
หน้าต่างโมเดล Position Lists โปรแกรม และ message ซ่ึงเป็นหน้าต่างรายงานผลการคอมไพลแ์ละการ

ติดต่อส่ือสารกบัคอนโทรลเลอร ์

 
 
 
 
 
 
 
 
 
 
 
 

 
 

 

รูปท่ี 4.2.1c: หน้าตา่ง Project Wizard 

 

รูปท่ี 4.2.1d:  
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5. เขียนโปรแกรมโดยใช้หลกัการวางแผนในการเขยีนโปรแกรมเชน่เดียวกนักบัหวัข้อ 3.3 เร่ืองขัน้ตอนใน การเขยีน
โปรแกรม เมื่อเขียนโปรแกรมเสร็จแล้วให้บนัทกึโปรแกรมโดยคลิก๊ที่หน้าตา่งโมเดลแล้วใช้ค าสัง่ File > Save all ทัง้
สามหน้าตา่งคือ โมเดล ต าแหนง่ และโปรแกรมจะถกูบนัทกึทัง้หมด 
6. เมื่อเขยีนโปรแกรมเสร็จแล้ว ให้อพัโหลดต าแหนง่ขึน้มาโดยใช้วธีิการในหวัข้อ 4.3.1 
7. ใช้ค าสัง่ File > Save all 
8. ขัน้ตอนตอ่ไปคือขัน้ตอนของ Project Management โดยใช้ค าสัง่ Execute > Project Management แล้วเลอืก
แท็บ Files เพื่อตรวจสอบวา่มีไฟล์โปรแกรมและต าแหนง่หรือไม ่หลงัจากนัน้คอมไพล์โปรเจคท์ 
9. ดาวน์โหลดโปรแกรมโดยใช้วิธีการในหวัข้อ 4.3.1 
10. รันโปรแกรมจากคอมพิวเตอร์โดยใช้ค าสัง่ Execute > Program Start และหยดุการรันโปรแกรมโดยใช้ค าสัง่ 
Execute > Program Stop  
หมายเหต:ุ การรันโปรแกรมอกีวธีิหนึง่ คือ การรันจากคอนโทรลเลอร์ซึง่อธิบายไว้ในหวัข้อ 4.4.1 
11. เมื่อต้องการเปิด project ทีช่ื่อ manual ขึน้มาใหมใ่ห้ไปท่ีค าสัง่ File > Open เข้าไปในไดเร็กทอร่ีที่ COSIMIR 
Industrial ติดตัง้อยูจ่ะปรากฏหน้าตา่งดงัรูปท่ี 4.2.1e ดบัเบิล้คลิก๊ที่ไดเร็กทอร่ี ‘Projects’ ดงัรูปที่ 4.2.1f จะพบวา่
มี Project ตา่งๆ ถกูบนัทกึไว้ ดบัเบิล้คลิก๊ที่ช่ือโปรเจคท์ที่ต้องการเปิด ในท่ีนีค้ือ ‘Manual’ จะปรากฏไฟล์ 
Manual.MOD  หลงัจากนัน้จะปรากฏหน้าตา่งโมเดล ต าแหนง่และโปรแกรมขึน้พร้อมกัน 
 
 

แบบฝึกหดัที่ 4.2a: จงเขยีนโปรแกรมโดยใช้ต าแหนง่จากแบบฝึกหดัที่ 4.1a โดยให้หุน่ยนต์เคลือ่นที่จากจดุที่ 1 ไปจดุที่ 5  
แบบฝึกหดัที่ 4.2b: จงเขียนโปรแกรมโดยใช้ต าแหนง่จากแบบฝึกหดัที่ 4.1b โดยให้หุน่ยนต์เคลือ่นที่หยิบชิน้งานจากสถานท่ีหนึง่
ไปวางอกีสถานท่ีหนึง่ 
 
ในบทท่ีผา่นมาเราเรียนซอฟต์แวร์ COSIMIR Educational ซึง่สามารถเขยีนโปรแกรมที่มีการสง่ข้อมลูไปมาระหวา่งหุน่ยนต์และ

อปุกรณ์ภายนอก และการเช่ือมตอ่ระหวา่งหุน่ยนต์และอปุกรณ์ภายนอกสามารถกระท าในซอฟต์แวร์ได้ ซึง่ซอฟต์แวร์ COSIMIR 
Industrial ก็มคีณุสมบตัินี ้ อยา่งไรก็ตาม ในบทนีเ้ราจะให้ความส าคญักบัการเช่ือมตอ่ระหวา่งหุน่ยนต์และอปุกรณ์ภายนอกโดยใช้
สายไฟเช่ือมตอ่กนัจริงๆ ซึง่เราจ าเป็นต้องทราบระบบที่เรามีอยู ่ ซึง่มีลกัษณะดงัรูป 4.2.2a ระบบประกอบไปด้วยคอนโทรลเลอร์และ
หุน่ยนต์ ซึง่ระบบนีต้ดิตอ่สือ่สารกบัอปุกรณ์ภายนอกโดยผ่านสายสือ่สารแบบขนาน ตอ่จาก External I/O signal connection ที่อยู่
ด้านหลงัของคอนโทรลเลอร์ซึง่เป็นพอร์ทแบบ 50 พิน (ดรููป 4.2.2b) ไปยงัพอร์ทของ I/O terminalซึง่มี 24 พิน และจากไป I/O 
terminal ไปยงัอปุกรณ์ภายนอก  I/O terminal เปรียบเสมือนตวักลางระหวา่งระบบและอปุกรณ์ภายนอกท าให้การเช่ือมตอ่สายไฟท า
ได้ง่ายและสะดวกขึน้  ในกรณีที่ไมม่ี I/O terminal อปุกรณ์ภายนอกจะต้องตอ่กบั External I/O signal connection โดยตรงซึง่เป็น
พอร์ทแบบ 50 ขา ซึง่การเช่ือมตอ่แบบนีไ้มเ่หมาะสมและไมป่ลอดภยั จึงต้องมี I/O terminal เพื่อเพิ่มความสะดวก   
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I/O terminal System 

อุปกรณ์ภายนอก 
(Peripheral 

Device) 

Input 

Output 

รูป 4.2.2a: รูปแสดงระบบการเช่ือมตอ่หุน่ยนต์กบัอปุกรณ์ภายนอกผา่น I/O terminal 

รูป 4.2.2b: รูปแสดงด้านหลงัของคอนโทรลเลอร์ซึง่มีพอร์ทแบบ 50 ขา 

สาย สือ่สารแบบขนาน 
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ตารางที่ 4.2.1: ตารางแสดงความสัมพนัธ์ระหว่างอินพุทและเอาท์พุทบทิ หมายเลขบทิและพินของพอร์ท I/O terminal 
 

Input bit bit number Pin  Output bit bit number Pin 
0 8 13  0 8 1 
1 9 14  1 9 2 
2 10 15  2 10 3 
3 11 16  3 11 4 
4 12 17  4 12 5 
5 13 18  5 13 6 
6 14 19  6 14 7 
7 15 20  7 15 8 

 
พินที่เหลอืถกูใช้ส าหรับการจ่ายไฟให้กบั I/O terminal ซึง่รายละเอียดความสมัพนัธ์ทัง้หมดอยูใ่นตารางที่ 1 ใน ภาคผนวก 
หน้า A-15 

ตารางที่ 4.2.2: ตารางแสดงความสัมพนัธ์ระหว่างอินพุทและเอาท์พุทบทิ หมายเลขบทิและพินของพอร์ทของ
คอนโทรลเลอร์ 
 

Input bit bit number Pin  Output bit bit number Pin 
0 8 40  0 8 10 
1 9 41  1 9 11 
2 10 42  2 10 12 
3 11 43  3 11 13 
4 12 44  4 12 35 
5 13 45  5 13 36 
6 14 46  6 14 37 
7 15 47  7 15 38 

 
พินที่เหลอืถกูใช้ส าหรับการจ่ายไฟให้กบัคอนโทรลเลอร์ ควบคมุเซอร์โวมอเตอร์ เป็นต้น ซึง่รายละเอียดความสมัพนัธ์ทัง้หมด
อยูใ่นตารางที่ 2 ใน ภาคผนวก หน้า A-16 
หมายเหต:ุ การท่ีเราจะทราบวา่อินพทุบิทไหนวิ่งผา่นพินไหนแล้วเป็นบิทหมายเลขใดในการเขยีนโปรแกรมนัน้ขึน้อยูก่บัการ์ด 
I/O ที่ติดตัง้ในคอนโทรลเลอร์ 

รูป 4.2.2c แสดงตวัอยา่งการเช่ือมตอ่ระหวา่งระบบกบัอปุกรณ์ภายนอก  ระบบรับสญัญาณอินพทุจาก start button 
และสง่สญัญาณเอาท์พทุให้วาล์ว   start button เป็นตอ่เข้ากบัอินพทุบิทท่ี 0 ของ I/O terminal ซึง่เป็นบิทหมายเลข 8 
(M_IN(8)) เป็นหมายเลขส าหรับอ้างองิในการเขยีนโปรแกรม (ดตูาราง 4.2.1 ประกอบ) เมื่อกดปุ่ มสตาร์ทจะมีสญัญาณคา่ 
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‘1’ เข้ามาที่อินพทุบิทท่ี 0 (M_IN(8) = 1) โดยสญัญาณจะวิ่งผา่นพินท่ี 13 ของพอร์ท I/O terminal ผา่นสายสือ่สารแบบ
ขนาน และเข้าสูค่อนโทรลเลอร์โดยที่คอนโทรลเลอร์รับสญัญาณ M_IN(8) = 1 ผา่นอินพทุบิทที่ 0 พินที่ 40 ของ
คอนโทรลเลอร์ (ดตูาราง 4.2.2 ประกอบ)  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

รูป 4.2.2c: รูปแสดงตวัอยา่งการเช่ือมตอ่ระหวา่งระบบกบัอปุกรณ์ภายนอกผา่น I/O terminal 
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โซลนิอยด์วาล์วตอ่เข้ากบัเอาท์พทุบิทท่ี 0 ของ I/O terminal ซึง่เป็นบิทหมายเลข 8 (M_OUT(8)) เป็นหมายเลขส าหรับอ้างองิใน
การเขยีนโปรแกรม (ดตูาราง 4.2.2 ประกอบ) เมื่อคอนโทรลเลอร์สง่สญัญาณคา่ ‘1’ สญัญาณจะวิง่จากพินท่ี 10 ของพอร์ท
คอนโทรลเลอร์เข้าพินที่ 1 ของพอร์ท I/O terminal (ดตูาราง 4.2.1 ประกอบ) ผา่นทางเอาท์พทุบิทท่ี 0 (M_OUT(8) = 1)  โซลิ
นอยด์วาล์วได้รับสญัญาณคา่ ‘1’  วาล์วก็เกิดการเปลีย่นห้อง ลมอดัเคลือ่นท่ีเข้าสูก่ระบอกสบู  เมือ่คอนโทรลเลอร์สง่สญัญาณคา่ 
‘0’ วาล์วและกระบอกสบูจะกลบัสูส่ภาวะปกต ิ
แบบฝึกหดัที่ 4.2c: จงเขียนโปรแกรมโดยใช้ต าแหนง่จากแบบฝึกหดัที่ 4.1b และใช้ start button และวาล์วและกระบอกสบูเป็น
อินพทุและเอาท์พทุตามล าดบั โดยมีเง่ือนไขดงัตอ่ไปนี ้ เมื่อกดปุ่ ม start button หุน่ยนต์เร่ิมท างานเคลือ่นท่ีไปหยิบชิน้งานจาก 
pallet ใส ่socket เมื่อวางชิน้งานเสร็จเรียบร้อยแล้วกลบัสูต่ าแหนง่เร่ิมต้น แล้วกระบอกสบูเคลือ่นที่ออกและกลบั จบหนึง่รอบการ
ท างาน  

 

4.3 การแลกเปล่ียนข้อมูลระหว่างคอนโทรลเลอร์และคอมพวิเตอร์ 
การแลกเปลีย่นข้อมลูระหวา่งคอมพิวเตอร์และคอนโทรลเลอร์ผา่นสาย personal computer cable การแลกเปลีย่นข้อมลู
ท าได้สองทาง คือ จากคอมพิวเตอร์สูค่อนโทรลเลอร์ (download) และจากคอนโทรลเลอร์สูค่อมพิวเตอร์ (upload)  

4.3.1 ขัน้ตอนการอัพโหลดและดาวน์โหลด 
1) เสยีบสาย personal computer cable ที่ serial port ของคอมพิวเตอร์เข้ากบัคอนโทรลเลอร์เพื่อการสือ่สาร

ระหวา่งคอมพวิเตอร์และคอนโทรลเลอร์  
  2) บิดกญุแจที่คอนโทรลเลอร์มาที่ต าแหนง่ ‘AUTO (Ext)’  
  3) Extras > Settings > Communication Port รูป 4.3.1a 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  4) เลอืกแท็บ ‘Serial Interface’ รูป 4.3.1b พอร์ท ‘COM1’ กดปุ่ ม OK 
 

 

รูปท่ี 4.3.1a:  
หน้าตา่ง Communication Port 
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5) Execute > Init Connection เมื่อการติดตอ่ระหวา่งคอนโทรลเลอร์และคอมพิวเตอร์ส าเร็จจะปรากฏหน้าตา่งดงั
รูป 4.3.1c ให้กดปุ่ ม OK และจะมีเคร่ืองหมายถกูอยูด้่านหน้าค าสัง่ Init Connection 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
6) Activate หน้าตา่งที่ต้องการดาวน์โหลดหรืออพัโหลด โดยคลิก๊ที่หน้าตา่งนัน้ๆ  ในตวัอยา่งนีจ้ะอพัโหลด

ต าแหนง่ 
7) ใช้ค าสัง่ Execute > Upload Robot -> PC เพื่อการอพัโหลด หรือ Execute > Download Pc-> Robot เพื่อ

การดาวน์โหลด จะปรากฏหน้าตา่งดงัรูป 4.3.1d แล้วระบหุมายเลขโปรแกรมของต าแหนง่ที่ก าหนดไว้ในช่อง Name(“N”) 

 

รูปท่ี 4.3.1b:  
หน้าตา่ง Communication Port 

 

รูปท่ี 4.3.1c:  
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หลงัจากนัน้กดปุ่ ม OK  การถ่ายโอนข้อมลูจะเร่ิมต้น และเมือ่การถ่ายโอนข้อมลูเสร็จสิน้จะปรากฏต าแหนง่ในหน้าตา่ง 
Position list ดงัรูป 4.3.1e 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
8)  เมื่อต้องการยกเลกิการตดิตอ่สือ่สาร ให้ใช้ค าสัง่ Execute > Init Connection ก่อนถอดสาย personal 

computer cable 

4.3.2 การก าหนดต าแหน่งบนซอฟต์แวร์ด้วย Jog operation  
เป็นฟังก์ชัน่ส าหรับการก าหนดต าแหนง่บนซอฟต์แวร์โดยที่หุน่ยนต์จริงจะเคลือ่นท่ีไปด้วย  ขัน้ตอนการก าหนด
ต าแหนง่บนซอฟต์แวร์มีดงัตอ่ไปนี ้

ขัน้ตอนท่ี 1) – 5) เหมือนในหวัข้อ 4.3.1 
6) ใช้ค าสัง่ Execute > Jog operation จะปรากฏหน้าตา่งดงัรูป 4.3.2a  
หมายเหต:ุ รูป 4.3.2b คือ หน้าตา่งการก าหนดต าแหนง่บนซอฟต์แวร์ที่เคยใช้กนัใน COSIMIR Education 
ซึง่หุน่ยนต์จริงจะไมเ่คลือ่นท่ีตามไปด้วย การเรียกหน้าตา่งนีใ้ช้ค าสัง่ Extras > Teach-In 
แตอ่ยา่งไรก็ตามฟังก์ชัน่การท างานของปุ่ มตา่งๆ ยงัคงเหมือนเดิม 

 
 

 

 

รูปท่ี 4.3.1d:  

รูปท่ี 4.3.1e:  
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ขัน้ตอนการให้หุน่ยนต์แสดงต าแหนง่ที่ก าหนดบนซอฟต์แวร์มีดงัตอ่ไปนี ้
1) – 5) เหมือนในหวัข้อ 4.3.1 
6) ดบัเบิล้คลิก๊ที่ต าแหนง่ที่ต้องการให้หุน่ยนต์แสดงผล 
7) ใช้ค าสัง่ Execute > COSIMIR Position -> Robot แล้วหุน่ยนต์จะเคลือ่นท่ีไปยงัต าแหนง่ที่ระบไุว้ 
ขัน้ตอนการให้โมเดลแสดงต าแหนง่ของหุน่ยนต์มีดงัตอ่ไปนี ้
1) – 5) เหมือนในหวัข้อ 4.3.1 
6) ใช้ Jog operation ดงัรูป 4.3.2a เคลือ่นท่ีหุน่ยนต์จริง 
7) ใช้ค าสัง่ Execute > Robot Position -> COSIMIR แล้วโมเดลจะเคลือ่นท่ีไปยงัต าแหนง่ของหุน่ยนต์จริง 
 

 4.3.3 การดูสภาวะการท างานของหุ่นยนต์ 
  A) การดูสภาวะอนิพุทและเอาท์พุท (I/O Monitor) 
  เป็นฟังก์ชัน่ในการมอนเิตอร์ดสูภาวะอินพทุและเอาท์พทุ ซึง่มีขัน้ตอนในการเรียกดดูงัตอ่ไปนี ้
  ขัน้ตอนท่ี 1) ถงึ 5) เหมือนในหวัข้อ 4.3.1 
  6) ใช้ค าสัง่ Extras > I/O Monitor แล้วจะปรากฏหน้าตา่ง I/O Monitor ดงัรูป 4.3.3a 
 

  

รูปท่ี 4.3.2a: หน้าตา่งส าหรับก าหนดต าแหนง่บน
ซอฟต์แวร์โดยที่หุน่ยนต์เคลือ่นท่ีตามไปด้วย 

รูปท่ี 4.3.2b: หน้าตา่งส าหรับก าหนดต าแหนง่บน
ซอฟต์แวร์โดยที่หุน่ยนต์ไมเ่คลือ่นท่ีตามไปด้วย 
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B) การดูสภาวะการท างานของหุ่นยนต์ (Monitor function) 

การดสูภาวะการท างานของหุน่ยนต์สามารถกระท าได้โดยใช้ค าสัง่ Execute > Monitor Functions 
หน้าตา่งดงัรูป 4.3.3b จะปรากฏขึน้ โดยที่ 5 ขัน้ตอนแรกเหมือนกบัในหวัข้อ 4.3.1 

 
 
 

จากหน้าตา่ง Monitor จะเห็นวา่เราสามารถดสูภาวะการท างานของหุน่ยนต์ได้หลายแงม่มุหรือตวัแปร 
ดงัตารางที่ 4.3.2 

 
 
 
 
 

 

รูปท่ี 4.3.3a: หน้าตา่ง I/O Monitor ส าหรับดู
สภาวะอินพทุและเอาท์พทุ 

 

รูปท่ี 4.3.3b: หน้าตา่ง Monitor ส าหรับดสูภาวะ
การท างานตา่งๆ ของหุน่ยนต์ 
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  ตารางที่ 4.3.2: ตารางแสดงการท างานของปุ่มต่างๆ บนหน้าต่าง Monitor 
 

ปุ่ม ชื่อ หน้าที่ 

 Program-monitor มอนิเตอร์สถานะของโปรแกรมที่รันอยู ่

 Slot state monitor  

 Position monitor มอนิเตอร์คา่ของต าแหนง่ในเชิงมมุของข้อตอ่และ
แนวแกนของหุน่ยนต์ 

 Motor speed มอนิเตอร์คา่ความเร็วของเซอร์โวมอเตอร์ 

 Droop  

 Encoder มอนิเตอร์คา่ encoder ของเซอร์โวมอเตอร์ 

 Motor load มอนิเตอร์คา่ encoder ของเซอร์โวมอเตอร์ 

 Current1 มอนิเตอร์คา่กระแสไฟฟ้าของเซอร์โวมอเตอร์ 

 Current2 มอนิเตอร์คา่กระแสไฟฟ้าของเซอร์โวมอเตอร์ 

 Voltage มอนิเตอร์คา่แรงดนักระแสไฟฟ้าของเซอร์โวมอเตอร์ 

 
ในท่ีนีจ้ะขอยกตวัอยา่งการใช้งานบางปุ่ ม เช่น การมอนิเตอร์สถานะของโปรแกรมที่รันอยู่ หลงัจากที่กด
ปุ่ ม Program-monitor จะปรากฏหน้าตา่ง Program Monitor ดงัรูป 4.3.3c แล้วกดปุ่ ม On เพื่อออนไลน์
ดสูถานะของการรันโปรแกรม ในท่ีนีโ้ปรแกรม ช่ือ 50.MB4 รันถึงบรรทดัที่ 30 แล้ว Refresh time 
หมายถึง ชว่งเวลาในการอพัเดทข้อมลู ในท่ีนี ้Refresh time ถกูตัง้ไว้ที่ 1000 ms ซึง่หมายความวา่ทกุๆ 
1 วินาทีจะมีการอพัเดทข้อมลู การใช้งานนีเ้หมาะส าหรับการมอนิเตอร์และหา error ในโปรแกรมแบบ 
multitask ได้ง่ายขึน้ซึง่เป็นโปรแกรมที่ควบคมุการท างานของอปุกรณ์หลายๆ ตวัพร้อมๆ กนัในโรงงาน 
เช่น ควบคมุหุน่ยนต์และสายพาน  การมอนิเตอร์คา่ตวัแปรอืน่ก็สามารถกระท าได้เช่นเดียวกนักบัการ
มอนิเตอร์สถานะของโปรแกรม เช่น การมอนเิตอร์คา่แรงดนัไฟฟ้าดงัรูป 4.3.3d 
.   
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รูปท่ี 4.3.3c: หน้าตา่ง Program Monitor ส าหรับ
ดสูภาวะการรันโปรแกรมของหุน่ยนต์ 

 

รูปท่ี 4.3.3d: หน้าตา่ง Motor Power ส าหรับดู
แรงดนัไฟฟ้าของเซอร์โว 
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4.4 การใช้งานคอนโทรลเลอร์ 
 4.4.1 การเร่ิมต้นสตาร์ทคอนโทรลเลอร์ในโหมดอัตโนมัติ 

ก่อนเร่ิมต้นสตาร์ทคอนโทรลเลอร์ในโหมด AUTO (Op) หรือโหมดอตัโนมตัิ ควรท าการตรวจสอบสิง่ตอ่ไปนี ้ เพื่อ
ป้องกนัความเสยีหายต่อบคุคลและทรัพย์สนิ 
• ตรวจสอบวา่ไมม่ีบคุคลอยูใ่นบริเวณพืน้ท่ีท างานของหุน่ยนต์ 
• ตรวจสอบวา่ไมม่วีตัถใุดๆ ท่ีไมจ่ าเป็นภายในบริเวณพืน้ท่ีท างานของหุน่ยนต์ 
• ตรวจสอบวา่ชิน้งานวางอยูใ่นต าแหนง่ที่ก าหนดไว้ 
• ตรวจสอบให้แนใ่จวา่โปรแกรมท างานถกูต้อง 

ขัน้ตอนในการสตาร์ทคอนโทรลเลอร์ในโหมดอตัโนมตัิ มดีงัตอ่ไปนี ้
1) บิดกญุแจที่ TB มาที่ต าแหนง่ ‘DISABLE’ ดงัรูปท่ี 4.4.1a 
 
 
 
 
 
2) บิดกญุแจที่คอนโทรลเลอร์มาที่ต าแหนง่ ‘AUTO (Op)’ ดงัรูปท่ี 4.4.1b 
 
 
 
 
 
 
3) กดปุ่ ม [CHANG DISP] ที่หน้าแผงคอนโทรลเลอร์สองครัง้ หน้าจอจะปรากฏความเร็ว override ดงัรูป 4.4.1c 
 
 
 
 
4) กดปุ่ ม [UP] หรือ [DOWN] เพือ่เปลีย่นคา่ความเร็ว override ในตวัอยา่งเปลีย่นคา่ความเร็วเป็น 10 ดงัรูป 4.4.1d 
 
 
 
 
 
 

 

รูปท่ี 4.4.1a: บิดกญุแจที่ TB มาที่ต าแหนง่ 
‘DISABLE’ 

 

รูปท่ี 4.4.1b: บิดกญุแจหน้าแผงคอนโทรลเลอร์มาที่
ต าแหนง่ ‘DISABLE’ 

 

รูปท่ี 4.4.1c: หน้าจอแสดงผลความเร็ว override 

 

รูปท่ี 4.4.1d: ใช้ปุ่ ม [UP] หรือ [DOWN] เพื่อเปลีย่น
คา่ความเร็ว 
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5) กดปุ่ ม [CHNG DISP] แล้วหน้าจอจะแสดง ‘หมายเลขโปรแกรม’  
 
 
 
 
6) กดปุ่ ม [UP] หรือ [DOWN] เพือ่เลอืกโปรแกรมที่ต้องการ ในตวัอยา่งเปลีย่นเป็นโปรแกรมหมายเลข 1 ดงัรูป 4.4.1f 
 
 
 
 
 
 
7) กดปุ่ ม [START] ที่หน้าแผงคอนโทรลเลอร์เพื่อเร่ิมต้นการท างาน และกดปุ่ ม [STOP] เพื่อหยดุการท างาน 

 

 

รูปท่ี 4.4.1e: หน้าจอแสดงหมายเลขโปรแกรม 

 

รูปท่ี 4.4.1f: ใช้ปุ่ ม [UP] หรือ [DOWN] เพื่อเลอืก
โปรแกรมที่ต้องการ 
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Programming Language (MELFA Basic IV) 

 
 

Software “COSIMIR Industrial” เป็น Software ลขิสทิธ์ิ ท่ีใช้ส ำหรับควบคมุกำรท ำงำนของ Robot อตุสำหกรรม โดยมีฟังก์ชนักำร

ท ำงำนท่ีหลำกหลำยและซบัช้อนมำกกวำ่ Software “COSIMIR Educational” ที่ใช้เพื่อกำรศกึษำเทำ่นัน้ ทัง้นีฟั้งก์ชนัและ

ควำมสำมำรถตำ่งๆ ภำยใน Software COSIMIR Industrial มีดงันี ้

o สำมำรถจ ำลองกำรท ำงำน (Simulation) ของ Mitsubishi Robot ในรุ่นตำ่งๆ ได้ 

o สำมำรถสร้ำง Work Cell ของ Robot ได้ 

o สำมำรถสร้ำง Mechanical Work Cell เพื่อแสดงผลกำรจ ำลองกำรท ำงำนได้ เช่น ระบบ Conveyor, Sensors, Actuators, 

ฯลฯ 

o สำมำรถท ำกำรติดตอ่สือ่สำรกนัระหวำ่ง Software บนคอมพวิเตอร์ และ Robot เพื่อจะได้เห็นถึงกำรท ำงำนจริง 
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o สำมำรถเขียนโปรแกรมควบคมุกำรท ำงำน (Programming Language) เช่น *.MB4 และโปรแกรมควบคมุกำรเคลือ่นท่ี 

(Position List) เช่น *.POS, *.MRL 

o สำมำรถท ำกำร Download และ Upload โปรแกรมและ File กำรท ำงำนตำ่งๆ ได้ 

 

จะเห็นได้วำ่ Software “COSIMIR Industrial” มีประโยชน์อยำ่งมำกในกำรน ำไปใช้เพื่อศกึษำถึงพฤติกรรมกำรท ำงำน กำรเคลือ่นท่ี

ของ Robot รวมถงึกำรน ำไปประยกุต์ใช้งำน Robot จริงในงำนอตุสำหกรรม 

 

ค ำส่ังและกำรใช้ค ำส่ังในกำรเขียนโปรแกรมควบคุมแขนกล MELFA Basic IV 

 

1. สัญลักษณ์ ‘ 

เมื่อปรำกฏสญัลกัษณ์ ’ หน้ำอกัษรใดๆ ในแตล่ะบรรทดั หมำยควำมวำ่ข้อควำมหลงัสญัลกัษณ์นัน้เป็นค ำอธิบำย จะไมเ่ก่ียวข้อง

กบัโปรแกรม 

 ตัวอย่ำง  MOV P1  ‘Move to position P1  

ข้อควำมหลงัค ำสัง่จะเป็นกำรอธิบำยถงึค ำสัง่ข้ำงต้นเทำ่นัน้ ไมม่ผีลตอ่กำรท ำงำนในโปรแกรม 

 

2. Position ในโปรแกรม  

หลงัจำกท ำกำร Teach Position ที่จ ำเป็นให้กบั Robot แล้ว ภำยในโปรแกรม MELFA Basic IV จะเรียกช่ือต ำแหนง่ Position แต่

ละ Position เป็น P1, P2, P3 … ตำมล ำดบัไปเร่ือยๆ 
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3. ค ำสั่ง MOV… และ MVS… ในกำรเคลื่อนที่ของ Robot  

ค ำสัง่ MOV เป็นค ำสัง่ให้ Robot ท ำกำรเคลือ่นท่ีไปยงัต ำแหนง่ทีก่ ำหนด โดยหนว่ยประมวลผลภำยในตวั Robot เองจะท ำกำร

ค ำนวณหำระยะทำง และทิศทำงกำรเคลือ่นท่ีที่เหมำะสมที่สดุ โดยปกติจะเป็นกำรเคลือ่นท่ีในแนวเส้นโค้ง (Joint interpolation) 

 

ค ำสัง่ MVS เป็นค ำสัง่ให้ Robot ท ำกำรเคลือ่นท่ีไปยงัต ำแหนง่ทีก่ ำหนดเช่นกนั แตก่ำรใช้ค ำสัง่เคลือ่นท่ีแบบ MVS นีจ้ะเป็นกำร

สัง่ให้ Robot เคลือ่นท่ีจำกต ำแหนง่ปัจจบุนัไปยงัต ำแหนง่ที่ก ำหนดตำมแนวเส้นตรง (Linear interpolation) ซึง่กำรใช้ค ำสัง่กำร

เคลือ่นที่เป็นแนวเส้นตรงแบบนีจ้ะมีประโยชน์อยำ่งมำกในบำง Application เช่นกำรสัง่ให้ Robot เคลือ่นท่ีไปตำมแกนแนวดิ่ง (Z)  

 

 

 

 

 

 

 ตัวอย่ำง  MOV P2  Robot จะเคลือ่นท่ีไปตำมเส้นโค้ง A 

   MVS P2  Robot จะเคลือ่นท่ีไปตำมเส้นตรง B 

 

4. ค ำสั่ง IF…THEN… 

ค ำสัง่ IF…THEN เป็นค ำสัง่ทีใ่ช้ส ำหรับกำรสร้ำงเง่ือนไขให้โปรแกรมท ำงำนตำมทีก่ ำหนด เมื่อเง่ือนไขเป็นจริงให้ไปท ำค ำสัง่อยำ่ง

หนึง่ และเมื่อเง่ือนไขเป็นเทจ็ก็ให้โปรแกรมกระโดดไปท ำงำนตำมค ำสัง่อกีอยำ่งหนึง่ เช่น กำรใช้ค ำสัง่ IF…THEN ในกำรเช็ค 

Status Bit วำ่เมื่อไรก็ตำมที่ Bit แสดงสถำนะเป็น 1 ก็ให้โปรแกรม Robot เคลือ่นท่ี 

 

A B 
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ไปยงัต ำแหนง่ตอ่ไป อยำ่งไรก็ตำมถ้ำ Bit ยงัไมแ่สดงสถำนะเป็น 1 (ยงัตรวจเช็คได้วำ่ สถำนะเป็น 0) ก็ให้โปรแกรมคงวนลปูเช็ค

ไปเร่ือยๆ 

ตัวอย่ำง   

 

 

 

 

5. ค ำสั่ง GOTO…/GOSUB…RETURN 

ค ำสัง่ GOTO เป็นค ำสัง่ให้โปรแกรมข้ำมไปท ำงำนตำมบรรทดั (Line Number) ในโปรแกรมที่ก ำหนด  

ค ำสัง่ GOSUB เป็นค ำสัง่ที่สัง่ให้โปรแกรมข้ำมไปท ำงำนยงัโปรแกรมยอ่ยทีก่ ำหนด โดยในโปรแกรมยอ่ยแตล่ะโปรแกรมจะต้องมี

หวัของโปรแกรมเป็นตวับง่ชีว้ำ่เป็นโปรแกรมยอ่ยช่ืออะไร ทัง้นีใ้นค ำสัง่ MELFA Basic IV จะใช้สญัลกัษณ์ * เป็นตวัแสดงวำ่เป็น

หวัของโปรแกรมยอ่ย 

ตัวอย่ำง   

 

 

 

 

 

 

 

6. ค ำสั่ง OVRD… 

ค ำสัง่ OVRD เป็นค ำสัง่ที่ใช้ในกำรเพิ่มหรือลด Override Speed ของกำรเคลือ่นท่ีของ Robot โดยกำรค ำนวนกำรเพิ่มหรือลด

ควำมเร็วในกำรเคลือ่นท่ีจะคดิเป็นเปอร์เซ็นต์ (0% ถงึ 100%) ของควำมเร็วที่ตัง้ไว้ตัง้แตต่อนแรกทีต่วั Controller ของ Robot 

100 IF M_IN(9) = 1 THEN 120
110 GOTO 100
120 MOV P3

 

3900 GOSUB *PLACECYL
3910 GOSUB *GETPIST
3920 GOSUB *ASSPIST
   :
4100             *PLACECYL

       4110             COVER% = 1
          :
       4140 RETURN
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ตัวอย่ำง  1) ถ้ำ Controller ถกูเซตคำ่ override speed ไว้ที่ 100% 

   MOV P1  Robot จะเคลือ่นท่ีไปยงัต ำแหนง่ P1 ด้วยควำมเร็ว override 100% 

   OVRD 70 ค ำสัง่ลดควำมเร็ว Override Speed 

MOV P2 Robot จะเคลือ่นท่ีไปยงัต ำแหนง่ P2 ด้วยควำมเร็ว override 100*70% = 70% 

   2) ถ้ำ Controller ถกูเซตคำ่ override speed ไว้ที่ 50% 

   MOV P1  Robot จะเคลือ่นท่ีไปยงัต ำแหนง่ P1 ด้วยควำมเร็ว override 50% 

   OVRD 70 ค ำสัง่ลดควำมเร็ว Override Speed 

MOV P2 Robot จะเคลือ่นท่ีไปยงัต ำแหนง่ P2 ด้วยควำมเร็ว override 50*70% = 35% 

 

7. ค ำสั่ง HCLOSE1 และ HOPEN1 

ค ำสัง่ HCLOSE1 และ HOPEN1 เป็นค ำสัง่เฉพำะทีใ่ช้ในกำรสัง่กำรให้ Gripper ที่ติดตัง้อยูท่ี่ตวั Robot ท ำกำรเปิดหรือปิด เพื่อ

หยิบจบัและปลอ่ยชิน้งำน โดย 

   HCLOSE1 จะสัง่กำรให้ Robot Gripper Close 

   HOPEN1 จะสัง่กำรให้ Robot Gripper Open 
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8. ค ำสั่ง DLY… 

ค ำสัง่ DLY เป็นค ำสัง่เพื่อให้โปรแกรมท ำกำรหนว่งเวลำท ำงำนเพือ่ให้ Robot ท ำงำนทนักนักบัคำบเวลำในโปรแกรม เช่นในกำร

เคลือ่นท่ีไปหยิบจบัชิน้งำน ณ ต ำแหนง่ๆ หนึง่นัน้ หลงัจำกที่ Robot เคลือ่นท่ีมำถึงต ำแหนง่ที่ต้องกำรแล้ว ต้องมีกำร Delay หนว่ง

เวลำก่อนเพื่อให้แนใ่จวำ่ Robot เคลือ่นท่ีมำถงึต ำแหนง่แล้วจริงๆ ก่อนที่จะท ำกำรหยิบชิน้งำน 

 ตัวอย่ำง  OVRD 10 ค ำสัง่ลดควำมเร็ว Override Speed 

   MVS P10 ค ำสัง่เคลือ่นท่ีในแนวเส้นตรงไปยงัต ำแหนง่ P10 

   DLY 1  ค ำสัง่หนว่งเวลำท ำงำน 1 วินำท ี

   HCLOSE1 ค ำสัง่ให้ Robot Gripper Close 

   DLY 1  ค ำสัง่หนว่งเวลำท ำงำน 1 วินำท ี

   MVS P9  ค ำสัง่เคลือ่นท่ีในแนวเส้นตรงไปยงัต ำแหนง่ P9 

 

9. ค ำสั่ง DEF INTE… 

ค ำสัง่ DEF INTE เป็นค ำสัง่ที่ใช้ในกำรก ำหนดตวัแปรที่จะน ำไปใช้ในโปรแกรม โดยกำรก ำหนดตวัแปรนัน้จะใช้อกัษร (character) 

ไมเ่กิน 8 ตวัอกัษร และกำรน ำไปใช้ในโปรแกรมก็สำมำรถใช้ช่ือที่ก ำหนดนัน้ได้เลย แตต้่องตำมด้วยเคร่ืองหมำย % 

 ตัวอย่ำง   

 

 

 

 

 

 

10     DEF INTE COUNTER
20     COUNTER% = 1
30     MOV P1
40     MOV P2
50     DLY 1
60     IF COUNTER% = 5 THEN GOTO 100
70     COUNTER% = COUNTER%+1
80     GOTO 30
90     MOV P3
100   COUNTER% = 1
110   GOTO 30
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10. ค ำสั่ง SPD… 

ค ำสัง่ SPD จะเหมือนกบัค ำสัง่ OVRD คือเป็นกำรก ำหนดคำ่ควำมเร็ว Override ของกำรเคลือ่นท่ีของ Robot แตค่ ำสัง่ OVRD 

นัน้จะใช้งำนง่ำยกวำ่ คือไมต้่องมีกำรก ำหนดตวัแปรเพือ่น ำมำใช้ในโปรแกรม เพียงแตก่ ำหนดตวัเลขแสดงควำมเร็วที่ต้องกำรเป็น

เปอร์เซ็นต์เทำ่นัน้ แตค่ ำสัง่ SPD นัน้จะต้องมีกำรก ำหนดตวัแปรเป็น Character ขึน้มำก่อน โดยค ำสัง่ DEF INTE 

ข้อแตกตำ่งระหวำ่งกำรก ำหนดคำ่ควำมเร็ว Override ทัง้สองวธีินีก็้มีข้อดีข้อเสยีแตกตำ่งกนัไป คือ กำรใช้ค ำสัง่ OVRD นัน้

สำมำรถก ำหนดคำ่ควำมเร็วได้ทนัทีโดยไมต้่องมกีำรก ำหนดคำ่ตวัแปรก่อน แตใ่นขณะเดียวกนั กำรใช้ค ำสัง่ SPD ในกำรก ำหนด

ควำมเร็วนัน้ เมื่อมกีำรก ำหนดตวัแปรขึน้ส ำหรับใช้ในโปรแกรมแล้วก็สำมำรถใช้ตวัแปรนัน้ๆ ได้ทกุต ำแหนง่ตลอดทัง้โปรแกรมโดย

ไมต้่องก ำหนดตวัแปรใหมอ่ีก ซึง่ท ำให้มคีวำมสะดวกในกำรเขียนโปรแกรม 

 

 ตัวอย่ำง  กำรใช้ค ำสั่ง OVRD           กำรใช้ค ำสั่ง SPD 

 

 

 

 

 

 

 

 

 

 

10     MOV P1
20     OVRD 70
30     MOV P2
40     OVRD 15
50     MVS P3
60     DLY 1
70     HCLOSE1
80     DLY 1
90     MVS P2
100   OVRD 70
110   MOV P1
 :

 

10     DEF INTE FST
20     FST% = 70
30     DEF INTE SLW
40     SLW% = 15
50     MOV P1
60     SPD FST%
70     MOV P2
80     SPD SLW%
90     MVS P3
100   DLY 1
110   HCLOSE1
120   DLY 1
130   MVS P2
140   SPD FST%
150 MOV P1
 :
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11. ค ำสั่ง DEF POS… 

ค ำสัง่ DEF POS เป็นกำรก ำหนดช่ือและคำ่ต ำแหนง่ของโปรแกรม โดยจะท ำให้ Robot สำมำรถเคลือ่นท่ีไปยงัต ำแหนง่ตำ่งๆ 

ภำยในโปรแกรมได้นอกเหนือไปจำก Position ที่ท ำกำร Teach ไว้แล้ว ส ำหรับกำรเคลือ่นท่ีที่ส ำคญัจะแบง่เป็น 4 แกนหลกัๆ 

ด้วยกนั คือ แกน X, แกน Y, แกน Z, และแกนกำรหมนุของหวั Gripper (ทิศทำงตำมเข็มนำฬิกำเป็น + และทวนเข็มนำฬิกำเป็น -) 

 

นอกจำกนีย้งัมีค ำสัง่ในกำรก ำหนดช่ือและต ำแหนง่ของโปรแกรมทีเ่ป็นต ำแหนง่ชว่ย (Auxiliary Position) เพื่อใช้เป็นต ำแหนง่ใน

กำรพกัคำ่กำรค ำนวณกำรเคลือ่นท่ีของ Robot ก่อนที่จะมีกำรเคลือ่นท่ีจริง ส ำหรับกำรก ำหนดช่ือต ำแหนง่ชว่ย สำมำรถท ำได้โดย

กำรใช้ค ำสัง่ “DEF POS AUXPOS” 

 

ทัง้นีก้ำรก ำหนดต ำแหนง่ Offset ในกำรให้ Robot เคลือ่นท่ีนัน้ ก็สำมำรถท ำได้โดยให้เคลือ่นท่ีเป็น Vector ผลรวมของกำร

เคลือ่นท่ีทัง้สองหรือสำมแกนในเวลำเดียวกนัได้ โดยเรำสำมำรถก ำหนดคำ่ Position ที่ต้องกำรเข้ำไปในแตล่ะแนวแกน จำกนัน้ 

Controller ภำยในจะท ำกำรค ำนวณทิศทำงกำรเคลือ่นท่ีที่เหมำะสมให้เอง เช่นต้องกำรเคลือ่น Robot ให้หำ่งจำกต ำแหนง่ P2 ไป

ตำมแนวแกน +X 50 mm. แกน -Y 20 mm. สำมำรถท ำได้ดงันี ้

 

10 DEF POS AUXPOS 

20 DEF POS VECXY 

30 VECXY = (+50.00, -20.00,+0.00,+0.00,+0.00) 

40 MOV P1 

50 DLY 1 

60 AUXPOS = P1 + VECXY 

70 MOV AUXPOS 

: 
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ตัวอย่ำง ต้องกำรให้ Robot เคลือ่นท่ีไปในต ำแหนง่ Offset เหนือ Position P1 (+100.00, +150, +30.00, +0.00, 

+0.00) ไปตำมแนวแกน Z เป็นระยะ 100 mm. แล้วท ำกำรหมนุหวั Gripper ไปตำมทศิทำงตำมเขม็

นำฬิกำเป็นมมุ 10 องศำ หลงัจำกนัน้เคลือ่น Robot ไปยงัต ำแหนง่ P2 (+50.00, +120.00, +50.00, 

+90.00, +0.00) แตย่งัคงให้หวั Gripper ค้ำงอยูท่ี่ต ำแหนง่เดมิจำกกำรหมนุตำมเข็มนำฬิกำเป็นมมุ 10 

องศำทีต่ ำแหนง่ Offset P1 

10 DEF POS AUX
20 DEF POS VECZ100
30 DEF POS VECDEG10
40 DEF POS VECXYZ
50 VECZ100 = (+0.00, +0.00, +100.00, +0.00, +0.00)
60 VECDEG10 = (+0.00, +0.00, +0.00, +10.00, +0.00)
70 VECXYZ = (-50.00, -30.00, +50.00, +0.00, +0.00)
80 MOV P1
90 DLY 1
100 AUXPOS = P1 + VECZ100
110 MOV AUXPOS
120 DLY 1
130 AUXPOS= AUXPOS + VECDEG10
140 MOV AUXPOS
150 DLY 1
160 AUXPOS = AUXPOS + VECXYZ
170 MOV AUXPOS
:

 

ก ำหนดช่ือต ำแหน่งที่ใช้ในโปรแกรม

 

ระบตุ ำแหน่งที่ใช้ในกำร
เคลื่อนที่ของ Robot

ผลตำ่งของต ำแหน่งทำงแกน X, Y และ Z
ระหวำ่งต ำแหน่ง P1 และ P2
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12. ค ำสั่งก ำหนด Input/Output 

ค ำสัง่ก ำหนด Input/Output ที่เป็น bit เพื่อแสดงสถำนะ on/off สำมำรถท ำได้โดยใช้รูปแบบดงันี ้

- กรณี INPUT ใช้ “M_IN(Bit Number)” เช่น  

Input bit number 3 มีสถำนะเป็น 1 (ON)   M_IN(3) =1 

 

- กรณี OUTPUT ใช้ “M_OUT(Bit Number)” เช่น  

Output bit number 7 มีสถำนะเป็น 0 (OFF)   M_OUT(7) =0 

นอกจำกนีย้งัมีค ำสัง่กำร Define ต ำแหนง่ bit ของ input และ output อีกวธีิหนึง่เพื่อน ำเง่ือนไงกำรแสดงผลสถำนะ on/off โดยใช้

รูปแบบกำร Define คล้ำยกบักำร define ต ำแหนง่ ดงันี ้

 “DEF IO (ชื่อ) = Bit, (Bit Number)” 

 

ตัวอย่ำง  ก ำหนดเง่ือนไขให้สภำวะเร่ิมต้นกำรท ำงำน Lamp output Bit ที่ 8 มีสถำนะเป็น ON (1)  

และเมื่อมเีง่ือนไขถ้ำ Input Bit ที่ 8 เป็น OFF (0) จะสง่ผลให้ Lamp output Bit ที่ 8 ดงักลำ่วเปลีย่น

สถำนะเป็น OFF (0) 

 

 

 

 

 

 

 

 

 

10 DEF IO MO1B1 = BIT,8
20 DEF IO SPRING = BIT,8
:
:
50 SPRING = 1
60 IF MO1B1 = 0 THEN GOTO 60
70 DLY 1
80 SPRING = 0
:

ช่ือแสดง output bit ที่ 8

ช่ือแสดง input bit ที่ 8
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การถอดอปุกรณ์เพ่ือเปล่ียน แบตเตอร์ร่ี 
การบ ารุงรักษา หรือการเปล่ียนแบตเตอร์ร่ีส าหรับ หุน่ยนต์รุ่น  MITSUBISHI  MELFA RV-2AJ  
******การเปล่ียนแบตเตอร์ร่ี ต้องท าไปอย่างรวดเร็วและถกูต้อง และจะต้องท า   ภายในระยะเวลา 15 นาที !!!
ไมเ่ชน่นัน้แล้ว ต าแหนง่ของ ROBOT จะหายไปและอาจจะท าให้ โปรแกรมใน ตวัหุน่ยนต์เสียหาย ได้  ******* 
ขัน้ตอนมีดงัตอ่ไปนี ้
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